
Create a light painting
with a torch and tripod

Thomas Heaton shares
his outdoor photo secrets

Remove distractions with
advanced cloning skills

Plus Why teleconverters
are essential for wildlife
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Welcome

Thomas Heaton
YouTube’s own 

landscape celebrity 

talks about his 

never-ending quest 

to capture images 

with feeling and 

emotion. Interview 

starts on p106

Iris Xing
New York School of 

Visual Arts graduate 

Iris takes inspiration 

from the world of 

consumerism to 

help people choose 

a healthier lifestyle. 

Turn to p162

Richard Peters
Wildlife ace Richard

pushes ISO to its 

limits and explains 

why switching to 

RAW is better than

buying a new 

camera. Read his 

advice on p122

Learn from 
the best

Ben Hawkins, Group Editor

T
AKE A LONG, LINGERING
look at the photograph
above. What do you see? 
Do your eyes immediately
latch onto one of the three
dark figures strolling across

London’s Millennium Bridge? Or do they
gravitate towards the subtle tones of St 
Paul’s Cathedral disappearing into the mist?
Whatever the answer, there’s no denying

the hypnotic power of black & white photography – no other
medium has the ability to transform a seemingly everyday scene
into an intriguing layer cake of such depth and contrast. Want
to capture your own mono masterpiece? Starting on page 34, we
take a look at five classic black & white images, from landscapes
to artistic abstracts, and talk you through the camera and editing
techniques that will help you add mood and drama. Enjoy!

58 Document the journey of

your food, from market to plate.

34 Discover five classic mono 

projects for instant drama.

138 Find the perfect creative

lens, with prices from just £10.
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instagram.com/
practicalphotography

facebook.com/
PracticalPhotographyMagazine

twitter.com/practphoto

youtube.com/ppmagazine

WATCH  
FREE VIDEOS!

Visit our YouTube channel 

at youtube.com/
ppmagazine to enjoy over 

50 brilliant how-to

camera and editing 

videos.

Subscribe now
& save up to 61%
Choose from our exclusive 

print, digital and combo  

deals and get Practical 
Photography for less.

greatmagazines.co.uk/pp
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Octo r
138 Tested – creative lenses
32 5 classic shots you must take
114 Create a light painting
106 Thomas Heaton interview
82 Advanced cloning skills
103 Teleconverters for wildlife

On the cover

Skills&Ideas

Regulars
06 Your free gifts

How-to videos, 19 Actions,

five smoke brushes, and more.

28 Guy Richardson
Early starts and long walks

help Guy capture autumn colours.

30 Lisa-Marie McGinn
Fashion ace Lisa-Marie 

takes on a stylised bridal shoot.

125 Next month 
Find out how to capture 

autumn’s amazing flora and fauna.

08 Beyond the lens
Sun-kissed rice fields, wild horse

stampedes and insect close-ups.

18 10 clicks
Projects include abandoned 

buildings and innovative portrait ideas.

32 Black & white guide 
Five classic mono projects and

the techniques you need to master.

58 Fine food photos
How to document your food’s

journey, from marketplace to plate.

100 Know your stuff 
Business advice, resizing in 

Photoshop and teleconverters.

106 Searching for stories
Thomas Heaton talks about his

never-ending quest to capture emotion.

162 Student showcase
New York School of Visual Arts

student Iris Xing uses consumerism to

help people choose a healthier lifestyle.

138

32

106



68 Control colour & exposure
Get more from RAW with Lightroom’s

ortion and white balance panels.

72 3 ways to tone your shots
Discover three quick and easy toning 

techniques for more stylised results.

76 Make mono stand out
Get to grips with Photoshop’s 

colour channels for greater contrast.

80 Level up your landscapes 
Take your first steps in landscape 

editing in the first part of this new series.

82 Learn advanced cloning
Remove almost any distraction from 

your images with these advanced techniques.

86 Add smoke dispersion 
Capture and create a surreal portrait 

with this innovative step-by-step project.

92 FREE! 19 mono Actions
Install, apply and customise our latest 

batch of Actions for Photoshop and Elements.

94 Photo Fixer
Newly Adobe-certified expert Dan 

Mold edits your images to a pro standard.

toshop
nius

GetIntoGear

Subscribe 
Save money 

with the latest 
reader offers   

See p48

130 Nikon lenses
A trio of new lenses – 10-20mm,

8-15mm and 28mm – get the PP treatment.

132 Sigma lenses
Take a closer look at Sigma’s latest

Art lenses – 14mm f/1.8 and 24-70mm f/2.8.

134 DJI Spark
Discover a pocket-sized drone with

12MP sensor and hand-gesture control.

138 Creative lenses
Quirky glass from Holga, Lomo

Lensbaby and more, from just £10.

146 5 best photo books
Explore your creative print 

options with these quality book ideas.

148 Mini tests
LandscapePro2 software,

Benro Slim tripod and Pixi Pano360.

76  Boost contrast in your mono shots 
with Photoshop’s colour channels

58  Document your food’s incredible 
journey from marketplace to plate  

86 Capture and create a stylish smoke
dispersion portrait in t by-step

146 Find the best
photo books 

134

NEW!
32-PAGE
EDITING
GUIDE

S C H O O L

Module 6: After Dark 
Starts on page 114

FREE  
PHOTO SKILLS 

COURSE! 
SEE PAGE  

114
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1
Shoot infrared sc es

Dan converts an old camera to infrared 

and unlocks a very different way of seeing the 

world. Now, where did we leave that old D200?

2
Use long exposures 

Tim heads to the heart of London to 

show how ND filters can be used to remove 

distractions from busy city scenes.

3
Get the film noir look

Louise revisits 1950s Hollywood and 

recreates the stylish film noir look, complete 

with low-key lighting and dramatic shadows.

4
Add mood to portraits 

Kirk uses natural light and flash (and a 

sprinkle of flour) to inject greater atmosphere 

into his gritty sporting portraits. 

Actions and brushes 
This month we’re giving away 19 new
black & white Actions for Photoshop
and Elements, and 5 custom smoke 
effects. See pages 86 and 92 for more. 

Photoshop video lessons
Convert to black & white using colour 
channels, remove lens distortion and 
straighten horizons, and master the art 
of cloning and healing. 

Camera
Buying Guide
Unsure about which
camera is best for your
needs? Our ebook 
includes reviews, spec
and prices for every 
interchangeable lens
camera available right
now. That’s over 80 
DSLRs and CSCs to 
choose from.  

Expert tuition

Pro hints & tips Camera skills

Plus More free gifts on your CD
THREE
BONUS
VIDEO 

GUIDES 

65 
MINUTES 

OF EXPERT 
ADVICE

Shooting advice

Improve your camera and editing skills with over an 
hour of hands-on video lessons for all levels of ability.

Your FreeGifts

DOWNLOAD THE DISC CONTENT AT bit.ly/ppdisc1711

practical.photography@bauermedia.co.uk

Practical Photography, Bauer Media,  

Media House, Lynch Wood,  

Peterborough, PE2 6EA 

Contact us if you have any 
problems with your free gifts 
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Laohuzui rice fields

by David Swindler

O I took this shot in Laohuzui, China,

which is well known for its rice terraces.

It was a tough journey, made even harder

by our lack of Mandarin. Luckily we met a

guy from Hong Kong who was interested

in touring the rice fields with us, and he

helped translate. I loved the early and late

parts of the day when you’d get the soft

colours of the sky reflecting off the water

in the terraces. I found that my 400mm

lens worked best for this composition.

Canon 5D MkIII | 400mm | 1/20sec | f/11 | ISO 320 

David Swindler is a landscape

and wildlife photographer with

extensive outdoor experience.

He has led guided photo

tours for several years. 

actionphototours.com
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BeyondTheLens

Rapas das Bestas festival
by Guillermina Sogo
O The Spanish ‘Rapas das Bestas’
(Cutting of the Manes) festival is a yearly
tradition where wild horses are dewormed
and have their manes cut. The most
spectacular part of the event is the corral,
where the mane cutters and horses
confront each other. It was raining heavily
at the time, which added to the drama.
Nikon D5100 | 60mm | 1/200sec | f/7.1 | ISO 1000 

Guillermina Sogo is a family
portrait and tourism
photographer who was born
in La Pampa, Argentina, but is
now based ain Galicia, Spain. 

guillerminasogo.com
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BeyondTheLens

Damselfly

by Dusan Beno

O You can find damselflies anywhere near

bodies of fresh water. I was observing a

few darting over the water surface and

hunting for insects and became curious

about seeing what they would look like

close-up. I used focus stacking in order

to create a totally sharp final shot.

Canon 60D | 65mm | 1/60sec | f/4 | ISO 200 

Dusan Beno is an experienced

macro photographer who has

been shooting for the past 12

years. He also enjoys wedding

and portrait photography.

500px.com/kvejlend
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Mediterranean coast by Gianluca Podestà
O I found a fantastic place for shooting near my home. These rocks

jutted out magnificently into the sea and there were loads of great

vantage points. However, when I arrived, the clouds were so close that

I wasn’t sure I was going to be able to get a photo. Luckily, the clouds

opened up for a brief moment and the sun shone through. The light

only lasted a minute, but my camera was ready and I got my shot!

Canon 60D | 20mm | 1/6sec | f/4 | ISO 100

Gianluca Podesta 

is a landscape 

photographer based in 

Genoa, Italy. He enjoys 

travelling far and wide 

to explore new locations 

and find the perfect conditions. 

500px.com/tecnicopodestasrl
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Out of this
world images

Elinchrom ELB 1200 battery

The best photographers in the universe will be

named this September as part of the Insight

Astronomy Photographer of the Year awards. The

largest international competition of its kind, APOTY

attracts more than 3800 entries from 91 countries.

Held by The Royal Museums Greenwich group

and is currently in its ninth year, the competition has

recently released its 2017 shortlist selections, which

features some of the most truly breathtaking images

we’ve ever seen. These shots include the supermoon

over the Italian Dolomites, a shooting star flashing

over Dorset as Jupiter looms in the distance, and the

Northern Lights dancing above a rainbow of light in

Trømso harbour, Norway. The tough selection

process was overseen by a judging panel that

included NASA’s Rebecca Roth, comedian and keen

amateur astronomer Jon Culshaw, BBC Sky at Night

editor Chris Bramley and the Royal Observatory’s

Dr Marek Kukula. 

The winners will be announced at a ceremony on

14 September, with the Astronomy Centre hosting a

free exhibition of winners and shortlisted entries

from 16 September until 22 July 2018. If you’d like to

test your skills and enter next year’s competition, for

a chance to be among the greatest

astrophotographers on the planet, you’d better take

advantage of those clear skies while they last. You

can find more information on the Royal Museums

Greenwich website. rmg.co.uk/astrophoto

ASTROPHOTOGR A PH Y

FL ASH

Above The Insight Astronomy 
Photographer of the Year shortlist 
includes some phenomenal shots 
of our universe.

Abov
is Elin
versa

Lighting giant Elinchrom has released the hotly 

anticipated ELB 1200 portable battery unit, complete 

with a choice of three heads. Capable of outputting

a phenomenal 1200 watts of power, controllable in

1/10 increments over 8.5 stops, the unit features

a blistering recycle speed of 1.7 seconds with a 

possible 215 full-power flashes from a single charge

(or 400 if using the optional HD battery). You can

choose from three heads – Action, Hi-Sync or Pro,

with Action giving a 1/8850sec duration, Hi-Sync

allowing you to capture action at up to 1/8000sec

and Pro being a great all-rounder. elinchrom.com
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The latest news from the world of photography

THE

W
ARREN KELLER, STEVE M

AZLIN, M
ARK H

AN
SO

N

H
AITO

N
G YU

BE
AT

E 
BE

HN
KE



Sea it, snap it

Win a place on a
wedding workshop

Bowens bulb
blown out of
lighting busi

CONTEST

Above Flash lighting
giant Bowens has had
to cease production,
blaming rising
competition from 
Chinese brands.

To celebrate its nautical heritage, 
single malt scotch maker Old
Pulteney is taking entries for its
annual ‘Wish You Were Here’ photo 
competition, aimed at amateur 
photographers. It’s asking you to
revitalise the concept of the 
traditional Wish You Were Here
postcard, with your take on a coastal
photograph. The winner could net 
£2500 and a tour of the Old Pulteney
distillery in the picturesque coastal 
town of Wick. To be in with your 
chance of winning this great prize, 
you need to submit your image before
29 September 2017.
oldpulteney.com/wish-you-were-here

Famed British lighting giant Bowens has officially gone

into liquidation. Just a year after Bowens (and its parent

company, Calumet) were bought by investment firm

Aurelius, it would seem it’s now set to flash its last.

Seemingly failing to keep up with the current innovations

of competing brands, as well as pulling out of last year’s

Photography Show due to ‘failing to have its Generation

X range ready on time’, this seems to have been a long

drawn-out inevitability. Bowens also blames the current

trend of new Chinese brands popping up. Factories that

would have traditionally manufactured units for larger, more

well-known brands, are now selling direct to the public. The

exclusion of the middle man has allowed these brands to

offer new products at a fraction of the cost and evidently

made business very tough for Bowens. RIP Bowens,

you were the first for many and you will be missed.

Graphic Studio is giving away a place on

award-winning wedding photographer

Chris Chambers’ week-long Italian 

workshop. The lucky winner will travel

to Ceconi Castle, in the Dolomites, and

spend a week learning about posing, 

lighting and getting the most out of 

low-light shooting. There will even be

an evening of astrophotography. This 

stunning prize is worth over £1000, 

and all you have to do to enter is send

your contact details to uksales@

graphicstudio.com by 1 December 2017.

CONTEST

NEWS FL ASH
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News

1400D
on having
the majority
-up this year,

pecting to see
D sequel any time
turing the same
ensor found in many
’s newest DSLRs, this
el camera will offer
image quality, with

fast autofocus, Canon’s brilliant
Dual-Pixel AF technology and
full tilting touchscreen.
We would also expect it to
boast the same 100-25,600
ISO range. canon.co.uk

Sony_5200
Not to be outdone, the
wildly popular Sony is
expected to announce
a new entry-level CSC
to replace the aging
_5100. It’s believed to
keep the 24.3MP APS-C
sensor technology, as well as
the company’s excellent Bionz
X processor. It will include an
upgraded, tilting touchscreen, 
7fps shooting speed, 4K
video capture and weigh
in at under 300g. Although
word on this release is scarce
at the moment, we believe
news will break towards the
end of the year. sony.co.uk

Nikon D3500
With the Nikon D3300
on the cusp of turning
3 years old, we are
expecting to see a
new Nikon entry-level
camera on the horizon.
This latest entry into the
Japanese giant’s line-up
will retain the same 24.2MP as
its predecessor, but with the
EXPEED 5 processor and a
higher ISO range of 100-12,600,
resulting in better low-light
image quality. We’d also like
to see Nikon carry on its 4K
rampage by including the 
increased video mode in one of
its entry-level cameras, though 
this may be unlikely. nikon.co.uk

mourMill
icipated products 

  xpect in 2017...
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10
What to shoot with your camera right now

O�Colour is one of the most 
important aspects of photography, 
with the power to make or break 
an image. Steven Grant (500px.
com/stefanosg) took advantage 
of the matching vibrant red of his 
Volkswagen bus and a mural in his 
local town for this amazing shot.
“Owning a vintage automobile 
and being a member of a car 
club typically involves a lot of 

photos. Pictures at car shows 
and trips can get a little tedious, 
and sometimes you just go for 
a drive to look for a good photo 
opportunity. One presented itself 
when an artist painted a shark 
on the side of a local bar in Eau 
Gallie, Florida. Several of us at the 
club talked about getting a picture 
in front of it, so one afternoon 
I decided to take the long way 

home and grab a few shots.  
I parked my 1971 Volkswagen 
Transporter bus in front of the 
three storey-high mural and 
grabbed my trusty mobile phone. 
I’ve found that, for my purposes, a 
great quality phone camera does 
just as good a job as a DSLR. The 
sun was behind the wall and low in 
the sky, which meant that I didn’t 
have any direct light on my scene.”

#1Create quirky coincidences
S T R E E T
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TIP 
LOOK OUT 

FOR FUN MURALS
Even if you don’t happen to
have a Volkswagen bus at

your disposal, you can
create amazing street
photos by capturing

passers-by.

S
am

sung G
alaxy E

dge+ | 4.3m
m

 | 1/208sec | f/1.9| IS
O

  40
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O There’s nothing quite like

the warm glow of the sun

peaking over the horizon at

dawn. Photographers all over

the world routinely chase

golden light in search of

the perfect image, just like

landscape photographer Neil

Barr (500px.com/neilsbarr).

“The morning I took this

image was almost exactly

a year from the first time I’d

picked up a proper camera

and begun teaching myself

landscape photography. Over

the first year I was out all day

every day, in all weathers,

in order to learn the craft

and visit as many different

locations as possible.

This shoot was only my

second visit to Quirang, on

the Isle of Skye. The first time

I saw it I almost crashed my

car when I rounded the corner

and saw the stunning and

unusual vista around me.

When I arrived this time it was

to heavy winds and torrential

rain – typical of Skye. It

was so bad that I sat in the

car waiting for it to cease,

before eventually giving in

and setting up my tent in the

wind and rain. Luckily, the

weather had cleared up by

morning and a number of other

photographers were already

set up and shooting before I

was even out of my tent! As I

walked along the track I would

stop and shoot as I went. I

eventually chose this spot as

I thought it gave me the best

composition, so I set up my

gear and waited. The light was 

a bit flat and unexciting at first, 

but landscape photography

is often a game of patience,

and I was eventually rewarded

with this warm light about

an hour after setting out.”

#2 Capture the beauty of golden light

10Clicks

L A N D S C A P E S 
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Above Use a wide-angle lens to capture
the vast beauty of your chosen vista. 

Above
“This was
my favourite
place to
shoot, as it
was a
Belgian
gothic castle
with huge
sweeping
staircases.”

Left “Avoid
using heavy
HDR, as it
can be
distracting
for the
viewer.”

O�The mysterious allure of abandoned

buildings is so strong that it’s inspired a

whole genre – urban exploration. Gina

Soden (ginasoden.co.uk) photographs 

incredible images that show the hidden 

beauty of these amazing locations.

“I’m not sure where my obsession with

these decaying environments came

from. At first it was definitely more

about the adventure side, as the

locations were so interesting, but now

it’s all about the photography.

The majority of buildings have their

windows and doors open, because the

owners just don’t have the money to

spend on securing them. I’ll never break

in, so if I can’t get into a building then I

just leave it, as it’s not worth the risk.

Taking a good shot is all about

composition. There should be  

strong lines to lead your eye into the

frame, or if there isn’t, then there should

be a striking object of interest in the

foreground.”

Check out our full interview with

Gina Soden to find out more about her

adventures exploring abandoned

buildings at bit.ly/2uF1rvS.

#3 Explore modern ruins
D E R E L I C T I O N

TIP 
USE A 

TRIPOD
Shooting with the minimal 
light of golden hour means

that your shutter speed may
suffer. Ensure that you use

a tripod to reduce
camera shake.

C
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 | 31m
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O If you want to draw

immediate attention to your

model, why not create a

frame within a frame for

jaw-droppingly good results.

By incorporating pieces of

coloured paper, self-taught

professional portrait

photographer Maja Topcagic

(500px.com/majatopcagic)

created these amazing images.

“I took these photos as part

of a series for the magazine

Gracija, published in Bosnia

and Herzegovina. I’ve often

found inspiration in the

unique beauty that redheads

have. Freckles used to be

considered undesirable and

unsightly, but today they’re

celebrated in the world of

photography. For my setup

I used two large softboxes,

positioned on either side of the

model. I also had a portable

silver reflector held below her

face. I used very thick paper in

a variety of different colours,

torn up differently each time,

so that it appears as if the

model is trying to escape the

frame. I experienced a few

problems,

namely that

some of the

colours just didn’t

work out like I wanted

them to. However, I had at

least five colours to play with

that looked great. I didn’t

use real studio backdrops,

as it would be a shame to

tear such expensive pieces

of equipment! I used my

Canon 5D MkIII with a

135mm f/2 lens, set at f/4

with an ISO of 100 and a

shutter speed of 1/125sec.”

#4 Uncover new ideas4

B E A U T Y

TIP
ADJUST THE

COLOURS
Open your shot in Photoshop

and hit Ctrl+U. Then change

the Masters menu to the

colour you want to adjust

and move the Hue

slider.

Above If using flash, ensure that 

your shutter speed isn’t above 

1/200sec as this is the max sync 

speed on most DSLRs.

10Clicks
C
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O As the days start to grow

shorter and the fleeting sun

grows yet more scarce, you may

be wondering what to shoot. 

However, even if the weather isn’t 

playing ball, you can still create a 

stunning image, just like American 

photographer Alissa Rosenberg 

(500px.com/alissarosenberg).

“It was a snowy day on Long 

Island, New York, and I decided that 

it was too cold to go outside and 

take photos. When I was scouring 

the internet for something creative 

to do indoors, I came across images 

of water drops lined up on foliage 

with flowers captured inside. I 

immediately wanted to know how 

they did it, and knew that it would 

be a great project to embark upon 

in my garden. However, I didn’t have 

any plant material to work with, so I 

just picked up a pencil and started 

experimenting. 

“I took this photo using a Sigma 

105mm macro lens, my Nikon 

D7100, an off-camera flash, trigger 

and tripod. I also built a homemade 

light box using Styrofoam board 

that I’d procured from the local art

store. This gave the flash something

to bounce off. I stabilised my 

camera on a tripod and placed a 

dish of water inside the light box.

For the background I headed to the

local dollar store and bought an 

American flag paper plate, which I

placed opposite my flash. I then 

used three pencils and repeatedly

dipped them into the water, using

my trigger to take photos. 

“The main challenge was to 

capture and freeze the motion of the

water dropping, while still remaining

in focus. When placed correctly, 

through the magic of science, the

image behind each drop was 

refracted inside the droplet of water.

This little project was entertaining,

challenging and at times physically

exhausting! It took a lot of trial 

and error to get it just right. The 

task of holding the pencils at the 

correct angle so that the flag image

refracted inside the water drops was 

at times tedious. The process ended 

up taking hours, requiring patience 

and out of the box thinking.”

#5 Innovate indoors

Above Dip the pencils in 
and out of the water as 
many times as necessary 
to get your shot. 

Left Use a macro lens to 
zoom into the tiny details. 
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10Clicks

O The magic of the sea

disappearing into the horizon

is perfect for capturing the

imagination of your viewer, 

especially when there aren’t 

any definable waves in the 

water. Srecko Jubic (500px.

com/felix1) combined an 

ultra low ISO and a 10-stop 

ND filter to create this 

minimalist seascape. 

“Ever since I first began 

experimenting with a camera, 

I’ve always been thrilled with 

the visual impact of a pier 

leading out to sea. A fresh 

opportunity to capture this 

great sight presented itself to 

me when I was visiting my 

cousin in New Jersey, USA.

We strolled along the

Keansburg fishing pier, which

we found impressive. 

However, it wasn’t until we’d 

walked further down the coast 

and found the remains of 

another pier that I knew that

I’d found my shooting location. 

“The cut off pillars looked 

far more interesting than the 

previous fishing pier. I decided 

to use a 10-stop ND filter to 

create a long exposure. As 

there was a lot of light I 

lowered the ISO to 32 to get 

the longest exposure possible. 

I was aware that I’d probably 

lose a little sharpness, as the 

best performance from most

sensors is at base ISO, which

is 64 on my Nikon D810. I used

my Tokina 17-35mm f/4 lens, 

which was wide enough to 

capture the foreground. I then 

set my aperture to f/8 in order 

to have both the middle of my 

composition and the 

foreground in focus. I set my 

camera to bulb mode in order 

to have complete control over 

my shutter speed. I used a 

remote trigger to take a 90sec 

exposure at first, but that 

unfortunately came out too

dark. However, I then took a

120sec exposure, which came

out perfectly.” 

#6 Go minimal for incredible results

TIP 
USE A

SHUTTER RELEASE
Having a super dark ND filter 

means you’ll need a shutter 

release cable to manually 

adjust your shutter speed 

and avoid camera

shake.

Above A 10-stop ND filter will cut 

out 0.01% of the light for a long 

exposure and undefined water.
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O As any macro photographer knows, beauty 

is abundant everywhere in nature, even on the 

underside of a humble leaf. Elena Elisseeva

(elenaphoto.com) originally took this photo 

as a stock image, but loved it so much that 

it became part of her fine art portfolio.

“I shot this image with my 105mm macro 

lens. The trick was to get the glass parallel to 

the leaf, in order to keep it totally in focus. We 

tend to think of leaves as being flat, but actually 

most of them have a slight curve. To find the 

perfect candidate, I collected several young 

leaves, with beautiful veins and no damage, 

brought them home and then chose the 

prettiest one that would also lay flat. I mounted 

my camera on a tripod, facing straight down, 

and used natural light to bring out all the veins.”

#7 Capture 
intricate detail

M A C R O

Above For the largest depth-of-field when using

a macro lens, use a narrow aperture setting.

O Capturing amazing wildlife

photos is a great use of your

skills, but why not hone them on

a subject a little closer to home?

Tsvetelina Yurukova (facebook.

com/dejareve) photographed

this quirky feline portrait in the

comfort of her own living room.

“This photo was taken about five

years ago, when I captured the

aghast expression of my cat Jojo

hearing the music of Nightwish

for the first time. He was a young

kitten back then, and very playful,

so it was rare for me to catch him

standing still. This was a difficult

shot to get, as he was playing

on my shelves with my other cat,

Shantal. The lighting was poor and

the focus tracking on my camera

wasn’t working very well. I was

also shooting wide open, which

made capturing an active cat in

focus a challenge! However, I

eventually got my shot and I love

it – it’s still my favourite now, after

all these years, and I’ve even

hung it on my wall at home.”

#8 Shoot pet portraits
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O Even a simple shot of trees at
sunset can be transformed into
an artistic masterpiece with a little
editing. Photographer Roman
Alyabev (500ps.com/alyabev) 
used his Photoshop expertise to 
create this incredible image. 
“I love to spend my spare time 
walking outdoors. I was wandering
through a forest at sunset and
was blown away by the golden
light peeking its way through the
woods. I positioned myself behind

a tree so that the sun didn’t shine
in my lens and set my aperture 
to f/2.2. This allowed me to keep 
the trees sharp while letting the 
grass blur. I adjusted my exposure 
compensation to -1, in order to 
avoid any overexposure. To get 
the blurred effect I copied the 
Background Layer and navigated 
to Filter>Blur>Motion Blur Ir
then used the Eraser tool at
10% to gently erase the bottom
part of the composition.”

#9 Craft digital art
P H O T O S H O P

10Clicks

Above Use the Eraser Tool set at a low opacity, such
as 10%, to create a smooth transition between layers.

O A great portrait always tells a story, so why not add an
extra narrative thread to your image in post-production,
just like Christian Fuhrmann (500px.com/frohwein78).
“I took this photo on a weekend trip to Amsterdam. My wife
and I were sitting in front of a restaurant when I noticed 
a woman looking wistfully into the distance through the 
window. I wanted to create a story with this shot, so I 
used Photoshop to place an aeroplane into the photo. 
I also created another Layer made up of the dust and 
scratches of a dirty bus window for extra impact.” 

#10 Create a story0
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A
S I WRITE THIS, I’M SAT ON THE FERRY FROM
Ullapool to Stornoway. I’m on honeymoon, having got
married last weekend. This is, of course, meant to be 
a holiday and time away from the camera, but I’ve 

smuggled it aboard with me… just in case. That said, this is one 
trip where my focus will be on enjoying the coastline and finding 
wild camping spots rather than running up mountains to capture 
the sunrise. This is a hiatus before normal service resumes, with 
late summer and autumn to look forward to on my return.  

With autumn approaching, the
days are becoming shorter and 
sunrise and sunset are moving to
more sociable hours. This is a 
perfect time for multi-day camping
trips and high mountain 
photography, not to mention 
capturing the colour of the 
landscape as it transitions in 
preparation for the cold depths of winter.

Last year, I was determined to capture an image that defined
autumn in the Lake District. I had my mind set on an image that
ticked all of the right boxes – high mountains, deep valleys, 
mirrored lakes and, of course, woodlands in full autumn colour. 
The higher summits offer some spectacular views, but for this 
project I needed to focus on the smaller hills that would allow 
me to capture the most vibrant colours.

After some more research and preparation, I discovered a 
dominant vista over Grasmere and Rydal Water. The scene is 
surrounded by the impressive White Moss woods, which would 
provide me with the essential autumn colour. The backdrop of 
the Old Man of Coniston and the far western summits would 
complete the view. All I needed to do was to wait for the right
conditions. As we all know, that’s easier said than done!

Capturing the rich tones of autumn can be a tricky business. 
The leaves are at their most vibrant for a short period of time 
during the season, perhaps only a week or two. At this time, they 
are also at their most vulnerable, susceptible to being blown 
away by strong winds or crushed by unexpected rainfall.  

In the lead up to the shoot, I kept my eye on the Mountain 
Weather Information Service, waiting for the right weather 
window. The image would only work at first light, which would 
make the logistics of getting to the location and setting up my 

equipment that much harder. 
One evening, I spotted my 

opportunity and made preparations 
for a 3am start. After a two-hour 
drive I pulled up, grabbed my 
backpack and began my hike. It 
wasn’t far but the path was steep, and 
my legs quickly became fatigued. As 
the clouds began to light up, the 

adrenaline kicked in and I reached the viewpoint just in time for 
the light to pour over the landscape. The autumn colour was 
perfect and the dramatic skies enhanced the vibrancy of the 
landscape. I took several images but a sweeping panorama was 
all I needed as the composition of the view fell into place.

It’s such a rewarding experience to capture something that 
you’ve worked so hard for, and to create an image that fits the 
brief. Although some flexibility is always necessary, careful 
planning and a clear vision are essential to achieve good results. 

Guy Richardson is a professional landscape photographer 

and time-lapse filmmaker. His images are used by some of 

the UK’s largest tourism and conservation groups, including

Visit Britain and The Woodland Trust. guyrichardson.com  

“IT WASN’T FAR BUT 
THE PATH WAS STEEP, 
AND MY LEGS QUICKLY 
BECAME FATIGUED...”

GUY RICHARDSON
ADVENTURES OF A WILD LANDSCAPE PHOTOGRAPHER AUTUMN ENCAPSULATED
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I
LOVE ALL TYPES OF PHOTOGRAPHY. EACH GENRE
allows you to develop your skills in different ways. I knew
I wanted to be a fashion photographer very early on in my 
career, but I experimented in everything from portraits 

to architecture and pets to nature. One genre I never really 
tried was wedding photography because, honestly, it terrified 
me. It’s such a huge responsibility and I never felt I was good 
enough and worried that I’d disappoint the bride and groom.

A few years ago, I started second shooting some weddings 
and even shot a few of my own. 
I confronted my fear because I 
wanted to expand my portfolio and
grow as a photographer. One of my
favourite new things is a stylised 
bridal shoot – I can incorporate my
love for fashion photography, but 
style it more towards real brides. 

I shot this series specifically 
for this article. We found a beautiful lakefront location
not far from the makeup artist’s house, and I knew from
the start that I wanted to do an evening shoot. Usually
the weddings I help photograph are in the morning or 
mid-afternoon, but there’s something so magical about 
shooting at dusk. Hopefully the romantic feeling of twilight 
will encourage couples to plan an evening wedding or 
put aside some time for sunset shots at the reception. 

I’m incredibly lucky that all of the ladies involved in this 
stylised shoot are some of my best friends. It helps shooting 
with people you’re comfortable with, especially when 
you’re somewhat unsure of what you want to achieve.

My original plan for this shoot was sun flare (my 
specialist subject) and water. Well, the location was perfect, 
but as per usual, the weather had different plans for us. 

We had the perfect sunset until we got to the location
and then the clouds took over. Feeling slightly deflated,
we carried on regardless, and it’s a good job we did, as
the shoot ended up being better than I imagined. 

I started working it like I would a fashion editorial, posing 
the model and setting up the shot. Then I began shooting 
like a wedding photographer. After three years of second 
shooting weddings and even photographing a few of my 
own, I’ve realised that all brides are different and they love 

something that represents their own 
personality. Some are confident in 
front of the camera while others 
need a little bit more direction to 
make them comfortable. It’s all 
about making her feel special and 
showcasing her bridal beauty. 

Being a fashion photographer has 
really helped me understand angles 

and the importance of communication. I love it when there’s 
fluidity and movement, and I tell all my brides to move 
slowly, be natural, play with your hair, smile and laugh. This 
way you catch so much more and it’s not a completely posed 
image. Formal shots are still important – every couple needs 
basic wedding images – but once you capture them, start 
incorporating your own style and your own ideas. Couples 
don’t just want a record of their big day anymore, they want the 
photographer to capture the day’s unique quirks and charms. 

Lisa-Marie is a Scottish-born fashion and beauty 
photographer based in Alberta, Canada. Her work is  
regularly published in glossy magazines, and clients include 
Elinchrom, Canon and Vistek. lisamariemcginn.com  

“ALL BRIDES LOVE 
SOMETHING THAT 
REPRESENTS THEIR 
PERSONALITY...”

LISA-MARIE MCGINN
ADVENTURES OF A FASHION PHOTOGRAPHER BRIDAL FASHION
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There’s something strangely powerful about 

black & white photography that has yielded 

some of the most evocative and iconic 

images ever taken. Not only does it create a 

strong sense of atmosphere and emotion, 

but in the absence of colour it focuses the 

viewer’s eye on an image’s shape, texture, 

tone and structure.

Over the next few pages we take a closer 

look at five classic mono projects and give 

you all the tools you need to tackle them. 

Once you master these techniques, you’re 

guaranteed more captivating and beautiful 

results that will instantly inject drama and 

intrigue into your portfolio.

USE MOOD & DRAMA
for more striking 

landscape shots P34

GET GRITTY PORTRAITS
to reveal more detail  

and character P40

CAPTURE ATMOSPHERE
for more natural candid
street photographs P44

FINISH YOUR SHOTS
with the best mono
editing software P46

GO MINIMAL IN THE CITY
with the long exposure 

technique P36

SHOOT ABSTRACTS
that will look great 

in a frame P43
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C
ONVENTIONAL
photographic wisdom states
that for the best results,
landscape images should be

taken around sunrise or sunset. Often
termed ‘golden hour’, it’s at this time of
day that the low sun bathes the land in a
soft, warm light, and if the conditions are
right, ignites the sky in a glorious display
of vivid oranges and pinks.

Many assume the rules are more or
less the same for black & white
landscapes, but this isn’t necessarily the
case. Without colour controlling the look
and feel of your shot, the viewer’s
attention is fully focused on the scene’s
contrast, shade, tone and texture, so
focusing on these elements will yield the
most striking results. You almost have to
recalibrate your eyes to imagine your

scene in black & white as you work,
figuring out whether hiding beneath the
colour are the building blocks of an
amazing mono image.

Look for mood and drama
As a general rule, colour landscapes tend 
to work best in what we might consider
‘fine’ weather, as this is when the colours 
in the scene are at their most vivid,
especially in the sky. In black & white
though, the most atmospheric conditions 
are generally found on unsettled, stormy 
days. You can exaggerate the moody feel
of your shot by darkening the sky with an 
ND grad filter, making heavy storm
clouds appear almost black. Look for
breaks in the cloud, too, where the sun
pokes through, as this usually gives very 
striking results. Keep one eye on the

forecast for imminent unsettled weather,
and if you spot cumulonimbus clouds
(towering, white storm clouds) while
you’re out and about, grab some shots – 
these usually produce dramatic black & 
white images. Mono landscapes do tend 
to work best towards the start and end of 
the day when shadows are longer, but you 
have more freedom to shoot at any time 
and still get great results. Avoid flat grey 
skies and clear blue skies as they don’t 
offer much texture. 

Expose for the highlights
If the range of light intensity is too large
for your camera to capture, always
expose for the brightest areas of the
frame and let the shadows go to pure
black. Think of Henri Mattise, who said:
“The queen of all colours is black.”

Capture a moody
mo l scape

TIP 
USE THE

RULE-OF-THIRDS
If the sky is more dramatic 

than the land, give it two

thirds of the frame. But if the

sky’s slightly flat, place

the horizon on the

upper third.

SHOT
1



Dress for the occasion
If you’re heading out to shoot black

& white landscapes, you’re far more

likely to get wet, so ensure you take

fully waterproof clothing and footwear,

and an all-weather cover for your

camera/lens and kitbag.

Work at the coast
Many of the UK’s best landscape

locations for black & white

photography are at the coast,

especially when windy conditions 

create choppy seas and big waves.

This means dramatic images with lots

of energy, and also there’s usually

much more sky in shot in coastal

areas. If you plan on shooting near the

sea in bad weather, be sure to stay

safe, keeping well back from the water.

Try a long exposure
Selecting a shutter speed of half a

second or longer will allow fast-moving

objects within the frame to blur, which

can add to the sense of energy and

drama. This could be grasses blowing

in the wind or waves lapping on the

shore, as in the shot to the left.

Expert advice for
moody landscapes 
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Above Seascapes make for superb atmospheric mono shots, as 

you can get lots of sky in frame and blur the movement of the water

for extra drama and intrigue.

Left A high contrast scene with plenty of extreme shadows and 

highlights often leads to a more interesting image, as in this shot 

of Bamburgh Castle in Northumberland.

Shoot with mono in mind
The vast majority of black & white 

images you see around were actually 

never meant to be in mono. Most

were shot with colour in mind, but

didn’t quite work and were converted

later. In this way, mono is sometimes

seen as a ‘get out of jail free’ card.

There’s nothing particularly wrong 

with this approach, and sometimes 

you can end up with an absolutely

stonking image, but you’re 

undoubtedly more likely to produce

better work if you think in mono as 

you shoot. The best way to work is to

set your camera to RAW, but turn on 

the Monochrome picture style. This 

will allow you to see what the image

looks like in black & white on the back

of your camera at the point of 

capture, but still retain all of the

colour information should you need it 

later. Don’t forget, apart from the odd 

specialist camera, RAW files are

always saved in colour, regardless of 

what is displayed on the LCD screen.  

You might also decide to add extra

contrast and sharpness to the

Monochrome picture style in the 

camera’s menu to help you to 

visualise what your final shot might

look like. Again, this won’t affect the 

RAW file’s information.
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B
RITAIN’S TOWNS AND
cities are packed full of smooth
lines, intersecting shapes,
geometric patterns and blocks

of uniform tone, all of which can make
extremely eye-catching subjects. As we
discovered in project 1, it’s these key
image elements that really pop when
colour is removed from the equation,
which is why architecture and mono so
often go hand-in-hand.

Black & white cityscapes almost
always work best with a minimal
composition, so take a ‘less is more’
approach. If the frame is too busy, it
draws attention away from the buildings
themselves, whereas if the architecture is
framed in plenty of negative space, it is
more likely to stand out.

Shoot upwards
Achieving a minimal image in a cramped
and cluttered urban area is always a
challenge, so your job as a photographer
is to find an angle without the distraction
of traffic, people, adverts and signposts.

A good approach is to keep your
camera pointing upwards (see image
above), eliminating the hive of activity at
ground level. Don’t be afraid to zoom in
on an area to remove unwanted
distractions, and if necessary, use the
Clone Stamp Tool in Photoshop to get rid
of small imperfections. This style of shot
works well where there are lots of
modern high-rise buildings and is usually
most striking on a wide-angle lens. By
getting in among the buildings and
looking directly upwards, perspective
distortion will be at its greatest, and
vertical lines will appear to converge
inwards towards a vanishing point,
leading the eye towards the centre of the
frame. Mono always lends itself well to an
abstract composition, so don’t be afraid to
put your artistic hat on and see the
landscape purely for its aesthetic value,
even if this means the viewer not
recognising a building or location.

For scenes where
looking upwards isn’t
a viable option, a good
way to strip detail from
the frame is to use a long
exposure. This will allow any
non-static object in shot – people, cars,
water and clouds – to move within the
frame during the exposure, rendering 
them blurred or even invisible. In the 
image below, the clouds, water and traffic 
are smoothed out, stripping all the detail 

out of the frame.
If you’re shooting at

night, you’ll find it easy to
get a very slow shutter speed, 

but in the daytime you might
struggle. The solution to this

problem is an ND filter (see right). Ideally, 
you’ll want to use a shutter speed of at
least 15secs, and this means you’ll need a 
tripod to keep the camera perfectly still.

Over the page we show you how to get 
the punchiest possible mono conversion.
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Shoot a
minimal
cityscape

Above Pointing 

the camera 

upwards helps 

eliminate any 

ground-level 

clutter from 

the frame.

Left An ND filter 

allows a long 

shutter speed 

to help blur out 

moving objects 

such as people, 

traffic and water.

TIP 
CHOOSE THE

BEST SKY
For the most minimal result, a

clear blue sky or flat overcast

sky work best. However, if

you want some texture,

broken clouds are

preferable.

SHOT
2
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Use a circular polariser
Lots of modern buildings are

almost entirely glass or metal-fronted,

which can create harsh reflections,

especially on sunny days. A circular

polariser attached to the end of your

lens will help reduce or remove these.

Know the law
When working in cities, it’s worth 

knowing what you can and can’t shoot. 

If you’re standing on public land, you

can take photos of virtually any 

building you like, and even the police

don’t have powers to stop you (unless

terrorist intentions are suspected). On

private land though, you need 

permission from the landowner, and 

may be asked to leave without it. Never

hand over gear or delete images unless

there is a court order to this effect.

Consider composition
Think carefully about the structure

of your frame, and how lead-in lines,

the rule-of-thirds or symmetry can be

put to work. Urban areas contain very

clear lines and shapes, so if your frame

is poorly composed it will be obvious.

Expert advice for  
striking urban mono 

Use ND filters for long exposures
If you’ve ever tried shooting a long 

exposure in bright daylight 

conditions, you’ll know that even 

using your camera’s lowest ISO and

narrowest aperture, it’s impossible to

achieve a very slow shutter speed.

This is where ND filters come in,

blocking out a large proportion of the

available light for much slower shutter

speeds. NDs come in lots of different

densities, but we recommend a

10-stop (ND1000), which allows

through only 1/1000th of the light for 

ultra-long exposures. This would 

make a 1/60sec exposure 15secs. You

can buy NDs from around £25 – we’d 

recommend checking out SRB

Photographic. If you’re opting for the 

circular screw-on type 

(recommended), be sure to get the

right filter thread size for your lens. 

Once the filter is on, focusing and

composition become near impossible, 

so it’s best to get these right first.

AN
D

RES M
IG

UEZ SACHETTI



SP150-600  G2

EN

REGISTER  

NOW FOR FREE  

5 YEAR

WARRANTY

5years.tamron.eu



Classic Black & White

Create punchy 
mono images

A
GOOD BLACK & WHITE
conversion is much more 
than simply stripping the 
colour out of an image. To 

get a really striking result, you’ll need 
to adjust contrast and exposure, set 
white and black points, and if possible 
apply a gradient to the sky for a more
dramatic feel. There are a million and
one different ways to achieve this in
Photoshop, but in the below four
steps we show you a quick and easy
method that will give you punchy
mono images in under 5 minutes.
Note that steps 3 and 4 are
optional, and should only be applied
to images that have a clear horizon,
as in the example shown.

2 Boost contrast with Levels
Bring up the Layers panel by going to Window>Layers.

At the bottom of the panel click the Create new fill or adjustment

layer icon and select Levels. Beneath the histogram in the box

that pops up are Shadows, Midtones and Highlights sliders. Move

the Shadows slider to the right and the Highlights slider to the left

to meet the edge of the displayed image information.

1 Convert your image using Channel Mixer
With your image open, go to Image>Adjustments>Channel

Mixer, and check the Monochrome box at the bottom of the

window. This will change the output channel to Gray, and the

Source Channels to +40, +40 and +20 from top to bottom. You

can try tweaking the balance of the three Source Channel sliders,

but the default usually produces a very attractive mono image.

4 Darken your sky for a more dramatic look
At the bottom of the Layers panel, click again on the

Create new fill or adjustment layer icon and select Curves. Click

on the diagonal line that runs through the histogram and drag it

towards the bottom right, darkening your sky. How far you go

depends on the style of shot you’re trying to create. For stormy

skies in particular, this techique produces a very dramatic result.

3 Select your sky with Quick Mask
Select the Background Layer by clicking on it, and press 

Ctrl+J to duplicate. Double-click the Edit in Quick Mask Mode at 

the bottom of the Tools panel, choose Selected Areas and click 

OK. Press D, then choose the Gradient Tool from the Tools panel.  

Click at the top of the image, drag the cursor down to the horizon, 

and release. Press Q to convert this mask into a selection.

Above & left A flat 

colour image may 

appear to be 

lacking potential, 

but can be very 

striking with a 

good mono 

conversion.

WHAT 
YOU NEED
Q A full version of 

Photoshop

Q A well-exposed 

colour image

Q 5 minutes

BEFORE AFTER

PRACTICALPHOTOGRAPHY.COM  39



A
GREAT PORTRAIT  
is much more than a 
simple snapshot of a 
face. It’s about 

capturing and portraying the 
true essence of your subject’s 
character to create a strong 
emotional connection with the 
viewer. This is often easier 
said than done, and in fact  
the je ne sais quoi that makes 
some portraits so striking 
can be extremely hard to 
define. But one surefire 
way of achieving a more 
expressive image is simply 
to work in mono, which 
tends to be a far more 
emotive genre than colour. 
When you think about it, 
almost all of the world’s most 
iconic portraits are taken in 
black & white. 

Choose your face
Your first job is to choose a 
suitable subject. For gritty 
portraits, older faces tend to have 
more personality, and this style of 
shot is generally more flattering for 
male subjects. Essentially, the closer 
you can get to Clint Eastwood c.2008, 
the better! It’s best to light your 

TIP 
SHOOT FROM

EYE LEVEL
Positioning your camera at or

slightly below your subject’s

eye-level tends to be the most 

flattering angle as it avoids 

perspective distortion 

on the face.

SHOT
3
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Increase local contrast
Open your RAW image in Photoshop 

and, in the initial Camera Raw window, 

locate the Clarity slider in the Basic 

settings tab. Move this to the right to 

increase local contrast, giving your image

a gritty look with exaggerated fine detail.

Don’t push Clarity too far though, or your

shot won’t look natural. You can also

increase global contrast using the 

Contrast slider, and you can tweak the

Shadows and Highlights sliders to reveal

more or less details in the very brightest

and darkest parts of the image.

Choose your focal length
Head and shoulders portraits are 

generally most flattering when shot at 

50mm (or 85mm on a full-frame camera). 

The image to the left, for example, was 

taken at 85mm on a full-frame Canon. This 

isn’t a hard-and-fast rule, so feel free to 

experiment until you find the focal length 

that works best for your subject. If you’re 

an APS-C DSLR user looking to invest in a 

portrait lens, a cheap 50mm f/1.8, often 

called a ‘nifty fifty’, is a very good option.

Relax your subject
Not everyone is comfortable in front of 

a camera so try to help your subject feel at 

ease. Perhaps put on some music, and 

spark up a conversation about something 

else to take their mind off the shoot. A 

relaxed subject will almost certainly mean 

more natural-looking portraits.

Expert advice for amazing mono portraits  

Set up your camera
Switch your camera to aperture-

priority mode and set an aperture

of around f/5.6, or wider if your lens

allows. This will create a shallow

depth-of-field that should make your

image more striking. Choose an ISO

that gives you a shutter speed of

1/125sec or faster. Outdoors, this

should be ISO 100, but indoors it

could be ISO 800 or higher. Set single

point AF and select the central focus

point. Always work in RAW, though

feel free to put your camera into the

Monochrome picture style, allowing

you to see the results in black & white

on your LCD as you shoot.

Above Choosing a wide aperture of 

around f/5.6, or wider if your lens 

allows, gives a shallow depth-of-field.

Left With single point AF, you can focus 

very accurately on the eye, which is 

important when using wide apertures.

Classic Black & White

subject either from above (about 45° is 
ideal), or from one or both sides, which 
will add shadow and texture to your 
subject’s face. The image to the left has 
been lit with all three, but as you can see 
there are still areas of shadow under the 
nose and chin. At all costs, avoid light 
sources coming directly from the front, 
as this will produce a flat, low-contrast 
image that won’t be anywhere near as 
striking. Equally, don’t light from below, 
as this is rarely flattering. 

Feel free to experiment with window 
light or off-camera flash light, and try 
holding a reflector on the opposite side 
of the face to fill in very hard shadows. 
A light modifier, such as a softbox or 
umbrella, is highly recommended to 
soften your light. Ensure you have a 
clean background so there are no 
unnecessary distractions in the frame.

Focus your image
Set up your camera as explained to the 
right, and try a test shot. You’ll need to 
expose for the lightest part of the face, 
so if any areas look burnt out, use 
exposure compensation to reduce image 
brightness. Always focus on the eyes, as 
they’re the most communicative and 
expressive part of the face. This is 
important when using a wide aperture, 
where depth-of-field is so narrow that 
focusing errors become far more obvious.
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A
S PHOTOGRAPHERS,
we’re well-versed in capturing
the world around us in a very
realistic way, tending to

portray a subject exactly as our eyes see
it. But by focusing in on a very small
detail of an object and cropping out the
wider scene, you can encourage your
viewer to read an image purely for its
aesthetic value, rather than taking a more
literal interpretation. You might even
deliberately frame your shot so as to
entirely hide the identity of the subject
from the viewer, producing a truly
abstract shot akin to a piece of modern art.
The beauty of abstract photography lies
in the fact you can get an extraordinary
image from an ordinary subject, provided
it has an interesting shape, texture or
pattern. Even something as simple as a

ream of paper can be shaped into a cur
then lit in a way that gives it real visual
beauty (see above left). An abstract
approach almost always works best in
mono, as you don’t want the image
structure to be hidden by colour. Also,
black & white is, in itself, already an
artistic style of shooting, so is always
complemented by an abstract subject.

Start seeing in a new way
Potential abstract images are everywhere.
And the good news is that they’re not too
tricky to shoot. The challenge is very
much in keeping your eye open and
seeing objects for that they look like
rather than what they are. Train your
eyes to spot smooth shapes, jaunty angles,
areas of high contrast, unusual patterns
or areas of light and shadow.

Create a striking
artistic abstract

Invest in a telephoto lens
Focusing in on a small part of an

object often requires a long lens, such

as a 70-200mm or 75-300mm. If you

don’t own one though, you can usually

get away with shooting at a wider-

than-desired focal length, then

cropping in later in Photoshop.

Use a strong side light
When an object is lit from the front, 

it usually lacks contrast as the quality 

of light will be rather flat. For this 

reason, side lighting is best, as this 

reveals texture, relief and contours, 

and gives your image more depth.

Classic Black & White

SHOT
4

TIM
 BERRY

TIM
 BERRY

TI
M

 B
ER

RY
/B

AU
ER

TIP 
USE THE

CLARITY SLIDER
Open your RAW file in 

Photoshop or Elements and in 

the Camera Raw window, 

adjust the Clarity slider, 

which increases local 

contrast.

  Expert advice for   
  striking artistic monos    
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T
HINKMONO, ANDYOU
automatically picture the work
of some of the great street
photographers of the mid-20th

century, including VivianMaier and
Henri Cartier-Bresson. Their powerful
and evocative images, which were almost
always shot in black &white, focused on
ordinary people going about their daily
lives, and were usually taken in a
documentary style with the subject
unaware they were ever on camera.

The reason street images are so much
moremagical in mono can be quite hard
to pin down, but it’s all to do with how a
photograph is interpreted when colour is
removed from the equation. The eyes
tend to focus more keenly on the
distribution of light and dark tones
within the image, and are more likely to

notice fine detail, facial expressions and
overall composition. Mono is also a far
more timeless genre, so evenmodern
street images can have an identical feel to
classic shots from 75 years ago.

Master the art
A good street photographer has the
ability to pick out a beautiful but fleeting
moment from the hustle and bustle of city
life, and react fast enough to fire off a
well-exposed and in-focus shot. This is
easier said than done, especially if you’re
shooting fromwaist level (see panel
right). To ensure you don’t miss any shots,
it’s worth getting to know your camera by
practicing changing settings with your
eyes closed – this will allow you to work
very quickly. If you’re shooting with your
camera away from your eye, it’s best to

activate all AF points, which should bring
the closest object to the end of the lens
into sharp focus. If you’re using the
viewfinder, activate just the central focus
point as this is the fastest andmost
accurate.We recommendworking in
aperture-priority mode, as the camera
will balance the exposure for you,
speeding up your workflow. If you shoot
in manual (unless you’re well-practiced),
you’ll probably find youmiss lots of shots
as you grapple with exposure settings.

Don’t be afraid to include
contemporary detail, such as street signs
and advertising boards. The temptation
may be to avoid these as they can stop a
photo looking ‘classic’, but if you look
back at ’50s street images, it’s the small
era-specific details that put a shot in
context andmake it so interesting.

Capture atmosphere
in a street sce

TIP
CARRY SOME

BUSINESS CARDS
Some of your subjects will

ask for a copy of the photo. If
you’re happy to share, hand

over a business card, or
take a notepad to get

their details.

SHOT
5



Choose your aperture
One of the biggest challenges of

street photography is getting your

subject sharp. Not only do you

usually have very little focusing time,

but often the subject is moving, and

you may be shooting from the hip.

You can make things easier by

avoiding very wide apertures, which

produce a shallow depth-of-field.

This means even small focusing

errors will leave your subject slightly

soft. Instead, select a mid-range

aperture of around f/8, giving a

larger depth-of-field and better

optical quality. Avoid very narrow

apertures though, as these will

produce slower shutter speeds,

leading to unwanted blur.

Look for characters
Some street photos, like the main

image to the left, don’t really show

anyone’s face, in which case it doesn’t

matter who your subject is. But for

more traditional candid portraits, look

out for people with lots of character.

Maybe they have an unusual hairstyle

or dress sense, or a very expressive or

interesting face. Or perhaps they’re

mid-laugh, or they’re elderly and their

face tells a real story. Just find that

little something that will make your

viewer pause and ask questions about

what’s happening in your shot.

To ensure you get a pin-sharp

image, aim for a shutter speed of

1/250sec. This might mean pushing

up the ISO, but don’t worry too much

about digital noise – when shooting in

black & white this can look like film

grain and add to the character of your

shot. On most modern DSLRs and

CSCs you can comfortably go up to

around ISO 6400 without serious

image degradation, or on older

models, ISO 3200.

  Expert advice for shooting amazing mono street images  
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Classic Black & White

Shoot from the hip
Street photography is

usually shot in a

documentary style, with the

subject unaware they’re on

camera. This ensures a

natural expression and

helps you capture a true

representation of daily life

at your chosen location.

There are a couple of

methods you can use to

achieve this. The first is to

shoot from a distance with a

long lens. This makes it

easy to remain undetected,

but images are often less

intimate. The other option is

get very close to your

subject and shoot from the hip with a wide-angle lens.

As the camera isn’t up to your eye, no one will realise

you’re taking pictures. This, of course, makes focusing

and composition difficult, and so your hit rate will

reduce. However, if you have a tilt or flip screen, this will

help you compose when your camera is at your waist.

Above A tilt-out 

screen is very 

handy for 

composing your 

shots from 

waist-level.
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for Photoshop, Elements, Lightroom and

Aperture. It’s not designed as a standalone

program, though will run as such with limited

functionality. The software is one of seven

plug-ins in the Nik Collection, and you used

to have to buy it, but Google has now made it

completely free. It offers a wide range of presets that help you emulate

20 film types, and you can easily add tones and borders. Tools include

Soft Contrast, Dynamic Brightness and a Grain Engine.

google.com/nikcollection

Adobe is the undisputed king of photo

editing software, and is the go-to option

for virtually all pro photographers. Back

in 2011, the company moved to a

subscription service, so you now pay

monthly rather than a one-off payment.

The photography package, which is £10

per month, gets you Photoshop and Lightroom, which are

arguably the two most advanced editing programs on the

market, as well as your own portfolio website. The

subscription plan commits you to one year of direct debit

payments, or you can pay £120 up front. adobe.com/uk

B&W Effects is a software plug-in for

Photoshop, Elements, Lightroom or

Paint Shop Pro. It won’t run as a

standalone program so you’ll need to

own one of these packages. It offers

hundreds of presets that instantly

transform your colour shots into

dramatic and evocative black & whites, and each preset can

be fine-tuned to suit the image you’re editing. The software

allows for manual dodging and burning and colour channel 

luminance adjustments, and you can apply authentic film

grain derived from scans of real film stock. topazlabs.com

e mono

utions
We check out the best editing 
options for creating eye-catching 
black & white shots...

1 FREE

2ADOBE CC SUITE 
£10/MONTH 3 TOPAZ B&W 

EFFECTS £46

Above & left 

With Nik’s presets 

you can convert a 

flat colour image 

into a punchy mono 

in a single click.

WATCH  
THE SHOW!

Check out this month’s 

Learn Photography Now

show to find out how the

PP team shoot and edit

their black & white

images.
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whilst technology has changed

over the years, the importance

of the printed image remains

Platinum Baryta bridges the gap 

between traditional darkroom papers 

and today’s digital media. I fi nd that 

whilst known for reproducing superb 

ack and white images, it should never 

be underestimated for colour work.

Platinum Baryta 300 by Fotospeed, 
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FIVE STEPS  
TO DISCOVERING
FUJIFILM’S UNIQUE 
X-TRANS TECHNOLOGY 

I
f you’re like us, then you’ll know how important it 

is to be able to get your shot as close to perfect 

in-camera as you can. Often, people take that to 

mean a well exposed image, strong composition 

and a good white balance, but Fujifilm always aim 

to take it one step further than the competition. 

Thanks to the X-Trans III sensor, found in the 

current line-up of X Series cameras, such as 

the X-Pro2, X-T20, X100F and the X-T2, you can be 

certain that your colours will look near-perfect as 

soon as you hit the shutter button. It’s all thanks to 

the amazing technology at play behind the X-Trans 

CMOS sensor, which is based on a traditional Bayer 

colour filter array, but with a few very important 

and noticeable tweaks made by Fujifilm’s R&D 

department, which we will be taking a look at here. 

Fujifilm also has the wildly popular and exceptional 

Film Simulation modes, which dig deep into its heritage 

as one of the world’s leading film manufacturers (a 

heritage which has been going since the company’s 

creation in 1934, when they aimed to be the first 

Japanese film manufacturer, creating anything from 

motion picture to microfilm and everything in between). 

These simulations are comparable to those that 

you’d find on many cameras, usually referred to as 

Picture Controls of Scene Modes, except they boast 

a far more impressive punch and evoke some of 

the finest moments of Fujifilm’s filmic history. These 

simulations include such iconic film recipes as Provia, 

Velvia, Classic Chrome and the newest edition, the 

black & white powerhouse, ACROS. With such an 

impressive resume of colour credentials, we’re now 

taking a deeper look at Fujifilm’s X-Trans sensor and 

amazing Film Simulation modes, to find out how 

they have created this technology and used it to 

manufacture some of the best cameras on the market. 

We’ll also be talking to X-Photographer David 

Cleland to get his opinion on the Fujifilm X Series 

and see how he creates his stunning mountain 

vistas, as well as capturing gritty documentary 

and explosive music images with his X-T2.

One of the most overlooked aspects  
of a camera is its ability to render colour,  
so this month we take a look at Fujifilm’s 
X-Trans III sensor & Film Simulation modes

“THE X-TRANS III SENSOR GIVES 
THE X SERIES BETTER AND 
TRUER COLOUR RENDITION”
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1
What is a Bayer colour filter array and

how does it affect the colour?

To put it simply, a colour filter is a very thin 

film which sits just on top of the sensor on 

your camera. It features red, green and blue filters 

in a 2x2 repeating design. Each of these colour 

diodes will only allow the corresponding colour 

onto the sensor in that specific area, where the 

processor will create a full image based on all of 

the data through a technique called interpolation. It 

sounds very simple, but why would you put a filter 

above your sensor? The traditional Bayer filter was 

created by Bryce Bayer way back in 1976, and it 

was a revelation. Because it filters out the different 

colours of light, it can assign them to a particular 

portion of the sensor, when the image is being 

processed by the camera. It is essentially stitched 

back together by using the information from each 

individual megapixel, but it isn’t without its faults. 

Due to the tight 2x2 repeating pattern, it can be 

susceptible to moiré, as well as false colour readings.

2
How does Fujifilm’s X-Trans sensor differ 

from a traditional Bayer array? 

Fujifilm took the basic idea of the colour 

filter array and applied it to the X Series of 

cameras, but made a few very important changes. 

Discover Fujifilm X Series

GET A GRIP
The X-T2 has a pleasingly deep grip, allowing 

for secure hand-held shooting in even 

the most action packed of situations.

PERFECTLY
IN SYNC
The X-T2

features a PC

sync terminal,

meaning it’s

perfect for studio

photography.

The inclusion

means you don’t

have to rely on

expensive flash

triggers – you can

simply use a lead

to connect to your

flash of choice.

ALWAYS IN CONTROL
Taking its cues from film cameras, Fujifilm’s  

X Series features traditional top-plate dials, as 

well as intuitively placed thumb wheels, giving 

you the freedom to take every shot your way. 

GRAPHITE SILVER OR BLACK
To carry on the legacy found in its vast heritage, the X-T2 comes in both

a black or Graphite Silver edition (as seen below). This may not affect

the performance of the camera, but it complements the style well.

X-TRANS III SENSOR
This allows the X-T2 to render colours truer-to-

life, as well as combat moiré, which is an image

defect found when shooting repeating patterns.

FOCUS PEAKING
When using manual 

focus, Peaking

can be set in the

AF Assist menu,

which shows a halo 

around anything

that’s in focus for

pin sharp results.

Film Simulation modes can be 

selected at any time and apply 

a preset to your camera’s JPEG 

files, as well as appearing as 

live previews through the EVF. 

They are based on some of 

Fujifilm’s most iconic film 

recipes, including Velvia, 

Provia, Classic Chrome and, 

the newest edition, ACROS. 

These modes tweak the output 

of your JPEGs to represent the 

colour and contrast of the 

classic film profiles, giving you 

an added level of creativity to 

your photos, with anything from 

Velvia’s vibrant saturation, to 

ACROS’ deep shadow details 

and delicate skin tones. These 

presets can also be applied to 

the RAW files in Photoshop  

or Lightroom, meaning you 

don’t have to sacrifice quality 

for that classic look.

TECH SPEC FILM SIMULATION

A DV E R T I S I N G F E AT U R E

PROVIA FILM SIMULATION

ACROS FILM SIMULATION
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The most notable of which is a new arrangement

that results in a unique 6x6 repeating RGB pattern,

instead of the original 2x2 pattern. This offers

the benefit of having at least one red, green and

blue diode on each vertical and horizontal line

(something which the original Bayer is lacking),

meaning it is able to produce an improved colour

rendition and is much less prone to ‘false colour’

found in conventional filters. Using this more

randomly gathered data allows the interpolation

process (where the image data is stitched together

using the increased colour details) to piece the

image together from a more accurate reading.

3
Are there any additional benefits to using

Fujifilm’s X-Trans sensor?

Colour rendition isn’t the only plus of the

X-Trans 6x6 layout. Thanks to the pattern being

more randomised than the closely repeating Bayer 

design, it is also able to naturally minimise moiré. 

Thanks to this ability, Fujifilm are able to omit an 

Optical Low pass Filter, which has been used by many 

manufacturers to combat moiré, but at the expense

of sharpness. This unique technology also results

in a higher effective resolution than its megapixel

count. Due to using the process of interpolation, the 

resulting image is actually greater than the sum of

its parts, often being said to be on par with some

full-frame cameras for image quality. This process

also lessens the effect of noise at higher ISOs, a

strength which Fujifilm is renowned for, with cameras 

such as the X-T2, or even the X-T20, performing

well beyond many DSLRs in low-light performance,

allowing you to shoot in any situation with confidence.

4
What are Film Simulations and how are they 

different to traditional Picture Modes?

While Fujifilm’s Film Simulation modes are

similar in principle to other manufacturers’

Creative modes, they are entirely different in execution. 

Each Film Simulation mode draws from one of Fujifilm’s 

historical film stocks, representing unique colours and 

feel from the traditional days of 35mm photography. 

Fujifilm has a lot of film to choose from, so narrowing 

it down is not an easy task, though it has managed to 

fit in some of the most iconic film stocks from its past, 

including such standards as Provia (a professional 

grade with medium colour and contrast grading and 

“WITH NO OPTICAL LOW PASS 
FILTER, THE X SERIES OFFERS 
EXCEPTIONAL RESOLUTION”

Above The X-Trans 

sensor is currently 

in its third 

incarnation, packing 

24.3MP and 

amazing low-light 

performance.

PREVIEW  
AS YOU GO
You can use

EVF or Live

View to see your

Film Simulation

previewed right on

the screen, allowing

you to know exactly

what you’re going

to get from the

finished product. 

This means that

you can find the

right profile for your

specific situation 

every time.

BENDING TO YOUR WILL
The X-T2 features a tilting screen which pulls

out to allow you to frame your subject from

different perspectives with total ease.

SEE YOUR SCENE
As with all X Series cameras, the excellent EVF

(Electronic Viewfinder) lets you preview your 

exposure and white balance, as well as review your

shots without taking your eye off the subject.

JOYSTICK CONTROL
The X-T2 also features the rear-mounted thumb-stick,

which allows you quick and intuitive control of your

focus points to capture the action as it happens.

THANKS FOR THE MEMORIES
The Fujifilm X-T2 comes with dual SD card slots, which means you’ll have twice

the capacity. You can shoot to the first slot and use the second slot as an

overfill, or shoot RAW to one and JPEG to the other – perfect for peace of mind.
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very fine grain), Velvia (a film with the world’s highest

colour saturation) and the newest addition to the

line-up, ACROS (a black & white film from the Neopan

range, which brings out beautiful skin tones and offers

the world’s highest-quality grain standard). All of these

pair exceptionally well with a camera such as the X-T2

to create stunning scenes with a wealth of colour

reproduction. With so many to choose from, including

the three above, it’s no wonder that photographers

use the Film Simulation modes to create a different 

look every time, and thanks to being able to apply 

these effects to your RAW files via Photoshop or 

Lightroom, you never have to limit the way you shoot.

5
Considering the level of research and 

technology, is this a flagship feature?

No, the same X-Trans sensor technology is to 

be found across the entire X Series. Whether it’s

in the exceptional X-T2, a pro-aimed camera with 4K 

video and iconic styling, right down to the small form 

of the X-T20, you still get exceptional image quality 

and colour rendition. Of course, it has seen upgrades 

throughout the years – currently on its third incarnation, 

it now boasts a 24.3MP effective pixel count (though 

we have talked about how this resolution is increased 

through various techniques) and better ISO handling 

than ever, allowing for excellent low-light performance.

Discover Fujifilm X Series

Fujifilm may now be known as a global optics and

imaging company, but its roots are a lot more humble.

It started life in 1934 with a single aim – to become

Japan’s first manufacturer of photographic film, a goal

that it has long since achieved, being known for

everything from motion picture to microfilm. It’s in this

history that we can see both the importance of colour,

and the innovation which helped push it beyond its main

rival, Kodak. A massive part of this success is its ability

to adapt to digital imaging with such ease, while

keeping one foot firmly in its storied past (Fujifilm still

produces photographic film to this day). A part of

keeping this history alive is the inclusion of Film

Simulation modes on its X Series cameras, digitally

mimicking some of its most popular film stock’s colours

and feel. If you remember shooting with rolls of Velvia,

Provia or Neopan ACROS with the same joy as we do,

then you’ll be glad to know they are all available as

simulation modes and have been painstakingly created

to be as faithful as possible.

BAYER VS X-TRANS SENSORS
CHANGES & BENEFITS

CUSTOMISE  
YOUR CREATIVITY
Fujifilm has 

always advocated 

customisation,

including many

Fn buttons which 

allow you to assign 

a huge amount of 

settings wherever 

you need them.

IT’S ALL  
ABOUT CHOICE
Shutter speed can 

be set with the top 

dial like other X 

Series cameras, or 

assigned to the rear 

thumb wheel to best 

complement your 

style of shooting.

INSTANT ISO
The X-T2 has a control 

dial mounted to 

the top plate which

is responsible for

ISO control. Simply

twisting this dial,

which is above the 

mode dial, will let you 

change your setting 

instantly, which 

you can preview 

thanks to the EVF.

BAYER
2X2 PATTERN

This pattern can result in more

false colour readings

SUSCEPTIBLE TO MOIRÉ

With a tightly repeating pattern,

Bayer filters pick up moiré

OPTICAL LOW PASS FILTER

Including an optical low pass

filter compromises the overall

image sharpness

X-TRANS
6X6 PATTERN

Allows better and more  

organic colour capture

COMBATS MOIRÉ

A more random pattern means 

less susceptibility to moiré

NO LOW PASS FILTER

The lack of an optical low pass 

filter means the X Series offers  

a higher resolution

A DV E R T I S I N G F E AT U R E

CRAFT & TRADITION A BRIEF 
HISTORY OF FILM CREATION

Left 
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AVID CLELAND WAS SHOOTING

film throughout his college years 

until he graduated and life got in the 

way. However, upon starting a family 

and picking up a camera again to 

document their early years, his passion 

was fully reignited and he has been shooting 

professionally ever since. Not limiting himself to 

a single genre, David is a man of many talents.

Q You have some stunning work in many genres 

– what inspired you to take up photography?

I studied design and found photography was a 

major role in the creative process. I shot a lot of 

B&W film back in college and developed it myself, 

though photography went on the back burner

for a while when I started exploring different

creative outlets. It wasn’t until I had my children

that I found myself wanting to document them

growing up, so I bought a DSLR and was hooked

on the whole process again, and it’s stayed with

me. I actually teach film and animation now,

and I love seeing how the skills cross over.

Q How did Fujifilm approach you to

become an X-Photographer?

I was using Fujifilm before X-Photographer 

became a term, I think. In 2010, I’d become really 

frustrated with carrying a large DSLR everywhere. 

I started to leave it at home more often, but it’s 

impossible to document anything without a 

camera. I actually saw a YouTube video about 

the original X100 and pre-ordered one in 2011, 

and began shooting with it immediately. One of 

my first images was of my son on a merry-go-

round, which I posted online. Fujifilm saw the 

shot and asked if I’d be interested in testing a 

pre-production X-Pro1 and a couple of lenses. 

Even though it was really a prototype, it was a 

brilliant camera. I actually presented at Focus

on Imaging back in 2012 off the back of using it,

and every new release brings a better model.

Q Your work has amazing tones and a

beautiful filmic quality – how important

is Fujifilm to getting that look?

There is definitely something special when it

David
Cleland
David pre-ordered

a Fujifilm X100 in

2010 and fell in love

with it. Today he

can be found

shooting gritty

documentary,

intimate music and

epic landscapes.

Here, David tells

us why he loves

his X Series.

FUJIFILM X-PHOTOGRAPHER 
Q&A DAVID CLELAND 

FROM INTIMATE, GRITTY PORTRAITS 
TO EPIC, SPRAWLING LANDSCAPES



comes to Fujifilm colour. It’s to be expected given the 

company’s history in film – they really understand the 

importance of dynamic range and tones. I was always 

firmly in the shoot RAW camp, but Fujifilm JPEGs are 

so good, I now shoot RAW and JPEG and end up 

deleting the RAW files 90% of the time. You can also 

customise so much in the X Series menus – anything 

from the shadow and highlight tones to the colour 

detail. I definitely don’t adjust the colour as much as 

I used to with DSLRs. I tend to underexpose by half 

a stop to keep the shadow details, but the colour 

and white balance are amazing and so natural on 

the Fujifilms. I used to spend a lot of time adjusting 

my DSLR files to have a filmic look, but the Film 

Simulations already do that for me on the X Series.

Q�Do you tend to use Film Simulations 

a lot? What’s your go-to one?

Yes, I love the Film Simulation modes. I tend to work 

with Classic Chrome, especially when I’m shooting 

natural colours, and ACROS G if I want a really moody 

black & white image. I’ve gotten to know the modes 

over the years and can gauge which one will work 
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Above Climbers
ascending the
Mourne mountains,
David’s favourite
location, which
are right on his
doorstep.

“ACROS GIVES ME  
A REALLY MOODY 
BLACK & WHITE 
LOOK TO MY SHOT”

Discover Fujifilm X Series
A DV E R T I S I N G F E AT U R E
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best for a certain scene. I tend to take the JPEGs

back to the studio, but a little-known secret is that 

Lightroom actually lets you apply the Film Simulation 

modes to the RAW files too, all by clicking on the 

Develop module and choosing the ‘Camera Profile’ 

drop-down menu. But my favourite is Classic 

Chrome. A man in Perth, Australia, saw my X-T2 

and asked me to take his photo, and the tones were 

rendered so beautifully with so little effort on my part. 

Q You also shoot a lot of documentary

work – does the smaller form factor help 

you to get the more intimate shots?

Definitely. The smaller form factor is what attracted 

me to Fujifilm in the first place. It creates a very 

different atmosphere in comparison with DSLRs. I 

always found the larger the camera, the more people 

clammed up, and making them relaxed was a lot 

of work. I can remember a number of celebrities 

who have started a conversation about my X-T2, 

asking if it’s film or digital and talking about the 

style – it’s made it very easy to relax and build a 

rapport. I also always have at least one X Series 

in my bag when I’m out and about, just in case.

Q�We’ve seen a clear evolution of your work 

on your website, www.flixelpix.com – has 

using a Fujifilm made you shoot differently?

I hope I'm not the only photographer who looks 

back and cringes? Fujifilm cameras have totally 

changed the way I approach photography – it’s 

taken me back to my film days where I considered 

my shot before taking it. I’d definitely become 

Above Capturing
the stunning 
waterfall at 
Crumlin Glen with 
a pre-production 
X-Pro1 body. 

Below Michael 
Mormecha from the 
band, Mojo Fury.

“FUJIFILM HAS TOTALLY 
CHANGED THE WAY I 
SHOOT – I’M MORE 
CONSIDERED NOW”
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lazy with DSLRs. It means I also do less post-

processing and have a better overall outcome. It’s

slowed the process down for me and I find it a lot

more enjoyable. Every time I press the button I 

know there’s something special on my SD card.

Q�What would you say are the five biggest 

benefits to shooting X Series for you?

Portability, customisability, image quality, colour clarity

and affordability. My X-T2 cost a third of my last DSLR,

it weighs less and offers more. I’m always amazed

at the level you can customise it, not just button

placement, but image dynamics too, like shadow

tones and colour options. Having a camera with

me at all times is perfect, especially when I’m 

trekking in the mountains and need to travel light.

Q�If someone took away your X Series 

tomorrow, what would you miss most?

Well, I’d only be left with my phone camera, so I’d miss

it a lot. I think I’d miss the creative process, which I 

only find with Fujifilm. I love the adjustments you can

make in-camera – everything from dynamic range to

fine tuning the image dynamics. Nothing compares to

this level of customisation, alongside the Film 

Simulations and the X-Trans III sensor. I don’t even 

want to think about what I’d do if I lost them.

Q�You shoot a lot of epic, sprawling mountains 

– where is your favourite landscape location?

It has to be home – the Mourne Mountains in County

Down are something special. I recenntly went away for

a few weeks and I really missed the area – I couldn’t

wait to get back up there. I really lovee the way the vista

can change so drastically dependingg on the weather.

Q Have you got any tips for anybody looking

to make the switch to mirrorless?

They’ve come a long way since 2011. I find the X-T2

amazing for live music photography. Thhese are

powerful, portable little packages and thhe introduction

of 4K, for me, makes the X-T2 the perfecct package. If

you have any doubts, I highly recommend attending 

some of the hands-on events held by Fujiifilm or 

retailers. Also check out the X-Photographhers

(fujifilm-x.com/photographers) on social mmedia 

and see what they have managed to accommplish.

Above A music

image for the

cover of an

album by The

Indiana Tree

House, shot on 

location in Perth.

NEXT MONTH 
FUJINON LENSES
In the November issue we will be

taking a look at the stunning range 

of Fujifilm’s Fujinon lenses, world-

renowned for their sharpness, wide 

apertures, high resolution and 

exceptional build quality.

Q Learn more at fujifilm-x.com

Discover Fujifilm X Series
A DV E R T I S I N G F E AT U R E
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FOOD MARKETS
Focus on fruit, vegetables,

meat, fish and more
P60

FOOD STILL LIFE
Capture your expertly

styled meal
P64

CR E ATI V E GU IDE

D I S C O V E R
T H E  S E C R E T S  O F

F INE FOOD
PHOTOGRAPHY

LO
UISE CAREY/BAUER

COOKERY SHOTS
Brave the heat of the 
kitchen for top results 

P62

Three tasty projects to cook up... 

Food may be a basic necessity, but it’s also one of life’s greatest
pleasures. Tucking into a delicious meal without a second thought is
(hopefully!) an everyday occurence. However, if you’re searching for a
sumptuous new project for you to sink your teeth into, why not step
beyond the dining room and explore your food’s fascinating journey
from the thriving bustle of a marketplace, to the blistering heat of the

kitchen, to the plate in front of you.

With three exciting projects, jumping from spontaneous market
portraiture to exquisitely styled still life, there’s something for everyone.
So put down the knife and fork, pick up your camera and get ready to

create mouthwateringly good photos.



W
HILE THE
weekly food shop
could be considered
a chore that’s best 
to finish as quickly 
as possible, why not 

create a whole new photographic 
opportunity for yourself instead? Trade 
in the convenience of the supermarket for 
the bright colours and rustic charm of 
your local town’s marketplace. Not only 
will you have the chance to photograph a 

vast array of fruit, vegetables, meat,
fish and more, but you’ll also be able to
capture candid portraits of the unique
characters selling the produce. 

Shoot street-inspired photos
Snapping marketplace pictures draws its 
key techniques from street photography. 
Not only do you need to be able to dart in 
and out of interesting situations without 
ever having registered your subject’s 
interest, but you must also have focused, 
composed and taken your shot in that 
small window of time. There are three 
essential techniques that you can utilise 
in order to ensure the best possible 
results in the small amount of time that 
you’ll have available to you. 

The first is to use a focal length that 
allows you to get up close to your subjects 
without having to physically move too far 
into their space. A 70-200mm f/2.8 zoom 
lens is ideal for this, as it gives you plenty 
of choice when composing your shot. The 
next technique is to shoot wide open. If 

you’re
working in an
indoor market
then the light will likely be quite poor,
but as your subjects will be moving
around you’ll need a shutter speed of at 
least 1/250sec to freeze them in place. For 
the best image quality possible, you’ll 
need to shoot at your widest aperture so 
that your ISO isn’t pushed too high (aim 
to keep it below 3200 if possible). If you’re 
lucky enough to be capturing an outside 
market, then keep your ISO low 
(200-400) and experiment with a 
narrower aperture.

The final key technique you’ll need to 
master centres entirely around focusing. 
Ensure that you’ve selected Single Point 
AF for the best results. Then, simply 
pre-set your focus point by half-pressing 
the shutter button and using the D-pad 
to move the little red box you can see 
through the viewfinder. As you’ll have 
such a shallow depth-of-field, it’s vitally 
important that the focal point of your 
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PROJ ECT 1

Explore the vibrant 
colours of the market

TIP
SET YOUR

WHITE BALANCE
Use a Tungsten (Canon)/ 

Incandescent (Nikon) white 
balance to counteract the 

slight yellow cast that 
you’ll get with most

indoor lighting.

Above Follow the rule-of-thirds and place 
your subject on one of the top power points.
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Above Look for

vibrant colours,

such as the reds

and greens of

herbs and veg.

Left Don’t be

afraid to ask the

sellers to show

off their wares.

Sweeten the deal

by purchasing

their goods and

you may come

away with a 

priceless photo.

image is sharply crisp. However, you
won’t have time to fiddle around with the
D-pad when you’re trying to take a shot 
without sparking your subject’s attention. 
Pre-set the focus point onto one of the top 
power points, as this will enable you to 
raise the camera to your eye, quickly 
compose the shot with your subject 
conforming to the rule-of-thirds, focus, 
and then finally take the photo. 

Take contextual shots
While street photography-inspired 
market images look fantastic, it would be 
a shame to eschew the vibrant colours of 
the variety of produce on display. Take 
advantage of the veritable rainbow of 

food available and shoot some still life
images as well.

Colour is king with this technique,
so compose your shot with fruits and
vegetables that complement each other.
Look for tones that are opposite on the
colour wheel, such as red and green or
blue and orange, for images that truly
pop. Search for unusual looking pieces
of food, such as artichokes or Saturn 
peaches, for an interesting focal point.
Then simply use a wide aperture like 
f/2.8 to keep your subject pin-sharp, 
while casting the background in colourful
blur. As you’ll be working handheld, don’t
let your shutter speed drop below 1/80sec,
but try to stay above 1/125sec to be safe.

Expert advice  
Roger Stowell  

Roger Stowell 

(rogerstowell.com/

wordpress) is an pro 

advertising and editorial 

photographer. He’s 

worked for a variety of 

clients, including Elle,

The Observer and BBC Good Food.

Q One of the most important aspects 

of market photography, or indeed any 

kind of shooting experience where 

you’re in a crowded place, is to 

become invisible quickly. It’s best not 

to get in close, as you’ll alert people to 

your presence and you’ll lose the 

candid nature of your shot. I’ll often 

stand in a corner near where some 

good action is going on, and I tend to 

find that I’m quickly forgotten.  

Q�It’s best to shoot quickly and not to 

wait. People seem to have a sixth 

sense that tells them when a camera 

is looking at them! Set your camera  

to burst mode in order to be able to 

capture precise moments in a short 

period of time.  

Q�Indoor markets tend to be pretty 

dimly lit places, so light can be a 

constant battle. Use the fastest lens 

you have, set wide open to ensure 

that your shutter speed is quick 

enough to be able to freeze your 

desired subject mid-motion, while the 

rest of the background is soft and out 

of focus. 

Q�A great technique that I always find 

myself using is to take my camera 

away from my face and hold it at 

chest height, resting it on the crook of 

my arm. It may take a bit of practice to 

consistently hold it level, but this is a 

great way to get candid shots. With 

old Nikons you could take off the 

pentaprism to see the mirror, but you 

can’t with newer models. However, 

experimenting with shooting blind can 

produce amazing results. 
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E
VEN IF IT’S AS SIMPLE AS
a handheld spoon hovering
tantalisingly at the edge of
the frame, or as dramatic
as fire crawling up the
sides of a frying pan, a clear

human presence is a surefire way to draw
your viewer into your image and show
them just how irresistable the food is.

Direct your chef
While marketplaces can be the perfect
opportunity to hone your candid
photography skills, when you’re
working with someone who knows
you’re there, you can direct them in
order to create the perfect photo.
Shots including your chef cooking will
be rather tied to wherever the hob is,
but don’t be afraid to step away from
the kitchen side when cutting up
vegetables or serving up food. If you’re
lucky enough to have an island in
your kitchen, then ask your cook
to make their preparations there,
rather than on a kitchen side facing
away from you as it’ll be easier to
capture their face. If you don’t have
an island, try using your dining room
table instead for a similar effect.

Choose your camera settings
Kitchens aren’t often known for being
particularly roomy, so a 24-70mm f/2.8
zoom lens will be your best friend for this
project. This will allow you to switch
fromwider contextual shots of the whole
kitchen to closer detail photos without
having to actually move yourself at all.
The process of cooking can be a messy
one, so shoot at a wide aperture, such as
f/4, to cast the background into blur and
prevent your photo from becoming overly
busy with miscellaneous kitchen clutter.
While your focal point must remain
sharp, don’t be afraid to introduce a little
motion blur of your chef moving, with a
shutter speed of 1/80sec.

PROJ ECT 2

Shoot the 
intricate
culinary 
process 

Above & below Shoot in RAW to capture high contrast

shots. This’ll mean that you can expose for the

highlights while still retaining plenty of shadow detail.

TIP
USE A

REFLECTOR
Kitchen lighting can often be

fairly dingy. Bounce back the

light by using a reflector and

placing it on the opposite

side of the light

source.
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Expert advice  
  Hooman Mesri  

Hooman Mesri 

(hoomanmesri.com) 

is a professional 

product 

photographer based 

in Ontario, Canada. 

He has more than  

15 years’ experience in studio 

photography and specialises in 

shooting food and jewellery.

Q�When beginning a food 

photography project, regardless of 

the purpose, one must think about  

all of the operational details. It’s 

essential to educate yourself about 

the subject, from the preparation, 

to the cooking process to the 

serving. Knowledge about the 

origin of the food and its history will 

also help when you’re working with 

the chef, as it’ll make it easier to 

communicate your ideas and get 

the shot.  

Q�For documentary-style food 

photography, where you have a 

series of images as your final 

product, continuity is key. I prefer 

to use the same overall tones in my 

images, no matter whether using 

high- or low-key lighting. Pay 

attention to the shadows and 

ensure that the overall quality of

the light matches in every picture.

Your background colour theme is

also important. This doesn’t mean

that everything has to be the same

colour from shot to shot, but the

photos shouldn’t feel disconnected.

Q Always experiment with different

angles for each image, and never

be afraid of close-ups. Create

simple and understandable

compositions that show off your

focal point. Don’t forget to always

review your image afterwards to

make sure that you’ve got your

winning shot.
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Use Auto ISO for great results
A kitchen can be a busy 

and stressful place, so 

you don’t want to spend

too much time agonising

over your settings,

otherwise you may lose 

great images. This kind of

situation is where Auto 

ISO becomes essential.

Most modern cameras will

have this option in their

shooting menu and will 

automatically choose 

which ISO will allow the

best exposure. However, 

depending on your 

camera, you can also 

exert more control by

selecting a maximum ISO

value and a minimum

shutter speed. 

Above By choosing a maximum ISO of 3200, noise 

will be always stay within an acceptable level.



O
NCE YOUR PRODUCE
has been acquired
and cooked to
perfection, it’s time
to create the ultimate
pièce de résistance

of your journey through the world
of food – an exquisitely styled still
life photograph. Food styling is an
occasionally misunderstood, yet vitally

important part of food photography.
It’s often a little trickier than it
looks, but fortunately we’ve got some
excellent top tips to help you create
a sumptuous photographic feast.

Create something simple
The best way to create an eye-pleasing
still life composition is to religiously
stick to the old adage ‘less is more’. While
your first instinct when seeing a weighty
spread of delicious food may be to load
up your plate as high as possible, this can
make a food still life start to look messy
and unappealing. For the best results,
follow the 3/4 rule, which is where you
fill three quarters of the plate with the
food and leave a wide rim that acts as
blank space and frames the subject.

Once you’re ready to start styling your
shoot, begin by identifying which part of
your dish is going to be the ‘wow’ factor
and then build the rest of the composition
around it. While it may be tempting to
break out the fine china for this project,
try to avoid overly intricate patterns and
use mostly plain plates instead. Props
have the ability to take your image to

the next level, no matter whether it s
a scratched silver spoon or an artfully 
bundled-up napkin. However, you never 
want the main focus of your image to 
be a prop, so make sure that your dish is 
always the star of the show. Just as you 
don’t want to overload your plate with 
food, ensure that you don’t bog down the 
photo with too many different elements. 
Remember that the food is the most 
important part of the photo and that 
anything else should be there to make it 
look good, and never to distract from it. 

A good rule-of-thumb to consider is 
that the more complicated your dish, the 
simpler the background styling should be. 
Try and match the mood of the food to 
the rest of your setup. If you’re shooting 
a hearty joint of meat, you may want 
to have a dark wintery background 
with a metal or slate texture. However, 
if you’re photographing a platter of 
fruit, then a bright summery backdrop 
with accents of fresh and vibrant 
colours may be more appropriate. 

Once you’ve got the basic setup 
for your shoot it’s time to decide how 
you’re going to use your camera to 

PROJ ECT 3

Style your food shoot

TIP
ADD A

GARNISH
Whether it’s cream, herbs or 
spices, a garnish will draw 
attention to your subject 
without overpowering it, 

making your shot
pop.

Above Leave a quarter of the plate free 
around the edges to frame your food. 
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show off the beauty of the composition. 
Shooting top-down is generally easier 
than at an angle, as it requires less 
styling. You only have to worry about 
the surface of the table, rather than 
what’s in the background as well. 
However, if you’re photographing food 
with layers (such as burgers, pancakes 
or sandwiches), then this will require 
you to shoot at an angle in order to 
capture that dish’s ‘wow’ factor. 
To shoot a flatlay, set your aperture to 
f/8 and your ISO to 100. Depending 
on your light, you may find that you’ll 
need a tripod to accommodate a slower
shutter speed. If you’re photographing
your food at an angle, then use a wide
aperture to cast the background into blur.

Obsess over the details
Remember that food truly is a malleable
subject, so don’t be afraid to try different
arrangements in your composition. For
example, if you’re shooting a pie, try
photographing it in various stages of
being served. It’s best to work quickly,
as food ages fast, but if your subject is
starting to wilt then there are ways to
save the shoot. To avoid ice melting in
drinks, simply invest in acrylic fake ice
cubes and spritz a light mist of water
over the glass for fake condensation.
Dunk sad-looking salad leaves in ice
cold water to refresh them. You can
also do the same thing with fruit in
order to avoid browning, but you’ll need
to add a little lemon juice as well.

Expert advice Olia Hercules
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Join Leiths-trained chef,

recipe writer and food

stylist Olia Hercules and

experienced editorial and

advertising photographer 

Roger Stowell for a long 

weekend of delectable 

food, beautiful French 

countryside and  

photography tutelage. 

Located at the converted 

farmhouse villa Le Mazeau 

in the South Vendée, you’ll 

have the opportunity to 

practice and develop both 

your photographic and 

culinary skills, while 

simultaneously relaxing, 

with access to a pool, 

satellite TV, Wi-Fi and an  

al fresco dining area, 

complete with a

wood-fired pizza oven.

For those keen to explore

the area, there are

opportunities to visit the 

markets and restaurants of 

Niort and La Rochelle. 

What you’ll learn
Q Explore the rustic charm 

of small French towns with 

your camera, capturing 

snapshots of everyday 

market life. 

Q Discuss your 

photographs from the day 

and receive Photoshop 

tuition in order to take your 

images to the next level.

Q Take shots of the 

cooking process and 

capture candid portraits

of the chef at work.

Q Go over the photography

basics and learn how to

capture fantastic food still 

life images. 

Where & how
Visit biginfrance.com to 

check out its wide range  

of courses, including 

cooking, yoga and 

meditation retreats, as well 

as photography courses 

with a variety of fantastic 

food photographers, such 

as Ilian Iliev and Mark 

Benham. Dates are to be 

confirmed for 2018, so 

keep an eye on the website 

for more info. 

Take it further Explore gorgeous 
food & scenery at Big in France

Olia Hercules is a chef, 

recipe writer, food stylist 

and author. Her first book 

Mamushka won the 

prestigious Fortnum and 

Mason Award for best 

debut cookbook 2016. Her 

second book is titled Kaukasis (Mitchell 

Beazley, £25, octopusbooks.co.uk). 

Follow Olia at instagram.com/

oliahercules to find out more. 

 

Q�I always take a big kit bag to all of the 

shoots I style, but I really only have three 

essentials that I couldn’t go without. My 

long DIY tweezers are perfect for creating 

intricate arrangements, while a little oil or 

water lets me create highlights on the 

dish or make the meat look more moist. 

In the past my heat gun has saved the 

day when the hob has broken and I 

needed to grill a steak. 

Q�In visual terms, there are a few golden 

rules to food styling, especially when it 

comes to editorial content. You must 

ensure the food is as tasty in real life as it 

looks in the photo (I believe the viewer 

can tell otherwise!). Try to use daylight if 

possible, unless you’re a whizz at lighting 

things artificially. Ensure that there  

are odd rather than even numbers 

(simplistically speaking, three carrots 

look more eye-pleasing than four). Make 

sure that the food has different textures 

and varied colours. However, the real test 

of a food stylist is making a plate of 

brown food look appealing!

Q�Whatever the situation, like in any job, 

there’s always scope for improvement. 

It’s important to keep learning.

ELEN
A HEATHERW

ICK



Power in all
the right places
Profoto B1X

The Profoto B1X improves on the B1 in three significant areas:

power, power and power. A more powerful modeling light, a

more powerful battery and extended HSS power range. Add to

that two new OCF reflectors and you’ll find with the B1X, we’ve

redefined the on-location flash yet again.

Discover the B1X at profoto.com
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Learn exciting new editing techniques 
from the UK’s best digital experts...

68
Warm up your RAW files
We show you how to correct white

balance and exposure issues in Lightroom.

72
Add style and colour
Our trio of toning tutorials are sure

to increase the wow-factor of your pictures.

76
Get striking mono results
Tweak your colour channels for black

& white images that really pack a punch.

82
Remove distractions
Master Photoshop’s Clone Stamp

Tool to clean up your landscapes.

86
Go abstract with smoke
Create awesome smoke dispersion

portraits with our DIY Photoshop project.

92
Try out your free Actions
Apply a whole range of black &

white styles in a single click with Actions.

94
Photo Fixer 
PP’s pro image editor Dan Mold 

retouches a selection of reader pictures.

98
Photoshop hacks
Three quick tips that’ll change 

the way you edit your shots forever.

80 PERFECT YOUR 
LANDSCAPE SHOTS 
Basic edits that make a big difference

NOW INCORPORATING

EASY PHOTOSHOP ADVICE 
THAT REALLY WORKS

WATCH OUR 
PHOTOSHOP 
TUTORIALS  

Every issue features 

additional multimedia 

content that includes 

Photoshop video lessons 

to complement our expert 

step-by-steps. When you 

see this icon on the page 

you’ll find extra content on 

your disc/download. See 

page 6 for full details. 

EXTRA PAGES  
OF THE BEST 

TUTORIALS FOR  
ALL LEVELS

32

PP’s Photoshop editor, 

Dan Mold, is an Adobe 

Certified Associate.
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// LIGHTROOM

Unleash RAW power
and change the white
balance of an image in
Lightroom. Dan Mold

explains how to get a brand-new
look in just minutes.

W HAT WE SEE
when we’re
composing to take

a photograph, and what the
camera produces when it records
the moment, are very rarely the
same thing. The human eye
undoubtedly has a broader dynamic
range, capable of seeing detail in deep
shadows and bright highlights. RAW files also come
without in-camera processing, so they often look flat.

I remember getting up early to catch the morning sun
for this shot. The stag was bathed in a rich golden glow,
but unfortunately a cloud covered it just as I pressed the
shutter. This meant the light was much cooler, and blue. 
Luckily, the white balance isn’t locked with RAW files 
so the colour temperature (how hot or cold the colours 
are) can be set in software such as Lightroom. In this 
tutorial I’ll show you how I fixed the colours, reduced 
lens distortions, increased contrast and brightened
specific parts of the shot.

Get more from RAW
RAW files are much larger than JPEGs, containing extra 
exposure information from the point of capture. This 
added data can be used in RAW processing software such 
as Lightroom. Back at your computer you can then 
correct parameters such as white balance and your 
exposure. With compressed JPEGs, which are processed 
in-camera, these values are not easily changed so there’s 
little scope to greatly improve the image.

DAN M
O

LDAFTER

BEFORE

Above As the image is fairly underexposed, the colours look 

a little flat and dull. It was also shot early morning in the 

Golden Hour, so the colour palette seems off. 

Left The processed RAW has a much warmer colour palette 

and the exposure has been lifted. This gives the image a 

completely different feel, and the warmer tones make it 

much more appealing.

WHAT
YOU NEED
Q Photoshop

Lightroom 6 or CC

Q A RAW in need of

a white balance

tweak

Take total  
control of 
exposure 

and colour 
with RAW
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1
Import your image, crop and correct lens distortions
Head to the Library module in Lightroom. This is where you can locate your shots

and import them. Click the Import button, or go to File>Import Photos and Videos
to bring up the Import dialogue. Use the Source panel on the left to search through your hard

drive and find the image you want to work on, make sure it has a tick next to it, and then hit

Import to bring it into Lightroom. Now go to the Develop module and click on the Lens

Corrections panel on the right and tick Enable Profile Corrections. It’s also a good idea to

crop your shot at this point using the Crop Tool. Give the tool a click to make it active, then

drag the outside corners of the crop bounding box until you’re happy with the composition.

The Lightroom workflow

operates in an entirely

different way to Photoshop

so can seem daunting to

get to grips with. But you’ll

soon familiarise yourself

with the layout when

you’ve made a couple of

RAW conversions. Here’s 

what you need to know

about the Develop tab, 

which is where you make

your edits...

Lightroom 
interface 
explained

Modules

The most useful modules

are the Library, where

you can import your

pictures, and Develop,

which lets you process

your RAW files. The Print

module is also handy if

you want to print directly

from Lightroom.

Adjustments

The Adjustments are all

collapsible panels. Click on

them to expand and they

will reveal the sliders and

controls within. These

contain powerful editing

options, from Exposure to

Sharpening, and Noise

Reduction to Split Toning.

Toolbar

For more precise adjustments,

there’s a handful of tools found

under the histogram. Here you

can apply a crop, remove

spots, correct red eye, add

graduated and radial filters

and adjust specific areas of

your pictures using the

Adjustment Brush Tool.

Filmstrip 

The Filmstrip sits at the bottom of the 

interface and lists the images from 

your latest import. This makes it easy 

to flick through the images in your 

current import. You can star rate your 

shots with number keys 0-5, and 

using the Filter you can reduce the 

images shown in the Filmstrip to just 

the ones you want to work on.

Above One of the first things to do 

after you’ve imported your shot is 

fix lens distortions and crop it.
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2
Fix exposure and white balance
Open the Basic panel on the right of the interface and

tweak the Temperature to change the White Balance

slider (whether the shot looks hot or cold) and use Exposure to

adjust the brightness. It’s worth going back and forth between

these sliders to get the colour and lighting looking right. We had

to underexpose this shot by -0.40 to make the golden colour

palette look natural. Then pull the Highlights and Blacks sliders

to the left a little and the Shadows and Whites to the right to 

increase contrast. Setting Clarity to +25, Vibrance to +50 and

Saturation to +5 is usually a good starting point.

3
Sharpen the details
The next step is to reduce noise and increase contrast 

to make the edges look sharper. Go to the Detail panel 

and set the Sharpening Amount to 50, then refine it to just the 

subject by holding the Alt key and dragging the Masking slider  

to the right. You’ll now see a black and white display. The white 

parts are the only areas that will be sharpened, so keep pushing 

the Masking slider up until only your subject is in white – this 

stops you sharpening out-of-focus areas. Under Noise 

Reduction you can drag Luminance to reduce digital noise.  

A value of 15 is fine for this shot as it was taken at a low ISO,  

but you may need to tweak this for your own picture.

4
Brighten specific areas of the shot
It’s pretty common for different areas within a scene

to have differing brightness. In the example shot, the

background is perfectly exposed, but the stag’s head is a little

underexposed. Large areas like this are easy to fine-tune. Just

grab the Adjustment Brush Tool from the Toolbox. This tool

allows you to paint adjustments, such as the Exposure, Contrast

and Shadows, onto specific areas of your shot. To brighten its

head we set the Exposure to +0.25 and the Shadows to +30.

We also set Clarity to +15 to give this area more bite. For a

soft-edged brush and natural finish set the Feather slider to 100,

then paint over the area to apply the adjustment. The sliders can

be finessed at any point and you can remove areas from your

selection by hitting Erase and then painting over the offending

area. You can also paint in a new adjustment by hitting New.

5
Export to save your image as a JPEG
When you’re done, you’ll want to create a JPEG  

so that you can upload it or work on it in Photoshop. 

Go to File>Export, choose where you want to save the shot 

under Export Location, and under File Settings change the 

Image Format to JPEG with a Quality of 100, then hit Export. 

GENIUS Holding the Alt key as you drag 
the exposure sliders brings up a clipping 

warning to show detail is being lost 

// 



C REATIVE USE OF COLOUR
is a great way to draw the
viewer’s eye towards your

image. So in this feature we’ll cover how
to tone your shots in three completely
different ways. These effects can be used
to accentuate the colours already in your
shot, or add your own to alter the mood.

We kick offwith this straight toning
effect, where a single colour is blended in.
For our shot, a fiery orange was used to
create a strong autumnal vibe. This gives
it muchmore warmth than the original,
so it’s easier to associate this version with
this time of year.

Over the page, we
reveal an easy way to
give your shots a sepia
tone and then how to finish
the vintage look with digital noise.

Lastly, we reveal how to create a split
tone. This is where two colours are
blended in – one assigned to the shadows
and the other to the highlights. The
results are stylish andmemorable.

All of the techniques can be achieved
in just five minutes and customised to
your liking. Sound good? Let’s dive in and
take a look at how to take control of
colour in your images.

Want to make your shots
more stylised? Just follow
Dan Mold’s three quick ways
to adjust colour for impact.
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Ways to tone
your pictures3

Left The original

picture is packed

with texture and

detail, but it’s a

little flat and could

do with a colour

boost.

Right It’s so simple

to give your shots a

warm, golden aura

in Photoshop by

blending in an

orange Solid Color

Adjustment Layer.

1
Duplicate your Layer
Open Photoshop and head up
to File>Open. Find the shot you

want to edit and hit OK to open it up. Now
hit Ctrl+J on the keyboard to duplicate
your Background Layer. In the Layers panel
(Window>Layers) you’ll see your Background
Layer and a carbon copy of it above. You
now need to change the Blending Mode of
this new Layer from Normal to Hard Light.
This instantly adds contrast to the shot.

BEFORE

1Add a warm
autumn mood

G
L

TU
KH

A

AFTER

WHAT
YOU NEED
Q

Elements

QAn image you’d like to

apply different colour

effects to
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2
Add your own colour
In your Layers panel, click on the Background 

Layer to make it active. Then click on the Create

new fill or Adjustment Layer icon and choose Solid Color

from the list that appears. You’ll now see the Color Picker,

which lets you set the colour you want to

apply. We dragged the cursor to the top

right corner of the Color Picker to give us

the lightest, most saturated colour. Then 

you can click the bar to the right of it to

set the hue. We set this to a bright zingy

orange and hit OK to set it. Finally, change

the Blending Mode from Normal to Soft

Light to add a stylish splash of colour. You

can change the Blending Mode of either

Layers to tweak the effect and reduce the

Layer Opacity to make it more subtle.

// PHOTOSHOP & ELEMENTS
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1 your shot
Open your shot

in Photoshop or Elements

and hit Ctrl+Shift+U or

go to Image>Adjustments>Desaturate to remove colour from

your shot. Head over to the Layers panel (Window>Layers)

and click on the Create new fill or Adjustment Layer icon, then

choose Hue/Saturation from the menu that appears. In the

Hue/Saturation panel the first thing you need to do is tick the

Colorize box. Now drag the Hue slider until you find a colour

you like and drag Saturation until the colour is the right 

strength. When you’re done, hit OK or click the cross to  

close the panel.

2 Recreate a
grainy retro
sepia tone
VINTAGE IS BACK IN FASHION, SO
why not apply a fuzzy sepia effect to
your pictures to give them an aged, 
yesteryear charm. A sepia tone is a 
classic, and our technique to create 
one in Photoshop or Elements can be
achieved in just five minutes. And once
you’ve run through the tutorial a few
times, you’ll be able to do it even quicker.
You’ll learn how to colourise your shots
using the Hue/Saturation Adjustment,
add contrast with Levels and add noise
in Photoshop to create the illusion of
old high ISO film grain. Let’s get to it!

2
Apply a
vintage
film look

If the effect is still a little

strong, go to the Layers

panel and reduce the

Layer Opacity.  

To add contrast, click

on the Create new fill or

Adjustment Layer icon once more, choosing Levels this time. 

Pull the Shadows and Highlights sliders in towards the middle 

a little to increase contrast in the shot, then pull the middle 

Midtones slider to get the overall brightness looking how you 

want it to. This toning effect looks great with a film grain look, 

so click on your Background Layer and go to Filter>Noise> 
Add Noise. Finally, set the Amount to 20%, tick 

Monochromatic and hit OK to apply.

AFTER
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2
Blend the colours into your shot
Make sure your Gradient Map is the active Layer in 

the Layers panel and then click on the Blending 

Mode drop-down menu. This is set to Normal by default, 

meaning the Layer isn’t interacting with the Layer below it at 

all. Because we want to blend the gradient map colours into 

the main shot you need to change it to a different mode. We 

set ours to Overlay for this shot, though other modes such as 

Soft Light, Hard Light, Screen and Lighten work well too, it just 

depends on the style you’re going for. If the effect is too 

strong, you can drop the Layer Opacity down. 

GENIUS You can add

extra Color Stops to your

Gradient Map Adjustment 

Layer to inject more colour 

and set the colours with a 

finer level of control

3 Create depth with a duotone
WHAT’S BETTER THAN TONING YOUR 
shot with a specific colour? Toning them 
with two colours of course! A split tone, or 
duotone, lets you choose which colours you 
want to tone the shadows and which 
colours effect the highlights. The results 
are sleek, stylish and super easy to achieve. 
Just load up your shot into Photoshop and 
follow the steps below... 

AFTER

1
Add colour with a Gradient Map
Open your picture and head straight for your Layers 

panel (Window>Layers). Now, click on the Create 

new fill or Adjustment Layer icon and choose Gradient Map 

from the list. Click on 

the Gradient Editor 

from the panel that

appears and choose

one of the Presets that

grabs your eye (you

can fine-tune them by

changing the Color

Stops on the gradient

below). When you’re

happy with the 

Gradient, hit OK to

apply it.
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WHAT 
YOU NEED
Q Photoshop CC

Q An image you want to
work up in black & white

with a high level of 
precision
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I t’s easy to think that
colour becomes irrelevant
when converting to black & 

white, but this couldn’t be further from 
the truth. Convert to mono using the 
Black & White filter in Photoshop, and 
you’ll be able to make full use of the 
colour channels. These remain intact, 
despite draining the image of colour. 
Why is this useful? Well, it means you 
can change the luminance of those colour 
channels. It’s fantastic if you want to 
brighten a grassy green foreground, 

darken a blue sky, or change the contrast
of any other colour, giving you a much
finer level of control than a standard 
Brightness/Contrast adjustment.

Over the page we’ll show you 
how to do it in Photoshop CC non-
destructively, so you’re never damaging 
the original picture. You’ll also see how 
to apply a gradient to mimic the effect 
of a graduated ND filter to darken the 
sky, and how to carry out localised 
dodging and burning to get the image 
looking exactly how you want it to. 

Make your mono 
shots stand out

AFTER

Dan Mold explains why colour 
channels are essential for making
black & white conversions that burst 
at the seams with contrast.

BEFORE

Left We fine-tuned the contrast of 

individual colour channels to add punch 

and increase impact to this shot.

Above There’s a great range of colours in 

this coastal landscape, making it ideal for 

a black & white conversion in Photoshop.
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3
Refine your gradient with a mask
You can mask off the gradient if it’s darkening areas

you don’t want it to. Just go to the Layers panel and

click on the Add Layer Mask icon. Now you can use a soft

Brush Tool with a black foreground colour (hit D followed by X)

to brush over any areas you don’t want the gradient to affect.

4
Increase contrast even further
The Dodge and Burn Tools can be used to lighten and 

darken specific areas. To darken, click the Burn Tool 

from the Toolbox and set it to a soft brush with an Exposure of 

3% for a gradual effect. Then set the Range to Shadows,

Midtones or Highlights – depending on the tonal range in the 

image you want to tweak. Now click on the Background Layer 

in the Layers panel and hit Ctrl+J to duplicate it. Working on 

this new Layer, brush over the part you want to darken and 

switch the Range appropriately. The Dodge Tool works in the 

same way for brightening specific areas. When you’re done,  

go to File>Save As and save as a Photoshop file to keep your 

Layers, or as a JPEG to merge them and save on disc space.

1
Adjust the contrast of your colours
Open your shot into Photoshop with File>Open
and then head over to the Layers panel (Window>

Layers). In the Layers panel click on the Add new fill or 

Adjustment Layer icon at the bottom and choose Black 

& White from the menu that appears. Now you can change

the brightness of individual colours in your shot. Change the

Preset to one you like the look of, or manually drag the colour

channel sliders until the image looks good to you. This is 

great because you change the luminosity of colours in your

shot, such as blue skies, yellow flowers, green grass and so

on. When you’ve got the contrast looking roughly how you

want it, you can refine it further in step 2.

2
Darken skies with a gradient
If the sky is still looking too bright you can darken 

it realistically with the Gradient Tool. Go to

Layer>New Layer and hit OK when prompted by the dialoguer
box. Now click the Gradient Tool from the Toolbox to make it 

active. Hit D to set the foreground colour to Black and then 

click on the Gradient Editor in the Tool Options. Here, choose 

the Foreground to Transparent preset and click OK. Click at 

the top of your image to start the gradient and drag your cursor 

down to the horizon in your landscape. When you’re done you 

can fade the gradient in by changing the Layer Blending Mode 

from Normal to Overlay, or dropping the Layer Opacity down 

from 100% to a value of your choice.

GENIUS Struggling to see your  
masked areas? Hit the \ key to show your 

Layer Mask as a bright red overlay

// PHOTOSHOP // VIDEO ON THE DISC
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1
Remove lens distortion
In Photoshop, open your RAW file and in the Camera

Raw window click the Lens Correction tab. Select

Profiles, and check the Enable Lens Profile Corrections box.

This will apply an accurate lens profile to your image and 

instantly fix any lens distortion. Elements users don’t have the

benefit of auto corrections, but it’s 

easy to do manually. Just open your 

shot in the Elements Editor, select the 

Expert tab, and go to Filter>Correct

Camera Distortion. Move the Distortion

slider until the horizon is straight. If

you used a wide-angle lens, you’ll

need to move the slider to the right.

2
Straighten your horizon
Your horizon might now be a straight line, but it may

not be perfectly horizontal, especially if you didn’t

properly level your tripod when you took the shot. Fortunately,

it’s an easy fix. In Photoshop, click the Crop Tool from the

Toolbox. You’ll now see a crop bounding box around your

shot. At the top, in the Options bar, you need to click on the

Straighten Tool – you can then run your cursor over the horizon

to make sure it’s perfectly straight. When you’ve done this, hit

Enter to make the change. In Elements, choose the Straighten

Tool at the bottom of the Tools Panel and tick the Autofill Edges

box in the options at the bottom. Next, click and drag a line

along the horizon as precisely

as you can. The software will

then straighten up your shot

and fill in the blank corners. If

you make a mistake, hit Ctrl+Z

to undo and have another go.

NEW
SERIES!

LANDSCAPE
SKILLS
PART 1/6

B EFORE YOU START PROCESSING
a landscape image, it’s good 
practice to ensure all the lines

and angles within your frame are 
geometrically true. This will give you a 
solid foundation on which to apply your
edits, and help you produce a more 
professional-looking result. These initial
editing steps are especially important for
seascapes, where an unbroken horizon makes
any distortion or skewing particularly noticeable.
In step 1, we look at how to remove lens distortion from an
image. This will ensure that the horizon isn’t bent, a problem often
experienced when using wide-angle glass. In step 2, we check out how to
level up a lopsided horizon and, in step 3, how to crop away redundant parts
of the frame for a cleaner and more striking composition. 

Level up your 
landscapes

Above & right The horizon in this wide-angle shot 

appears slightly bent due to lens distortion, and it’s 

also lop-sided due to a poorly levelled tripod. A few 

simple editing tweaks will quickly fix these issues. 

Removing lens distortion and 
straightening the horizon are 
essential first steps for landscape
editing. Tim Berry shows you how. BEFORE WONKY HORIZON

AFTER STRAIGHT HORIZON

WHAT 
YOU NEED
Q Photoshop or 

Elements

Q A landscape image

that hasn’t already 

been corrected
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Perhaps the single most
important editing step when
processing a landscape is to
get the three basic
adjustments – brightness, 
contrast and colour – spot on. 
Next month, we show you the 
quickest and most effective 
ways to do this in both 
Photoshop & Elements. 

NEXT MONTH

AND EXPOSURE

AN
TO

N
Y SPEN

CERAFTER

3
Crop your image
In an ideal world, every image would be 

perfectly composed at the point of capture,

but in reality this is rarely the case. Often, it’s only when

you see your shots on screen that compositional issues

become clear. As such, you shouldn’t be afraid to adjust

your crop, especially if it helps you position your subject

where you want it in the frame using the rule-of-thirds, or removing a distraction from the

edge of the shot. Whether you’re working in Photoshop or Elements, select the Crop Tool

in the Tools panel. Before you start, double check in the crop options that the Resolution
box is left blank, and the image Width and Height are set tot Unconstrained or No 
Restriction. To crop, pull the corners of the crop bounding box to the desired point. If you 

hold down shift as you drag, this will maintain the same aspect ratio. Hit Return when

you’re done, then head up to File>Save As and save your picture under a new file name.
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W E’VE ALL BEEN
there, thinking we’ve
taken our genre-

defining shot, only to realise that a
small child has dragged a tree into
the scene, ruining an otherwise
glorious photo. In the olden days of
film, this would have meant a
wasted exposure. But, luckily, with
the advances in Photoshop, now it
just means an extra 10minutes of
work to salvage your vision.We’re
taking a look at four intuitive
techniques to remove unwanted

clutter in your images.Whether
it’s people, objects or sensor spots,
these techniques will give you the
fighting edge and skills to remove
almost anything. Of course, we
aren’t limiting our techniques to
the humble clone brush – we’ll also
look at the Patch Tool to blend
texture, the Brush Tool to restore
colour and cutting, and pasting
other parts of the scene to keep
straight edges and perfect
proportions. Now, let’s remove
those unwanted distractions...

Four great methods
for better cloning

Below Our sunset

looks great, but

we’re not keen on

the child and tree

in foreground.

Right We used

several techniques

to remove the tree

and child from view,

leaving us with just

the sunset vista.

BEFORE

AFTER

RO
O

M
TH

E
AG

EN
CY

Kirk Schwarz looks at four powerful
techniques to give you the creative
freedom to remove almost any
distractions from your images.

WHAT
YOU NEED

Q Photoshop CS5

and above

Q An image with plenty

of distractions you

want removing

CHOPPY FOREGROUND
Cloning is a simple process to pick up, but

repeating patterns, or tightly packed textures

such as these waves, can be tricky. We’ll take

care to line up the crests for the smoothest result.

LOW DETAIL AREAS 

Our shoreline has straight lines, but not much

area for us to clone, so we’ll cut a part of it out,

paste it onto a new Layer and show you how to

fit it in seamlessly in one very simple step.

COLOUR
GRADUATED
SKIES
While cloning offers

a lot of freedom and

potential, it’s not

always the best way

to merge two 

contrasting colours 

together, so we’ll

show you how to

seamlessly blend 

colours with the 

Brush Tool, as well

as bring textures

back with the Patch 

Tool, a very 

powerful technique.
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1
Clone out your foreground
With your image opened in Photoshop CS5 or 
above, create a duplicate Layer (Ctrl+J). Using 

the Clone Stamp Tool (S) with a soft edge, you need to 
select a point which you would like to replicate (here it’s 
the water), making sure it’s as close in texture and colour 
to the area you want to add it to. When you’ve decided, 
click on the area while holding down the Alt key. Keep 
brushing in until you have removed the distraction from the lower 
part of your image. When it’s completely removed, you’ll want to go 
back over any areas which don’t look natural. Keep an eye out for 
repeating patterns (a dead giveaway from cloning) or areas that look 
blurred or muddy, which may mean that you are cloning a pattern 
against an alternative pattern that doesn’t match up on the edges.

CLONE SOURCE 
POINT

// PHOTOSHOP // VIDEO ON THE DISC
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3
Merge the colours
Now you’ve cloned out the easier parts of

your image you may need to tidy up some

of the colours in the sky. Luckily, there are a couple

of amazing techniques for skies, especially when

there’s a vibrant colour to work with. Simply using

the Brush Tool, setting it to 30% Opacity and 50%

Flow, and making sure you have a soft edged brush,

you can paint the colour back in and give it a more natural

gradient. Select the colour you wish to brush in by holding

down Alt and clicking the Eye Dropper Tool on the area. You

simply need to brush over the location where the colours

aren’t merged naturally. Don’t forget, once you’ve brushed

one colour in, you can then switch to the alternative colour

and brush a little bit back until you have the perfect balance.

4
Add the texture back
After using the Brush Tool on the sky, you

may notice that the colours look great, but

the texture doesn’t. Selecting the Patch Tool, which can

be found by cycling through the Healing Brushes (or

pressing Shift+J until you come to the tool that looks

like a patch), you simply need to draw around the area

that’s lacking detail, and let go to get the marching

ants. Once you’ve made this selection, just drag it to somewhere

with the same rough colour and texture that you want to replicate

and let go. The Patch Tool uses Content Aware fill to blend your

two selections and works really well on the sky, even better on

blue skies. You may notice a rough edge on occasions, but you

can simply use the Clone Stamp to even those out. 

5
Cut and Paste for perfect lines
You’ve cleaned up the foreground and background, 

but you still have the pesky midground, in this case

the island or shoreline. You could clone it out, but you may end

up with issues in the water or sky. Instead, you need to make a

selection with the Rectangular Marque Tool (M), making sure

you leave plenty of space above and below the area you wish

to use. With your selection made, you need to duplicate it on

to a new Layer (Ctrl+J). Now

we can move it around – simply

move the Layer until it lines up.

Don’t worry about hard edges

– you’ll tidy those up in the next

step. If you need to increase or

decrease the size, you can use

Edit>Free Transform (Ctrl+T).

This allows you to resize

the Layer. We recommend

holding Shift and dragging on

the corner point – this keeps

it at the same size ratio.

2
Clone out the sky
Once you’re happy with the way your cloning

looks, you’re ready to address the sky. Using the

same cloning technique, holding Alt and selecting a point

where the colour and patterns are similar to the area you’re

brushing over, start to paint the sky over the distraction

in a sweeping motion. You may notice areas where the

colours start to look less blended and more like you’ve

just painted them in. Don’t worry, that’s an easy fix.

GENIUS Make your Clone Tool softer 
by clicking the Brush size box (top left) 

and decreasing Hardness to 0
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7
Pay attention to the fine details
As we mentioned, attention to detail is everything 

when you’re removing objects and crafting a new part 

of the image. Some tell-tale signs include repeating patterns 

(which can happen when you’re using the same small area as 

a source point for your cloning), hard edges from any areas 

you’ve cut out and pasted over other areas (which you will need 

to brush out using a black Brush Tool on the Layer Mask), or 

areas which lack any texture (a side effect of painting colours 

in with the Brush Tool). Using the same techniques we’ve 

outlined here, you can zoom into the image and make sure 

nothing stands out, and if it does, use these skills to tidy it up.

8
Flatten your image and save
Now we have our edited image, with only those in 

the know realising there was any kind of distraction

to begin with, it’s time to finish up. We can start by flattening

our Layers (which will reduce the file size), which can be 

done by right clicking on any of the Layers in the Layers 

panel and selecting Flatten Image. You can also do this by 

selecting any Layer you wish to merge (clicking on it with your

mouse while holding Ctrl to select more than one Layer) and

pressing Ctrl+E. Don’t forget to use Save As, so you still have

you original photo in case you ever need it, and save it as a 

JPEG file (unless you want to go back and edit any individual

Layers at a later date, in which case you’ll have to use PSD).

6
Tidy up your edges
We said you may find some edges on

your cut and paste, so this step will show

you how to blend them in. First, you need to create

a Layer Mask (the square box with a hole in it at

the bottom of the Layers panel), then make sure

the white box next to the Layer you’re working 

on is selected. Now you can use the Brush Tool,

set to 100% Opacity and 100% Flow, to paint black on the

top and bottom to hide any sky or water detail that doesn’t

match. After this is complete, lower the Brush Tool Flow to 

20% and simply brush over any hard edges to blend them 

in – the more you paint over them, the greater the effect. 

Because it’s a Layer Mask, you can simply brush with white 

to unhide anything you’ve accidentally brushed away.

The Clone Stamp Tool is very powerful, and one of the first 

tools you will learn to use in Photoshop. Although it’s easy 

to pick up, mastering it may take a little time – there are 

definitely a couple of mistakes we are all guilty of. When you 

are cloning from a small area, or using the same source 

point often, you may notice a repeating pattern, which is a 

dead giveaway, so change your source point often to avoid 

this. You may also fall foul of misalignment of any straight 

edges. To be sure you avoid this, you can press the Caps 

Lock key, which will give you a precise pointer icon, allowing 

you to perfectly line up your clone. 

 Pro advice Common  
 cloning mistakes 

REPEATED TEXTURE MISALIGNED CLONING

// PHOTOSHOP // VIDEO ON THE DISC
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Make your model go up
in a puff of smoke with
Dan Mold’s stylish
do-it-yourself

dispersion project.

86 PRACTICAL PHOTOGRAPHY

Add impact
to portraits

Above We’re giving away five free smoke brushes for you to

use, but you can learn how to shoot every aspect and bring

it all together in Photoshop on the following pages.

Right The

side-on

portrait and

pictures of

smoke don’t

look like much,

but when 

combined

creatively,

they become

more than the

sum of their

parts.
BEFORE

FREE BRUSHES

T HERE ARE GENERALLY
two trains of thought when it
comes to post-processing – apply

small, subtle tweaks that give the shot a
natural but enhanced look, or carry out more
obvious conceptual fantasy works of art that are
more ‘out there’. Our smoke dispersion project
definitely belongs to the latter, so is a great one to try if
you want to let your imagination run wild in Photoshop.

It’s a project of two halves and we’ve outlined each
step of the journey, from start to finish. We kick off
by capturing a sharp profile portrait, then show you
how to shoot your own smoke textures with a paper
backdrop, off-camera flash and an incense stick. When
you’ve got the pictures on your memory card it’s time to
blend them together in Photoshop. We show you how
to transform your smoke shots into custom brushes
using the full version of Photoshop. Elements users
can’t create custom brushes, but we’re supplying a free
smoke brush pack so you don’t miss out on the fun.

Raring to go? Turn the page to see how you can
make your own Hollywood-style special effects.

WHAT
YOU NEED
Q A DSLR or CSC

Q A flashgun, triggers

and a few other props

Q Photoshop or

Elements

AFTER
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1 Shoot in manual mode
Manual mode gives you total control

of your exposure and is crucial for getting

the best shots with off-camera flash.

2 Using off-camera flash
We’ll be lighting the smoke with a

flashgun off-camera. You’ll learn how to 

use triggers to create an easy setup.

3 How to use Layer Masks
These are essential when making 

multi-Layer composites, giving you a fine 

level of control when merging images.

3 skills you’ll learn
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This technique requires a little time 
to get both the portrait and the smoke 
shots just right. Elements users won’t 
be able to turn the smoke images into 
custom brushes, but they can still be 
great to shoot and use as textures.

There’s some great fun to be had 
by setting up your own home studio 
and it’s really easy to do. You just 
need some basic equipment such as 
a camera with a manual mode and a 
flashgun that can be fired off-camera 
with a set of radio triggers.

You’ll create the smoke with an 

incense stick and a holder. Incense 
is pretty safe, but it’s worth keeping 
a glass jar with sand in it to dispose 
of the burnt sticks and some water 
nearby too for worst case scenarios. 

For the portrait shot you just need 
a camera and a model – you could even
shoot a self-portrait. When you’ve shot
the portrait you just need to apply a little
creativity in Photoshop to complete the
look. But we’ll get onto that later. Make
sure you have the following items below
and then you’re good to get shooting
your portrait and smoke textures. 

Get your shots in the bag

Above Triggers are an easy and affordable 

way to fire your flashgun off-camera.

 Tripods and lightstands 

You’ll need one tripod to hlp support and position your  

camera, and another tripod or lightstand to set up your 

off-camera flashgun to the side of your incense stick.

Incense

These affordable sticks

don’t just make your

house smell nice, they

create smoke trails

that make brilliant

custom brushes.

 Triggers  

These attach to your 

camera and flashgun to

trigger the flash away

from the camera’s

hotshoe for more creative 

lighting. The budget 

Yongnuo RF-602TX set 

we used cost just £20.

 Flashgun  

Because smoke 

moves quickly it’s 

important to freeze 

it with flash to get 

a sharp shot. Flash 

triggers let you fire 

the flash remotely 

and most have a 

1/4in female port 

in the base so you 

can put the whole 

setup on a tripod 

or lightstand.

1
Dial in your settings
Put your camera into aperture-priority mode and

zoom your kit lens to the 55mm mark (70mm on

a full-frame camera). Then set the aperture to f/5.6 and

the ISO to a value of 400. 

2
Take the portrait
Ask your model to pose how you want them  

to – a side-on profile shot works well for this 

project, but feel free to try a few different angles. Then use 

AF-S mode to focus on the model’s eye and take the shot.

 Creative camera 

You’ll need a camera with MASP creative modes, the 

important mode being manual (M), so you can take total 

control of the exposure when firing your flash off-camera.



PRACTICALPHOTOGRAPHY.COM  89

1
Set up your smoke studio
To shoot your own smoke textur

to turn into Photoshop brushes, 

you’ll want to work in a well-ventilated

room or outside. This reduces the risk of

setting off a fire alarm. Find a table you

can put your incense stick on and an

incense stick holder which catches the

ash as it burns (we got our holder and

24 sticks for just £3). Put up black paper

or a card background behind it with some

tape (de-tac it on your clothes so you don’t

damage any paintwork). Smoke is lightly coloured

and will be much easier to see against this dark background.

2
Prop up a flashgun for extra light
A flashgun is a great way to get sharp, shake-free

smoke shapes because it freezes the moment.

Use a pair of triggers to set off the flash remotely, attaching

the receiver to the flashgun and then putting the whole set

up on a tripod or lightstand. Side-light the smoke with the

flash and attach a piece of black card to the flashgun head

with an elastic band to stop it illuminating the background.

4
Dial in your settings and shoot
Put your camera into its manual mode and set an 

aperture of f/8, a shutter speed of 1/200sec and ISO

of 100. Now set the flashgun power to 1/8th and take a test shot

to see if the flash is firing. Finally, light the incense stick and 

take another test shot. If it’s too bright, lower the flash power.

If it’s too dark, increase the flash power. You can also waft the

smoke with a piece of card to create different smoke shapes.

3
Compose your shot on a tripod
Attach the transmitter trigger to your camera and

mount it on a tripod. Use the 55mm end of a kit lens

on an APS-C camera, or around 70-85mm on a full-frame

camera to compose on the area that the smoke will flow up

into. Make sure the tip of the incense stick is just visible at

the bottom of the shot. Now go into Live View and focus

on the stick, then switch to Manual Focus to lock it off.

Q IMAGE NOT SHARP

Make sure your image stabilisation

is switched off, as this can introduce

shake into your shots when shooting

on a locked-off tripod.

Q�FLASH TOO HARSH 

If your smoke trails are coming out

too bright, try moving the flashgun

further away from the smoke or turn th

flash power down. If it’s still too bright, dial

in a higher aperture to make the whole image

darker, and make sure your ISO is set to its lowest value.

Q�BACKGROUND TOO BRIGHT 

The background should come out completely black, so 

make sure you’ve secured a large black flag to the side of

the flashgun with an elastic band so that the light is directed

away from it. Make sure your flash is exactly side-on to the

smoke so that it doesn’t light up the black backdrop.

 Pro advice How to fix 
shooting problems 

// PHOTOSHOP & ELEMENTS // FREE BRUSHES ON THE DISC
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2
Invert the smoke and brighten it
In the Layers panel click on the top smoke Layer 

to make it active, then hit Ctrl+I to invert it. You 

want the background to be completely white, so go to 

Image>Adjustments>Curves. Now select the White Point 

eyedropper and click on the background to make it totally white. 

Hit OK, then press Ctrl+Shift+U to desaturate the smoke.

4
Resize and use your new brush
You need to resize your smoke with Image>Image 

Size. Tick Resample and change the longest side 

(Width or Height) to 2500 pixels with a resolution of 300ppi. 

Hit OK, then go to Image>Flatten Image to merge the Layers. 

Now go to Edit>Define Brush Preset. Give the brush a name, 

then hit OK. It’ll now be the last brush in your brushes.

1
Duplicate your smoke Layer
Load up a smoke shot into Photoshop and hit Ctrl+J 

to duplicate it. In your Layers panel (Window>Layers) 

click on the Create new fill or adjustment layer icon and choose 

Solid Color from the list. In the Color Picker choose pure white 

(R:255, G:255, B:255) and hit OK. In your Layers panel, drag 

the Color Fill Layer in between your two smoke Layers.

3
Tidy up any rogue smoke
Staying in the Layers panel, click on the Add Layer 

Mask icon. Now choose the Brush Tool from 

the Toolbox and hit D followed by X for a black foreground 

colour. Using a soft Brush Tool, and a Flow of 20%, paint

over any stray smoke strands and the incense stick to turn it 

completely white. Use the [ and ] keys to change brush size. 

Combine your 
shots together

Above Using Photoshop CC you can make your own custom smoke 

brushes and create this amazing smoke dispersion effect.

By now you’ve done the hard work and
the pictures are safely on your memory
card, ready to go. So now it’s time to
relax and spend some time bringing
it all together in post-processing. The
full version of Photoshop is essential
for creating your own custom smoke
brushes. But that doesn’t mean you miss
out on the fun if you’ve only got Elements.
We’re giving away five smoke brushes free with
this issue, so you can load them up and create
your smoke dispersion. If you’re using Elements
start on the page opposite, but if you’ve got 
Photoshop CC, start with the tutorial below.

TIP 
ROTATE

YOUR BRUSH
In the Brush panel you can 

rotate and flip the smoke 

brush, so you can paint it 

in at the exact angle 

you want.

MAKE YOUR BRUSHES
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1
Cut out your portrait
Open your portrait and use the Polygonal Lasso

Tool to draw all the way around it (draw across

the neck when you get there). When you’re done you’ll 

see the marching ants, so hit Ctrl+J to punch it onto a

new Layer. In the Layers panel (Window>Layers) switch

off the Background Layer by clicking the Eye icon.

2
Desaturate and extend the canvas
Hit Ctrl+Shift+I to desaturate the picture, then head 

up to Image>Canvas Size. Now extend the canvas

to give yourself a little more room for the smoke to flow into.

We set ours to a Width of 60cm and Height of 60cm. Hit OK to

apply. Now use the Move Tool to drag your portrait to the right

or left edge – the smoke will appear in the space behind it.

4
Blend the face into the background
Grab the Brush Tool and choose one of your smoke

brushes (you can load up the free ones if you use

Elements). Now click on the top Layer in the Layers panel, click

Add Layer Mask and with a black Brush Tool paint over some

of the face to reveal the background. You can change the Brush

Size with [ and ] and reduce the Opacity to get it looking right.

6
Build up the effect to finish off
To get the effect looking right you’ll want to

spend a bit of time reworking the Layers and

Layer Masks to build up the effect. When you’re happy

with the result, go to File>Save As and save your shot

as a Photoshop (PSD) file to keep the Layers or choose

JPEG to merge the Layers and reduce the file size.

3
Add a dramatic background
Click on the Background Layer and go to Layer>
New>Layer. With the Gradient Tool, set it tor

Radial and hit D on the keyboard to reset the foreground

and background colours. In the Gradient Editor, choose the 

Foreground to Background preset and hit OK. Apply the

gradient by clicking the middle of the shot and dragging out.

5
Add surrounding smoke
Create a new Layer for your smoke by heading

to Layer>New>Layer With the Brush Tool active,r
choose a smoke brush you want to use. Hit D for a black

Foreground Color and then paint in some extra smoke to

complete the look. You can drop the Layer Opacity down 

to blend it in and hide parts with a Layer Mask if needed.

DISPERSE YOUR PORTRAIT

// PHOTOSHOP & ELEMENTS // FREE BRUSHES ON THE DISC
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Louise Carey delves into the art of black &

white with 19 evocative mono Actions that  

will give your image an extra dramatic edge.

How to use your
free Mono Actionse

W HILE WE ALL LOVE BEING ABLE TO EDIT 
our images to perfection, sometimes there just
aren’t enough hours in the day to make all the

adjustments you’d like to. Luckily, if you’re time-poor and
looking for a way to speed up your workflow, we’ve got
the perfect solution for you. Photoshop Actions are 
a fantastic way to shave precious minutes off your edit, 
while still creating beautifully crafted images. Actions are
essentially pre-recorded adjustments that your editing 
program remembers, so that you don’t have to make 
the same edits twice. Once you press ‘Play’, the desired 
adjustments will be instantly applied to your shot. You 
then have the opportunity to dive into the different Layers
and change them to suit your image as necessary. Both 
Photoshop and Elements have the capacity to load and
run these Actions, so check out the steps below to find
out how to make the most of your free gift.

1
Load your Actions
Open up your image in

Photoshop or Elements. 

Go to Window>Actions and make sure

Actions is ticked. This will bring up the

Actions panel. In the top-right corner of

this panel, click on the menu icon (above

the trashcan in Elements) and choose

Load Actions from the 

list. Now navigate your 

way to the Free Gifts 

folder on your Learn
Photography Now disc

and double-click on

the PP Collection –

Mono Styles.atn file.

2
Find a look you like
In the Actions panel you’ll see

your free 19 Actions appear

under PP Collection – Mono Styles.

Have a scroll through the Actions until

you find one you’d like to experiment

with, then simply click on it so that it’s

highlighted and press the Play Selection

button. Depending on how many steps it

has, the Action may take a few seconds

to complete. If you want to try another

Action on for size, simply go to your

Layers panel (Window>Layers) and

drag the new Layers into the Trash,

leaving behind your original Background

Layer for you to play around with.

3
Customise and save
Some Actions will create 

additional Layers. These can 

be tweaked and customised to your liking 

by double-clicking them and changing 

the values, or lowering the Layer Opacity 

for a more subtle effect. You can also 

mask off parts of the adjustment by 

painting black onto the Layer Mask to 

hide the effect from view. When you’re 

happy with the result, go to File>Save 
As and save your shot under a new 

filename. To try out a different Action just 

close your image down without saving 

it, then open the original up again and 

try a different Action on your shot.

BEFORE

Above Choose an image with plenty of contrast that will convert well 

into black & white. This flower is well lit, while the background is dark. 

AN
ASTASIA VISHN

ICKAYA

WHAT 
YOU NEED
Q Photoshop or

Elements

Q An image you’d like

to apply a variety

of black & white 

effects to
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ARTISTIC 4

LOW KEY

HIGH KEY

HIGH NOISE

ARTISTIC 2

19 
ACTIONS 
ON THE 

CD

// PHOTOSHOP & ELEMENTS // FREE ACTIONS ON THE DISC



PHOTOSHOPGENIUS

94 PRACTICAL PHOTOGRAPHY

Dan says: We have
to start by taking
our hats off to
Kanstantsin. Firstly,
for not letting his
disability stop him
from going out and

taking photos, and secondly for taking 
such great pictures handheld. His use 
of image stabilisation is ingenious and 
resourceful – we’d have easily believed 
that he carefully framed-up using a
tripod, had he not told us his secret.

When it comes to compositions,
they don’t get much better. Kanstantsin
has captured a scene that instantly
transports us to this stunning location.
It has an extraordinary depth to it
too. Starting with the colourful leaves
in the foreground, the beautifully
blurred waterfalls in the mid-ground
and the bridge in the top third,
Kanstantsin has demonstrated a strong

understanding of the rule-of-thirds. 
He also carved out a logical path for 
the eye to follow through the picture. 

Our only slight criticism is that 
the original shot is about 1 stop 
underexposed. A slight bump to the 
brightness using Curves, or a Levels 
adjustment in Photoshop, would make 
the shot much lighter and brighter (see 
Photo Fix panel). This would also help 
to make the rich greens and yellows 
in the picture as vibrant as possible.

We appreciate Kanstantsin is
confined to limited shooting and
editing times. But if he can carry 
out this small adjustment it’d really 
take his picture to the next level.

We’re impressed by Kanstantsin’s 
dedication and perseverance to
photography and glad to say it’s paid 
off with this fantastic autumnal
landscape. We hope to see and
share more of his work soon.

Autumnal falls By Kanstantsin Markevich

Stuck in an editing rut with your shots? Send them over
to ppsubmissions@bauermedia.co.uk and our Photoshop
experts will show you how to professionally retouch them.

Kanstantsin

says: I always

try to convey the

atmosphere and

mood of nature in

my landscapes.

But I have problems with the

pressure in my eyes, so I have

to limit my shooting and editing

sessions. Out in the field, this

means I shoot on-the-go without

a tripod. This can be problematic

for shooting motion like the

water in this image. But with

decent image stabilisation it is

possible. Due to my condition,

I can’t spend long editing my

pictures. I usually just tweak

the RAW until it looks right, and

apply a Highlights/Shadows

adjustment in Photoshop.

BEFORE

AFTER

PhotoFixer

Image is 
underexposed 
so colours look 

less vibrant than 
they could.
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Fujifilm X-E2 | 27mm | 0.3sec | f/16 | ISO 200

TIP 
MAKE YOUR 

COLOURS POP
These autumnal greens and

browns work brilliantly because 
they sit next to each other on

the colour wheel. Find out
more about analogous

colours at color.
adobe.com

Photo Fi Brighten your pictures in Photoshopx

1
Use Curves...
Curves is a powerful tool for 
adjusting image brightness, 

contrast and colour. To use it, go to your 
Layers panel (Window>Layers) and click 
on the Create New Adjustment Layer icon, 
choosing Curves from the menu. Adjust 
the curve to change the luminosity of 
different tones in your shot. We pulled the 
middle midtones section upwards to 
brighten the picture. If areas start to clip 
to pure black 
or white, you 
can paint 
black with a 
soft Brush 
Tool on your 
Curves Layer 
Mask to 
restore detail 
in the clipped 
areas.

2
...or use Levels
Levels is a really good way of
changing the brightness of an 

image in Photoshop or Elements. In your 
Layers panel click on the Create New
Adjustment Layer icon and choose Levels.
Drag the middle slider to set the midtones.
Then drag the outside blacks and
highlights sliders in to increase contrast.
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Windswept
By Ruslan Isinev

Ruslan says: For this shot I wanted to 

capture my model’s hair moving. I

asked my assistant to wave a reflector

to blow a gust of wind up to her head to

get this effect. To make sure the

picture came out sharp I set a wide

aperture of f/2 and a high ISO of 2800 so that I could

freeze the action with a fast shutter speed of 1/8000sec.

Dan says: Great portraits 
have a strong story, and 
Ruslan’s shot certainly has 
that. It’s clear that he’s put a 
lot of thought into the model’s 
clothing, her expression and 
the location. Blowing her hair 
with a reflector is also a nice 
touch, giving her a 
windswept and wistful 
aesthetic. The location is 
packed with texture and 
contrasts with the model’s 
bright garments to help her 
stand out. 

In the original shot the 
model’s skin is a midtone and 
the surrounding background 
is in deep shadow. This makes 
the whole shot look quite 
dark, and the skin tones look 
flat. We boosted the exposure 
to inject more highlights into 
the model’s skin using the 

Exposure slider in Adobe 
Camera Raw (see Photo 
Fix 1). This makes it much 
brighter and more appealing.

Ruslan had the right 
idea to freeze the action. 
But by using a high ISO 
value, he’s introduced quite
a large amount of digital 
noise. This becomes more 
apparent when the exposure
is corrected. Off-camera 
flash would be an idea for 
brighter, noise-free shots in
the future. But this gritty 
look can be smoothed out 
with a little noise reduction
in Photoshop (Photo Fix 2).

Overall, these are minor
tweaks. But addressing 
them in Photoshop is 
easy and really helps 
bring Ruslan’s shot up to 
a professional standard.

Nikon D700 | 28mm | 1/8000sec | f/2 | ISO 2800

BEFORE

Photo Fix Reduce noisex
& correct brightness

1
Correct exposure
Open your RAW file into Photoshop to load it

into Adobe Camera Raw. Now, in the Basic

panel adjust the Exposure slider until you’re happy with

the overall luminance of the shot. You can also hold the 

Alt key down as you make your adjustments to see a

clipping warning, to see if your shadows or highlights clip.

2
Reduce noise in seconds
In Adobe Camera Raw you can add Noise

Reduction in the Detail tab using the Luminance

slider. If you 

prefer, this is 

possible in 

Photoshop too.

Just go to

Filter>Noise>
Reduce Noise
to reduce the

gritty look you

get from

shooting at

high ISO 

values.

AFTER

Image is a 

little noisy from 

high ISO 2800 

value

Image

is rather 

underexposed 

so skin tones 

look flat
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Photo Fix Boost coloursx

1
Add a Hue/
Saturation
adjustment

Open your shot into Photoshop with

File>Open and head over to your

Layers panel (Window>Layers). Click

on the Create New Adjustment Layer

icon and choose Hue/Saturation

from the list that appears. Now you

can drag the Hue slider to change

the colour, Saturation to choose how

intense you want the colour to be

and finally Lightness to change how

bright or dark the colours look.

2 channels
Staying within

the Hue/Saturation

adjustment panel you can

edit specific colours

within your picture. To

boost the orange in this

tiger’s head, click on the

box that says Master and

change it to Reds. Here

we can increase the

Saturation slider to make

these specific colours a

bit more punchy. While

you’re working on a

specific channel you can

also adjust the Hue and

Lightness. Hit OK, or click

the small cross when

you’re done, to close the

panel and make your

changes.

AFTER

Tschuna
By Kathryn Willett

Kathryn says: My
local zoo in Dudley is
my favourite place to
take pictures. I used
a Nikon P510 bridge
camera with a large

zoom to get this close-up. The lens is
also small enough to aim through the
railings without them appearing in the
shot. I never hide the fact that my
subjects are captive, but I try to get
the most natural look possible.

Dan says: Tigers always make fantastic 
subjects. Kathryn’s strong eye contact here 
makes it a very powerful portrait indeed. 
She’s been rewarded by choosing her 
moment carefully, shooting against a deep 
black background. This really helps the 
bright orange coat of the tiger to stand out. 
It gives the shot a studio feel too.

A tighter landscape crop would make the 
eyes larger in the frame, adding impact. I just 
wish a little more of its left eye was showing 
through the leaves. 

Zooming in on the fur, we can see details 
look a little waxy. This is due to the small 
sensor in Kathryn’s camera. We’d definitely 
recommend she make the jump to a DSLR or 
CSC with a larger APS-C or full-frame 
sensor for better image quality. She’s 
undoubtedly got an eye for photography, but 
could really excel with the right equipment.

Nikon Coolpix P510 | 550mm | 1/160sec | f/4.9 | ISO 800

BEFORE

Colours  

are slightly 

subdued

Square 

crop means 

the eyes are 

small in the 

frame
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PHOTOSHOPGENIUS

A messy hard drive can cause headaches when looking for

pictures, so it’s sound advice to put shots from your shoots in

a folder. Give it a date and name, such as ‘2017 12 25 

Christmas Day’. Start with the year, then month and day to

make them appear in chronological order. To sort and edit

shots within a folder, Adobe Bridge can help no end. Navigate

to your photos using the Folders panel and then go into the

Filmstrip module. You can now scroll through your shots.

Assign star ratings or labels to pictures by going to Label at

the top, or hitting the keyboard shortcuts Ctrl+1 to Ctrl+9. You

can then narrow your search down to images with a specific

star rating or label using the Filter panel.

If you’ve got a lot 

of images you 

want to stack in 

Photoshop 

Layers, copying

and pasting in

each shot 

manually can be

a laborious 

process. 

Instead, find

your shots in

Bridge and click

on the first shot

you want to

load. Then hold

the Ctrl key and

click on all of the other pictures you want to load. When they’re

all highlighted, head up to Tools>Photoshop>Load Files into 
Photoshop Layers. Photoshop will then automatically open and 

stack your Layers. Depending on how many shots you have it 

can take a while, but it automates the process.

Organise images easily with
star ratings and labels

Output images as a PDF to 
create a professional portfolio

Stack shots into Layers quickly

A D O B E B R I D G E

Quick tips & keyboard shortcuts that’ll
help you process your images faster!

hop

A D O B E  B R I D G E A D O B E  B R I D G E

ADOBE 
BRIDGE 
SPECIAL

Turning a selection of 

images into a PDF file is 

a great way of creating

a neat collection and

making your own 

portfolio. Just open up

Bridge and click on the

Output module. In the

options on the right,

choose PDF and set the

Document Size to your

preference. In most

cases A4 is ideal. 

The Output module

does not come as

part of the build with

Bridge CC, but can be

downloaded for free

from Adobe’s website:

tinyurl.com/nvb7y5g

We hope you’ve enjoyed our

Photoshop Genius section

and would love to see how

you’re getting on using our

brand-new editing

techniques. So why not share

your finished shots with us?

Each month we’ll announce

our favourite entry on our

Facebook page, and the

winner will receive a Manfrotto

Stile Allegra 50 bag, worth

£50! To be in with a chance to

win, just follow the Photoshop

techniques and then

send your results to u

at ppsubmissions@

bauermedia.co.uk

with the subject head

Photoshop Genius. W

forward to seeing them soon.

Share your shots with us and win! WIN! 
A £50
BAG



Beautiful, contemporary frames to preserve your precious 
memories, with over 95 stylish frame colours and profiles, 
28 window mount colours and easy online ordering. Plus 
every framed print is guaranteed for 5 years!

WWW.ONEVISIONIMAGING.COM | 0845 862 0217

The Ultimate 
in online framing

A framed photo is not 
just for Christmas…

 Prices from

£11

36 
NEW Frame 
Mouldings
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Know
ouY rStuff

All your technique and gear questions answered by
our team of experts knowyourstuff@bauermedia.co.uk

Tim Berry 
PP’s deputy 

editor has a 

master’s degree

in photography

and has taught

undergraduates.

Louise Carey

PP’s features

writer is an

experienced

fine art and

documentary

photographer.

Dan Mold

UK-based travel

and wildlife pro

Dan has an eye

for detail and lots

of insights to

improve your pics.

Timsays:Photography can be an
expensive hobby, so the prospect
of earning some cash off the back
of your investment is an alluring
prospect. The industry is very
competitive, but if you go in with
the right knowledge, equipment
and approach, there’s no reason
why you can’t be successful. Your
new venture is likely to be a slow
burner, so don’t quit your day job
just yet – just start by working at
weekends and see where
it goes. Here are a few
things to think about...

Assist a pro
Whichever field of
photography you
plan to specialise in –
weddings, portraits,
products, food – it’s
definitely worth asking
a pro if you can assist
them on a few shoots. You
probably won’t get paid, but you’ll
gain some indispensible insight
into what the job entails, and
pick up plenty of shooting tips.

Market yourself
Make up some business cards
and hand them out to as many

people as you can. Be cautious
about paying for advertising
at this stage – it’s expensive
and won’t necessarily yield
returns. A good website is
essential to winning new work
– more on this to the right.

Invest in the right kit
For almost all professional work
you’ll need two cameras so you
have a backup should one fail.

This is especially crucial
for weddings where
there are no re-runs.
Also ensure you have

pro-standard glass,
with at least three
sharp, wide-aperture

lenses. In particular,
a 50mm prime, such
as Sigma’s 50mm f/1.4
Art (above), always
comes in useful.

Set your prices
Resist the tempation to compete
on price – there will always be
someone working cheaper, or
even for free. Instead, compete
on quality, developing a personal
style that your customers will
love. Set your prices at the local

industry average from the start, 
then up them from there.

Register self-employed
Once you’re ready to start 
taking on paid jobs, you’ll need 
to register as a sole trader, 
which marks the point at
which you’ll start paying tax 
on your income, and some 
added National Insurance 
contributions. Just head to 
gov.uk for full instructions. 
Keep all your receipts and 
invoices as you’ll need these 
when filing your tax return.

Build a portfolio
Build up a bank of images 
for your website. The quality 
of these shots are ultimately 
the reason people will hire 
you. Constantly update your 
portfolio with your latest work. 

I’m thinking about using my photography skills to start 

earning some extra money. Can you offer me any 

practical advice that will help me get started?

Chris Tanner, Belbroughton

ER
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How do I start 
a photography 
business?
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Your website is your digital shop 

front. Potential customers will 

come here first to check out your 

portfolio, prices, availability and 

contact details. A professional-

looking site that is easy to

navigate will give the impression 

that you’re a safe pair of hands, 

so you should place huge 

importance on making the user 

experience as smooth as 

possible. As part of this keep 

your images relatively low res so 

they load instantly, and keep the 

amount of text to a minimum. 

Only showcase up to 50 of 

your very best images or you’ll 

risk watering down your portfolio 

with less impressive shots.

Some photographers like to 

have a ‘one size fits all’ website

showcasing lots of different 

genres. In my view this is a

mistake. If you’re a wedding

photographer, dedicate your site 

to weddings – clients generally

won’t care how good you are at 

capturing birds. You can always

start a second site for your

other photography.

If you find the prospect of

creating your own website

daunting, it’s actually far easier

than you think. There are lots

of companies that offer very

impressive pre-designed 

templates, and they’ll also look

after the hosting and domain 

name registration for you. We 

recommend format.com.

Above There are plenty of companies offering website 

templates, some of which are free, and some paid. 

Format.com is very easy to use and reasonably priced.

Start finding work Set up your own websitek

TIP
TAKE OUT 

INSURANCE
As well as full cover for your

kit, you should also have

public liability insurance 

should anyone take legal

action against your

business.
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How do I resize my
images in Photoshop
using interpolation?

Alan Grey, Dersingham

Dan says: Interpolation is the 
term used to describe the process 
of adding new pixels to an image 
when you enlarge it, increasing 
its resolution. There are three 
main types of interpolation in 
Photoshop, which we’ve outlined 
in detail below. Bilinear and 
Bicubic are the preferred options, 
as they take into account existing 
pixels within the image file to 
intelligently guess what the colour 
and tone of the new pixels should 
be. We recommend the Bicubic 
modes as they sample more data 
for the most accurate results. 
There’s a total of four Bicubic 
modes, so we suggest using Bicubic 

Automatic, which intelligently 
chooses the best mode to use, 
depending on whether you’r 
enlarging or scaling down. The 
interpolation method is selected 
from the drop-down box at the 
bottom of the Image Size box. 
If you were to upsample the 
image to larger than the 
original size, new pixels would 
then be need to be created, so 
interpolation would take place. 

Resize the ‘smart’ way
It’s best to use Smart Objects 
if you’re resizing often. These 
special Layers remember the 
original image resolution, so can 
be downsized and enlarged to 
full-size again without losing 
quality. To create a Smart Object, 
right-click on the Layer and 
choose Convert to Smart Object.

What’s the best way to 
resize in Photoshop?

Bicubic Automatic
Like Bilinear, Bicubic takes into account 
surrounding pixels, but it uses 16 of them 
for smoother tonal graduations. This 
mode produces the best quality, but 
takes the most time to process. Bicubic 
has different modes to suit different 
processes, but Bicubic Automatic 
chooses the best one for the job.

Nearest neighbour
This is the most basic type of interpolation
as it creates new pixels by copying the
values of adjacent pixels. It preserves
sharp edges in areas of contrast, so 
is ideal for graphics, but it’s unlikely 
to give you the best overall result on a
regular image. It’s useful for upsampling
low-res screenshots with lots of text.

Bilinear
This mode is more advanced than 
Nearest Neighbour and produces 
smoother results. Bilinear takes the 
average of four surrounding pixels to 
work out what the ‘new’ interpolated 
pixels should be. Adobe say this method 
produces ‘medium-quality’ results, and 
hard edges may become slightly soft.

DAN M
O

LD/BAUER



Teleconverter options compared

1.4x converter = 420mm f/4

Focal length is extended to 420mm,

so the subject is bigger and the quality

slightly worse. The widest aperture has

been reduced to f/4, 

so the background 

isn’t as blurry and 

the shutter speed

isn’t quite as fast.

2x converter = 600mm f/5.6

Focal length is doubled to 600mm

so the subject is much larger. Image

quality is reduced

and the f/5.6 aperture

means the ISO had

to be increased to

achieve a fast enough

shutter speed.

No converter = 300mm f/2.8 

Without a converter, the lens’ 

maximum aperture of f/2.8 allows  

fast shutter speeds, and image quality 

is pin-sharp with very little chromatic 

aberration. However, the subject is 

small in the frame so a tight digital  

crop is required, which means a lower 

res final image.

p y pp y

 
has disappeared

I use Photoshop

Elements 15 and have

lost the outline of my

Brush Tool. I can only see a 

crosshair. Any ideas?

Julian King, Camden

Louise says: Don’t worry Julian, 

this is a very common issue. The 

crosshair you can see is there 

because the Caps Lock key has 

been pressed. This mode allows 

you to see the exact centre of your 

brush, helping you make very 

precise strokes with the Brush 

Tool. Unfortunately, it’s quite easy 

to accidentally hit this button 

when you’re editing, especially if 

you use the left Shift key for 

shortcuts, which sits directly 

beneath it. Fortunately it’s a quick 

and easy fix – just hit the Caps 

Lock key again and your brush 

outline will reappear. 

A very similar problem is often 

experienced when the Tab key is 

pressed – this makes the Tools 

Panel and any other active panels 

disappear. So if this ever happens, 

you know why!
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TIP
CHECK YOUR

COMPATIBILITY
The spec sheet of a

teleconverter will tell you if

it can be used with your

lens, so check before

you pay out!
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I’d like to fulfil my lifelong

dream of photographing the

Aurora Borealis. Where do you

recommend I go to do this?

Linda Palmer, Leatherhead

Tim says: The Aurora is a stunning
natural phenomenon visible when
solar activity is high above the Earth’s
magnetic pole (around 65°N and S of the
equator). This makes Canada, Alaska,
Scandanavia and Russia perfect viewing
spots, though sometimes they’re visible
as far south as Scotland. Solar activity
peaks every 11 years, with the last peak
in 2013. This means we’re approaching
a period of low activity, but don’t let this
put you off – you still have a good chance
of seeing them. Below we check out three
of Europe’s best viewing locations.

Where can I best shoot
the Northern Lights?

What is my 
DSLR’s image 
lock button for?

There’s a lock button on 

the back of my Nikon

camera. What is this for?

Bridget Hincliff, Buckinghamshire 

Louise says: You’re probably 

referring to the Protect button, 

which is marked by a key symbol. 

Pressing this once when reviewing 

an image protects it from being 

accidentally deleted. Canons also 

have this function, but it’s done via 

the menu. This can be a really 

useful function if you’ve taken a 

stunning image that you simply 

can’t risk losing.

It’s also possible you’re making 

reference to Nikon’s Focus 

Selector Lock Switch, marked by 

an L, which stops you accidentally 

changing the focus point. Many 

advanced Canon cameras, such 

as the 5D Mk IV, have a similar 

switch to lock the rear dial, which 

stops you accidentally changing 

settings. These too can be useful, 

but are more often a source of 

frustration, as users mistakenly 

flick the switch and then can’t 

figure out why their settings or 

focus point won’t change.

Top three destinations to shoot the Aurora

Abisko, Sweden
Head up the Arctic Circle during the 

winter and shoot the Aurora from 

Sweden’s frozen lakes and snow-dusted 

pine forests. Fly in to Kiruna then drive 

north to Abisko. Tree foliage can also be 

very impressive in the autumn, so this is 

the perfect time of year to visit.

Lofoten Islands, Norway
A small but stunning archipelago off  

the north-west Norwegian coast, these 

islands are at the top of many a 

photographer’s bucket list. Lofoten is 

perfect in the autumn for Northern Lights, 

and its amazing fishing villages will 

guarantee you amazing shots.  

Reykjavik, Iceland
Perhaps the world’s most famous 

viewing spot for the Aurora, Iceland’s 

incredible landscape makes for perfect 

foreground interest. Although expensive 

while you’re there, flights are relatively 

cheap. Base yourself in Reykjavik, and 

explore route 1 along the south coast.
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Above The Aurora is strongest around 65°N 

or S of the equator, but when activity is 

strong, can be viewed further south. Iceland, 

Sweden and Norway are ideal viewing spots.
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On a never-ending quest to portray ‘that feeling’,
Thomas Heaton is obsessed with the great

outdoors and images with narratives.

S E A R C H I N G F O R

STORIES
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PRO SHOWCASE
AMAZING IMAGES AND INSIGHT

FROM THE WORLD’S BEST 
PHOTOGRAPHERS



Thomas Heaton  
is an acclaimed
landscape, travel 
and outdoor 
photographer 
based in the

North East of England. He’s 
also a prolific YouTuber with a
growing audience of more than 
140,000 subscribers. 
thomasheaton.co.uk
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O YOU THINK YOUR ‘SELF’
is found in your head or heart?
Recent studies suggest that
a person’s answer to this
question reveals a whole
lot about their psychology.
‘Heart locators’, for instance,
are more likely to rely
on their emotions when

making difficult decisions. Cue Thomas Heaton,
an outdoor photographer led more by moods
and feelings than settings and technicalities...

What makes a great outdoor image?
The one thing that stands out to me more than
anything is simplicity. I find that the images which
compel me the most are those with very little going
on. They convey great mood and atmosphere, often
with a single subject or focal point; they’re clean,

with negative space that allows the viewer to feel as
if they’re there. Of course, these are often the most 
difficult images to execute well and require a great 
eye for detail, tones and composition. As well as this, 
these quiet, simple and often beautiful scenes can
be hard to come by in today’s hectic world. When I 
take a landscape image I’m usually trying to achieve 
one of two things – create something aesthetically 
pleasing or capture something to inspire or move
somebody. I want the viewer to say, ‘Wow, that’s
beautiful’ or ‘Wow, I wish I was there right now’.

How would you describe your style?
Outdoorsy. I simply try to capture, take home and 
share what I love, which is being outdoors. This
could be an epic mountain scene or a single tree
bathed in early morning light. That said, I love
to learn, I love to view the work of others and I
love to be inspired. I’m a big fan of explorers and
adventurers such as Robert Scott, Edmund Hillary, 
Ranulph Fiennes, Joe Simpson and Ben Fogle;
they’re a constant reminder that there’s a whole
world out there, waiting to be seen. There are many 
photographers who also inspire me and no doubt
influence my work. The delicate large-format work 

“THE MOMENT I SEE AN IMAGE
COME TO LIFE IN FRONT OF ME IS
THE MOMENT MY MOOD LIFTS...”
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Pro Showcase Thomas Heaton

Above A lone 
Cape vulture 
silhouetted 
against a setting 
sun in the Kruger 
National Park, 
South Africa.

Above left
Cresswell Beach, 
Northumberland: 
“I found my shot 
and waited for 
the light. The sky 
exploded into a 
rich tapestry of 
reds, oranges and 
purples. It didn’t 
last long, but I 
was ready for it.”

of Ben Horne encourages me to look closer at the 
landscape. The epic work of Ansel Adams inspires 
me to shoot grand vistas. The work of Colin Bell 
inspires me to find meaning and stories within the 
landscape and capture the history and life of an area.

You talk a lot about feelings and emotions – 
how do you go about capturing something 
so abstract in a two-dimensional image?
Difficult question! My feelings are usually positive 
when I’m out shooting. Even if I’m having a 
really bad day, the moment I see an image come 
to life in front of me is the moment my mood lifts 
and I’m filled with elation… most of the time. 
Sometimes I’m just glad to shoot the image and 
get the hell out of there, usually when it’s biting 
cold, wet and windy, and it’s these moments that 
often produce images with the most feeling. 

You also talk a lot about storytelling – how does 
an introvert become a YouTube star?
I honestly don’t know! I am an introvert, I’m quiet by 
nature and don’t care to be the centre of attention. I 
want to be the grey man. So, what happened? Well, 
I found another platform for sharing my images 

– YouTube. But not only can I share my images, I
can take the viewer along with me and share the 
adventure. What’s funny is how much it’s grown, 
but the growth doesn’t feel like a real thing. You 
see, I don’t experience the size of my channel first 
hand. When I film, I’m out in the middle of nowhere 
and I’m all alone. I’m not speaking to hundreds of 
thousands of people, I’m talking to myself. When I 
upload a new video, I’m not playing it to a room of 
50,000 people, I just upload it to my computer in my 
tiny little office and then go and make a cup of tea. It’s 
no different now than it was two years ago. I’m sure 
if I had to shoot and film in front of a live audience it 
would be different, but for now recording myself on a 
mountain is no different to singing in the shower. No 
one can see or hear me and I’m in my own little world.

What have you learned through sharing your 
experiences and insights on YouTube?
I’ve learned a lot. I’ve learned it’s important and 
incredibly beneficial to slow down, shoot less and 
think more. When out on a normal landscape shoot, 
if I decide on a composition I have to set up my 
DSLR and take the shot, but because I’m making 
a film I also have to take out my video kit, shoot 
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some B-Roll to show the viewer where I am (this 
often includes flying a drone), record my piece to 
camera about why I’m shooting this scene, talk 
through my settings, shoot some more B-Roll and 
then take the shot. This whole process can take 
20-30 minutes so I have to know that the final 
photograph is going to be worth it. As a result, I 
shoot images that I know have a chance of working. 
This slow and deliberate style has now stuck with 
me and it makes for a great shooting experience.

You previously worked as a video technician – 
what did you learn during these formative years 
that has informed your current career choice?
There’s one thing I took away that has served me 
well for years and will continue to do so – it’s not 
what you say, it’s how you say it. During my four 
years working for a corporate events company, my 
main duties included shooting and editing corporate 

videos, installing A/V equipment at conferences
and live events and operating live cameras at said 
events. I’ve had to endure more conferences than 
I care to remember, but one thing always stuck 
with me – although I was never interested in the 
conferences, I could quite easily find myself engaged 
and enthralled with a speaker who was addressing 
the room with passion and energy. A conference 
with good speakers would fly by, the room would be 
engaged and energised and I’d be hanging off their 
every word, even if I didn’t know what a dynamic 
applications consultant was. On the other hand, 
a speaker reading from a lectern with no charisma 
and no energy would ensure the day would drag. I 
always thought to myself that if I ever had to speak 
publicly, no matter what I was saying, I would make 
sure I did it with passion, confidence and belief.

If you could pass on one nugget of advice to 
a new outdoor photographer, what would it be?
Don’t give up. The success of landscape 
photography often hangs on capturing those 
rare and special moments, whether it’s a fleeting 
moment of light or a low-hanging blanket of mist 
at dawn. The problem is, of course, these moments 

“PHOTOGRAPHING A BEAUTIFUL 
IMAGE IS EASY – GETTING IN THE 
RIGHT PLACE IS THE HARD PART...”

Above Cuillin, Isle

of Skye: “I got a

little wet taking

this image, but it

was worth it.”

Above right “I live

five minutes from

Whitley Bay and

have shot it a

hundred times,

but I’d never seen

anything like this.”

Far right Muskox,

Polar Park Centre,

Arctic Norway.
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are rare and often require a lot of effort for no 
reward. The problem is, until you’ve witnessed 
and captured one of these beautiful spectacles, you 
don’t know of the pleasures and joys associated 
with doing so, therefore it’s easy to give up before 
you’ve experienced this elation. Photographing 
a beautiful image is easy – getting yourself in the 
right place at the right time is the hard part.

Tell us a little about the jobs/projects you’re 
working on right now…
I do a lot of work for various tourism boards – at 
the moment I’m working on a large project for Visit 
County Durham, which is great as it’s so close to 
home and a beautiful county. I’ve also just completed 
some work for Manfrotto, which included a lot 
of fun and games with one of their new bags. 
The most exciting job I have lined up is in January 
2019 where I’ve been invited to be a guest host on 
a 17-day workshop in Antarctica. The workshop 
is the ultimate in travel and adventure and prices 
start at around $20,000. I questioned why it was 
so expensive and, as it turns out, you can’t just 
cruise down to Antarctica as you please. There 
are all manner of licences and permits required, 

Pro Showcase Thomas Heaton
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safety teams, staff, chefs, trained guides, the list 
goes on. It truly is a remote and difficult wilderness 
to access. If anybody reading this happens to 
have a spare $20k, details are on my website…

What has been your defining photography 

moment so far? 

If I had to choose one moment, I’d say it was 
camping up on Place Fell in the Lake District. I shot 
an image of my tent overlooking Ullswater with 
the beginnings of a cloud inversion forming. This 
has done very well for me and is likely to be my 
most viewed photograph, as it was the homepage 
image for Flickr, as well as the splash screen 
when opening the Flickr App. I also recorded this 
camping trip for my YouTube channel and I believe 
this video helped propel me to where I am now. 

Talk us through the practicalities of landscape 

and travel photography – you obviously need 

more than just good camera skills… 

Travel and landscape photography doesn’t require 
much in the way of kit or camera skill, just a camera, 
couple of lenses, tripod and perhaps a few filters. 

You can stick your camera on auto pilot and it will 
do a good enough job. The difficulties start when you 
plan to shoot anything that requires more than just 
a short stroll from the car. If you’re shooting in the 
mountains or in the desert you’ll need to carry water, 
food, tent, ice axes, crampons, waterproof clothing, 
insulated jacket, stove, GPS, not to mention filming 
equipment. This requires a lot of planning and you 
also need to know your limits and make sacrifices 
where necessary. You need basic navigational skills 
and confidence in hostile environments in order 
to be relaxed enough to focus on capturing the 
image. I always say that photography is the easy 
part – it’s everything else that presents a challenge.

Talk us through your techniques…

My rule for focusing is to focus to infinity. This 
will produce sharp images front to back in most 
situations. If there’s a single subject that requires all 
of the attention, such as a lone tree, I’ll focus on the 
tree and not worry about the rest. If I have interest 
in the immediate foreground I’ll focus stack, which 
involves taking the same image three times, each 
image focused at different points of the composition. 
I’ll then stack those images in Photoshop, ensuring 
the image is sharp from front to back. I almost 
always shoot at ISO 100 and between f/8-f/11, and 
if I wish to capture any movement in the frame I’ll 
use an ND filter to control the shutter speed. With 
regards to composition, I like to keep things as simple 

Above Lake 

District, Cumbria: 

“Gale force winds, 

driving rain, sleet 

and hail, all made 

worthwhile for 

those seconds of 

fleeting light.” 

“I THINK IT’S IMPORTANT TO 
UNDERSTAND THE PROCESS  
AND CRAFT OF PHOTOGRAPHY...”
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Pro Showcase Thomas Heaton

as possible. I often find this to be most effective. 
Whenever I find myself on my knees, twisting and 
turning and trying to fit everything in the frame 
and aligning all the elements, this is a sign that I’m
trying too hard and the resulting image will most 
likely end up being confusing and over complicated.

How would you describe your mental and physical

approach to shoots? 

My work can be physically demanding if I choose it
to be so. Sometimes I like a stroll on my local beach,
as this is always a pleasure, while on other occasions
I like a multi-day hiking and backpacking trip which
demands a lot more fitness. I’m an avid rock climber
and really do like to keep as fit as possible, so I don’t
do much in the way of physical preparation for shoots.
My lifestyle allows me to push things a little further.
Mentally, well, this is different. On more than one 
occasion I’ve found myself feeling anxious and 
uneasy at the thought of setting out to shoot in an
unfamiliar location – it doesn’t take much to lose your
way in a remote area and the nature of landscape
photography means that we often stray off piste.
I’ve been caught out by dense hill fog, completely
lost and disorientated. It’s not nice. In the Alps 
I found myself descending a mountain faster than
was safe to do so, while a thunderstorm approached
and I was completely exposed on a rocky outcrop.
The early mornings and late evenings can play havoc
with my state of mind over a period of time. The one
thing I need more than anything is sleep. Without it,
I start to show signs of anxiety and depression, 
I make poor decisions and lose all enthusiasm. 
I still push on, because I know I’ll reap the rewards
later, but it is difficult. This is why I love the winter
time so much – early sunsets and late sunrises.

Does gear excite you or is a camera just a tool?

Gear doesn’t excite me too much. Don’t get me 
wrong, I love what technology has done for us 
over the past five years, but people get too caught 
up on gear. Landscape is a very simple form of 
photography and doesn’t require much. I keep 
thinking about an idea for a video. I’d love to set 
up five cameras, some consumer level and some 
pro. They’d all have the same settings, all with 
the same processing, all with the same beautiful 
composition. I’d then host an exhibition and 
challenge people to match the image to the camera.
I’d do it online, too. I’m curious about what the result
would be. I don’t think many would get it right. 

Why shoot with a 5x4 field camera?

Ah, the joys of shooting large-format film. This is a 
new challenge for me and one I’m relishing. Digital 
photography is amazing and will always cover 
about 90% of my work, but I sometimes feel like 
I’m losing touch with photography, as the camera 
does all of the hard work and it becomes a little too 
easy and unfulfilling. I think it’s important to really 
understand the process and craft of photography. 
By shooting large-format film, I’m able to reconnect 
with the true art of photography – light, exposure 
and composition, all of which must be done without 
the aid of a digital preview and automatic settings.

 Pro advice   
 Thomas’ top photo tips  

1
SET THE ALARM 

Get up earlier than you

need to and stay out later

than you think you need to. This

is when all of the magic happens

and you stand the best chance

of capturing a beautiful image.

2
LOOK CLOSER

Analyse what you’re

looking at and try to pick

out the elements that drew you to

the scene in the first place and

focus on these. It could be the

light, the texture of the rock,

a patch of mist etc.

3
BE COMFORTABLE

Take warm clothing,

water and food. It’s

difficult to concentrate if you’re

hungry, cold or thirsty. You need

to be comfortable in order to

be creative – and always tell

somebody where you’re going.

4
EXPLORE YOUR 

LOCAL AREAS 

These may not be the 

iconic landscapes we are all 

used to seeing, but that is the 

point. People are getting sick of 

seeing the same images over and 

over. Originality is the best way 

to stand out, so by exploring 

local areas, not only will you have 

these locations to yourself, but 

you have the chance of creating 

images that have not been 

previously captured.

5
BE VIGILANT

Don’t assume you’ve 

made a good exposure 

on site. Zoom into x10 and check 

focus, check your histogram, turn 

on Blinking Highlight Alerts... all  

of this ensures that you don’t go 

home and open your images only 

to find that you’ve made errors. 

It’s easier to check in the field. 
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SUPPORTED BY

You’ll learn how to create your own magical light paintings by
mastering your camera’s manual mod nd focusing in the dark.

M DULE 6 AFTER DARK

GET 
FEEDBACK

ON YOUR SHOTS!
Not only will you receive a

special certificate if you pass 

the module, we’ll also give

you some expert personal

feedback on your

image!

Sign up today at camera-school.com

FREE TIPS 
CARDS!
SEE INSIDE THE
BACK COVER
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CUT OUT & KEEP   

What is Camera School?
Designed for beginners who want to take their

photography to the next level, Camera School is

a free six-month course that teaches you the key

camera settings and techniques needed to start

shooting striking images. Every module focuses on

a new genre. Sign up at camera-school.com to get

expert feedback, exclusive how-to videos and more.

Tell me more about the homework
Every month, we’ll set you a homework task based

on the techniques you’ve learned – take a look at the

cut-out-&-keep course schedule to the right. You’ll

be working to a brief with very specific criteria, so

read this carefully before you shoot (see page 121).

Upload your homework by the deadline and we’ll give

you feedback on your work, and hopefully a certificate!

How will my certificates work?
If you complete the homework task perfectly, ticking

all the boxes specified in the brief, you’ll receive a

Gold certificate. If you didn’t quite get it right, you’re

still in with a good chance of a Silver or Bronze. Find

out how to submit your homework on page 121.

CLOSED017
e 13 April 2017

CAPES
e: May 2
a
ework deadline: 1

k

e LOSEDugust 2017
: 6 July 2017

VE STILL LIFE
e: A
al
ework deadline: 2 A

k

eCLOSEDune 2017
: 11 May 2017

AITS
e: J
a
ework deadlin : 7 J

e LOSEDeptember 2017
: 3 August 201

MENT
ue: S

al 7
ework deadline: 3

e LOSEDu y 2017
: 8 June 2017

AL WORLD
e: J l
a
ework deadline: 5 J

k



This month’s light painting technique is essentially

a combination of two skills – shooting a long

exposure from a tripod, and tracing around your

subject with a torch. As your camera’s sensor is

collecting light for the whole exposure, the path

your torch takes will appear as a continuous light

trail, and some of that light will spill onto the

subject and illuminate it. The timing of your shot

can be tricky to get right, but with some practice

you should be able to produce very striking shots.

You’ll need to shoot in complete darkness, so

wait until after sunset, or find a very dark room.

Working in manual mode, choose a shutter speed

long enough so you’ll be able to draw around the

entire subject. For smaller objects, like this robot,

this might only be 5 seconds. For larger objects,

you might opt for 20-30 seconds. Your aperture

should be around f/8, where your lens offers the

best optical quality, and your ISO around 400. If

once you’ve tried a shot, you find that your subject

and trails are too bright, drop your ISO to 200. If

it’s too dark, raise the ISO to 800. You could also

try moving the torch faster or slower, varying the

shutter speed if necessary. For the best results,

keep your torch behind or to the side of the

subject, rather than in front, so your hand doesn’t

impinge on the camera’s view of the trails. You

can also try wearing black gloves to reduce

the risk that your hand is visible in shot.

116 PRACTICAL PHOTOGRAPHY

CORE SKILLS SET UP YOUR
CAMERA THE RIGHT WAY

6.1

Above If your ISO is too low or high, your subject will be under- or over-exposed. 
A poorly exposed shot can also be caused by you moving the torch too quickly 
or too slowly. Experiment with ISO and torch speed for the best result.

Below Keeping your hand behind, or to the side, of the
subject will eliminate the risk of you blocking the light.

Above The shutter speed is long enough so that the torch was able to trace 
around the whole subject, and the ISO is just right for a balanced exposure.

ISO TOO LOW ISO TOO HIGH

CORRECT SHUTTER SPEED

TIP 
MAINTAIN

UNIFORM MOTION
Keeping the movement of 
your torch as smooth as 

possible and at a constant 
speed will produce more 

professional looking
results.

TORCH IN FRONT OF THE SUBJECT

TORCH BEHIND SUBJECT 
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SELECT THE 
RIGHT TORCH  

The torch that you choose for this 

technique is crucial to the success 

of the shot. The best option is 

something like a Maglite Mini, 

which has a small single bulb and a 

‘candle mode’, where the bulb can 

be seen from virtually all angles. 

Avoid torches with several bulbs 

(often seen on modern LED 

models) and those that have a 

narrowly cupped head where the 

light can only be seen straight on.

CHOOSE THE
PERFECT LENS

Nikon 18-55mm kit lens
Almost all DSLRs are sold with  

a standard kit lens, which offers  

a zoom range of 18-55mm. There’s 

no hard-and-fast rule for which focal

length is best for this technique, but

somewhere around 35mm is a good

starting point. As you’re working from 

a tripod, turn off Vibration Reduction

(image stabilisation), as this can 

reduce overall sharpness. 

Nikon 24-70mm f/2.8
Upgrading your kit lens to a pro-level 

24-70mm will give you superb image 

quality. Many Nikon users believe this 

lens to be the sharpest standard 

zoom lens on the market. It also 

boasts a wide aperture of f/2.8, which 

allows a shallower depth-of-field  

and faster shutter speeds. The lens 

costs £1349 and is compatible with 

full-frame and APS-C cameras.

MANUAL MODE
Working in manual

mode gives you full

control over ISO,

aperture and shutter

speed, which is

essential for the light 

painting technique.

LOW ISO 

Start with an ISO of

400, adjusting it to 200

if your subject and trails

are too bright, and 800 

if they’re too dark. 

SLOW SHUTTER SPEED
Select an exposure 

time of between 

5-30secs, depending 

on the size of your 

subject. 10secs is a

good starting point.

WHITE BALANCE
Changing your white

balance preset will alter

the effective colour

of the torch light.

Try Incandescent for

a white/blue look,

or Shade for a more

orange look. An LED

torch will give cooler

light than one with

a regular bulb.

Work in Single-servo AF (AF-S) and Single Point 

AF, and use the D-pad to select the central AF point. This will allow you to focus 

very precisely on a particular place in the frame (see page 120 for more).

MID-RANGE APERTURE
Choose an aperture of around f/8, where most lenses 

offer the best image quality. This should also give you a 

large enough depth-of-field so that your entire subject 

appears sharp. You don’t need to change the aperture 

at all for this technique.

Choosing the correct camera settings is essential to 

producing well-exposed light painting images. Here 

are our suggestions to help get you started.
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CORE SKILLS TAKE CONTROL 
OF COMPOSITION

THE ESSENTIAL
NATURE OF TRIPODS

While this month’s Camera School doesn’t adhere

to the same rules as previous assignments, such as

the rule-of-thirds or rule-of-odds, there are a couple

of things you should keep in mind. Firstly, you

should aim to make your subject as large as you

can in the frame within reason, so try using a longer

focal length or moving your camera closer to the

subject. This will give your image more impact and

make it stand out against the darker background.

Secondly, don’t forget that you will have a light trail

to consider too, so leave enough space for this.

Due to using a long exposure, you’ll also want to

make sure you compose in such a way that keeps

your camera very still for the duration. We

recommend a sturdy tripod with a poseable head,

which will allow you to keep your camera steady,

and also compose your image precisely.

Keep it still
Due to the nature of light painting, it’s best to

choose a subject which you know won’t move, so

no pets. This is because the incidental light from

your torch will illuminate the subject continuously,

and any movement will cause blurring, which we

want to stay away from. You should also use a light

source that’s proportional to the size of the subject

matter (a large torch with a flashlight setting will

illuminate a wide area, which is perfect for

landscapes, but terrible for smaller items). For this

assignment, we made sure we had a small torch,

with a bare bulb (such as the Maglite Mini) to

give us the precise lines. If you have a

dimmed setting on your flashlight,

experiment with it – this will allow you

to expose your image for longer, as

well as prevent you from

overexposing the subject.

Above If your camera’s exposure ends before you’re 

done, you’ll be left with unfinished light trails, so it’s 

better to set your shutter speed longer than you need.

When you’re shooting light trails, you’ll need a 

long exposure of at least 10 seconds, which

means you’ll need to steady your camera. Using

a tripod not only allows you to keep your camera

still and avoid blur, it also allows you to set your

composition and focus perfectly in the light,

keeping it exactly the same when it gets dark. We

recommend a tripod with a ball head, as you’ll be

able to make tiny adjustments, aiming your lens

up, down or to the side as required. Of course, if

you don’t have a moving head, you can still angle

your camera down by pulling the front leg in 

slightly, so the tripod leans forward, though this

may decrease the stability, and remember to not

overdo it or your camera may fall flat on the floor.

TIP 
USE A BALL

HEAD
Ball heads attach to tripods,

but allow you to freely make 

precise adjustments to your 

camera, as well as set it

into a portrait

orientation.

 POOR LIGHT TRAIL

GOOD LIGHT TRAIL

6.2
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WHY THIS SHOT WORKS

CORRECTLY 
EXPOSED
Because we’re using

a long exposure to 

capture the light, we

have to remember to

keep the torch moving.

If it stays still for too

long, you’ll end up with

a brighter exposure in

that place, we’ve kept 

the movement 

constant and 

consistent, giving us 

the perfect exposure.

CLEAN
BACKGROUND
We’ve kept the

background clean, 

thanks to consistent 

movement and 

choosing a torch that 

doesn’t spill light onto

the background. Make 

sure you have a good 

amount of space

between subject and 

background to avoid 

inadvertent lighting 

– 30cm should suffice.

CLEAR AND PRECISE 
LIGHT TRAILS
Our light trails are

clear (they don’t cross

over) and precise (they

adhere to the area we

are trying to

illuminate). We have

also chosen a lower 

powered torch that

offers us precise

control to create

precise shapes and

doesn’t cast too much

light onto the scene.

Light painting is a very fun
experiment that will likely get
better every time you try it, and
once mastered there’s no end 
to how big a subject you can
shoot. But at its heart, it does
come with a couple of
fundamental rules to follow for
the best results. Using a torch
with a bare bulb will allow it to
be seen from the side, as we
discuss on our settings page
(117), whereas a newer LED
torch can only be seen from the
front and is excessively
powerful, which would cast
unwanted light over our entire
image and ruin the effect (best
to use these in large areas).
Light painting isn’t an exact
science, and the length of your
exposure will depend on several
factors, so don’t be afraid to
experiment with timings – if you
need longer than 30 seconds,
consider a remote shutter
release with a bulb mode.

Above & left Wearing dark 

gloves stops your skin 

causing traces. Move as 

steadily as is possible.
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Even light trails have to obey the rules

of physics, so they’re affected by

depth-of-field just as much as your

subject is. This means you’ll want to

focus accurately on your subject

and paint your light trails close to

it so that both appear sharp.

Focusing in the dark can be an

issue, so we suggest using the AF

Assist Beam on your camera if it has

one. This will kick out a light

momentarily to illuminate your subject

while your camera focuses. Another option,

that’s perhaps even easier, is to turn the room

lights on while you achieve sharp focus and then switch them

off so you’re in the dark when you’re ready to start painting.

The only issue here is that you’ll need to use your torch to

get back to your tripod, being careful not to knock your

camera in the dark. You’ll want to use the AF-S single servo

autofocus mode and lock it off when you’ve focused. This is

because you don’t want the camera to refocus when you

press the shutter the second time to start the long exposure.

Read the tips here to see how you can do it, then get light

painting and submit your homework.

6.3

Above Focusing with the lights on is a good way to lock onto the front

part of your subject. Use a medium aperture value such as f/8 for a

large depth-of-field so your still life setup is sharp throughout.

1 Choose your focus mode
The most suitable autofocus

mode to use for stationary subjects is

single servo, also called AF-S on Nikon

cameras. This searches for your

subject when you half-press the 

shutter and stays locks on until you

press the shutter, unlike Continuous,

which constantly refocuses while the

shutter is half-pressed.

2 Set the active AF point
Change the autofocus point

selection to Single Point AF, rather than

Auto. This mode allows you to choose

where the active AF point is positioned

in the frame using the D-Pad on the

back of the camera. Use the camera’s

viewfinder or the screen with Live

View to position this AF point over

your main subject. 

3 Lock it off
You may need the lights on to 

focus, or activate your camera’s AF 

Assist Beam to make it easier to focus 

in the dark. When you’ve focused on 

your subject you need to switch to 

manual focus without knocking the 

camera to lock the focus. This ensures 

the focus won’t change when you 

press the shutter to take the shot.

CHOOSE AF-S FOR PIN-SHARP FOCUS

POOR FOCUS SELECTIONGOOD FOCUS SELECTION

TIP
USE LIVE VIEW

Put your camera into its Live

View mode, then hit the Zoom

In button so you can see the

area you’ve focused on

more clearly to check

that it’s sharp.

CORE SKILLS
FOCUS AND START
LIGHT PAINTING



PRACTICALPHOTOGRAPHY.COM  121

S C H O O L

S U P P O R T E D B Y

START LIGHT 
PAINTING
With your camera settings dialled in,

still life arranged and focusing locked,

it’s time for the fun bit. A tiny, bright

light source is ideal for this technique,

as it’ll let you get very fine light trails.

We used a Maglite, which has a candle

mode, revealing its single LED. This

kicks out light in all directions, so as

you’re painting the light trails it’s also

lighting up your subject. It’s possible

to use the LED light from a smart

phone, but this only throws light out in

one direction. So once you’ve created

your light trails, you’ll need to flip the

phone around to light up your subject.

We’re looking for complete light 

trails that go around your subject and

don’t prematurely end half-way around

your prop. If you feel like getting really

creative you can add multiple light

trails by turning off your torch after

you’ve finished your first one, then

position your torch where you want the

next to start, turn on the torch and

paint another one in.

HOMEWORK SUBMIT YOUR
SHOTS TO GET FEEDBACK

BEFORE YOU UPLOAD

We want to see a perfectly exposed light painting with a

shutter speed long enough to capture uninterrupted trails.

Focus on the closest part of your subject and use an aperture

of f/8 for strong sharpness. A torch with a candle mode that

reveals the bulb will make it easier to make your trails,

especially for fine details like boot laces or guitar strings. Your

image should be in colour and unedited, other than being

resized to the 5MB limit. Once you have your shot, upload it to

camera-school.com/mod-6-aft If you need to ask any

questions, go to the Camera School Facebook page 

(facebook.com/ppcameraschool). Your homework deadline

is 27 September, so have your shot uploaded by then.

Q Have you used the right settings?

Q Have you chosen the best composition?

Q Have you managed to get sharp focus on your subject?

Q Have you achieved complete light trails? 

Q Have you illuminated your subect?

UPLOAD YOUR SHOT TO CAMERA-SCHOOL.COM/MOD-6-AFT
DEADLINE 27 SEPTEMBER MARKING BRONZE, SILVER OR GOLD

GET THE RIGHT 
EXPOSURE 
Adjust your

exposure in

manual mode so 

it’s not too dark 

or too bright.

LIGHT TRAILS 
ARE IN VIEW
We want to see

strong light trails 

that illuminate 

the subject in

clean lines.

SHARP AND 
IN FOCUS
Set and lock the

focus so that it

doesn’t change 

when you take 

the shot.

Left One of the greatest

advantages of digital

cameras is their ability to

ou review your

ots instantly on

he back of the

camera. Hit the

Playback button

nd zoom in

osely to check

focus is sharp. If

it isn’t, or the exposure is

off, now is the time to fix it.

INCOMPLETE LIGHT TRAILCOMPLETE LIGHT TRAIL
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NIKON PROFESSIONAL Q&A
RICHARD PETERS

QWhat’s the first lesson a new low

light photographer should learn?

Because of the use of telephoto lenses requiring

faster shutter speeds and the ability for animals to

move in and out of shadows, low light situations can

be anything from pre-sunrise to shooting into

shadows on an overcast day. With so many

variations it’s important to know the limits of your

camera equipment, so you know how to adapt in

order to capture photos in tricky lighting. From

optimal apertures to autofocus and sensor limits,

knowing gear compromises will allow you to

prioritise the way you compensate and work around

them. The worst thing you can do when light levels

drop is carry on taking photos and hope for the best.

Q Any rookie mistakes that Camera

School students should look out for?

Low light often means lower contrast and higher

ISO levels. Shooting in JPEG has its advantages,

certainly for a course like Camera School, but RAW

will always give better results. There’s a huge

amount of data captured by the sensor and, in low

light, you’ll get the best from your photos by utilising

all that data. While our cameras might do a perfectly

adequate job of processing JPEGs taken in bright

lighting conditions, they almost never give the best 

results when the light levels drop. Switching to RAW 

(once you’ve finished this course!) can remove the 

perceived need for a better camera.

QWhat’s the secret to great

low light photography?

Don’t be afraid of high ISO levels. A noisy sharp 

photo is better than a clean photo that suffers from 

the motion blur of a slow shutter speed. When the 

situation calls for it, don’t be afraid to up the ISO. 

While low light is most often associated with dusk, 

any light can be considered low depending on the 

shooting conditions. You may need to freeze action 

on a heavily overcast day, and to do so requires a 

four-figure ISO. If it does, go for it. As a general rule, 

I’ll allow my cameras to go 1 stop down from their 

top native ISO.

QWhat’s the best piece of low light

advice you’ve ever been given?

Vibration Reduction (VR) won’t help you freeze 

subject motion. While that may sound obvious to 

the more seasoned shooter, when you’re finding 

your feet it can be all too easy to use VR to help 

avoid camera shake in low light, but this

Richard
Peters 
Richard is a wildlife 

photographer best 

known for his 

dramatic lighting 

style. Notable 

accolades include 

European Wildlife 

Photographer of 

the Year and 

several Wildlife 

Photographer of 

the Year awards.

He has hosted talks 

at London’s Natural 

History Museum.

ACCLAIMED WILDLIFE PRO RICHARD TALKS GEAR,
LOW LIGHT AND WHY ISO IS YOUR BEST FRIEND...

6.4



THE ART OF DANCE PHOTOGRAPHY: DANCERS AFTER DARK
Details: “Dance photographer Jordan Matter will explain the steps, tricks

and tips needed to shoot incredible dance portraits at night. This course

will be suitable for all levels of photographic experience, as Jordan will be 

there to help you get the best shots possible.” 

Date: 14 September 2017 Location: London 

THE ART OF PORTRAITS WITH FIRE
Details: “Starting with a safety and technique briefing you’ll cover the best 

camera settings and exposure modes to use for a fire poi portrait. You’ll 

begin to practice these techniques using slow sync/rear curtain flash with 

light sticks or wire wool. Once the light is just right you’ll take the final step 

– shooting the flaming fire poi portrait.” 

Date: 24 October 2017 Location: Burnham-on-Sea, Somerset 

JOIN THE PROS - LANDSCAPES - CORNWALL
Details: “Join two of the UK’s leading landscape 

photographers for a two-night residential workshop 

in beautiful West Cornwall. Under the guidance of 

Adam Burton and Ross Hoddinott, you’ll learn 

about ‘full frame’ photography, while exploring one 

of Europe’s most photogenic coastlines.”

Date: 15-17 November 2017 Location: Cornwall

Visit nikon.co.uk for more info. 
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S U P P O R T E D B Y

inadvertently sees you drop to a shutter speed that’s
too slow to freeze subject motion. A good tip to avoid
this is to shoot in aperture-priority, using Auto ISO,
and setting the minimum shutter speed (from within
the Auto ISO menu) to Auto. This will tell the camera
not to drop below a shutter speed that’s lower than
your focal length. For those new to low light shooting,
that gives you one less thing to think about while you
concentrate on getting the rest of your exposure
values correct.

QWhat’s your favourite Nikon camer
lens combo for low light and why?
Since its release, I’ve shot almost
exclusively with two D810s. While not
known for their low light performance,
with careful exposure control I’ve found
them to perform surprisingly well.
However, more recently I added a D500
to my camera bag. Paired with the
Nikon 400mm f/2.8E FL ED VR, it’s an
incredibly powerful combination,
allowing a huge amount of light onto th
sensor. I’ve had images at ISO 10,000
printed from this combination 
and they hold up very well 
indeed. But more than that,
the low light focusing is
industry leading, allowing
me to shoot in lower 
contrast conditions than
ever before.

Above Richard captured the penetrating glare of this 

spectral little owl with an incredibly high ISO of 28,800.

Left An ISO of 4000 gave Richard a shutter speed of 

1/500sec, perfect for stopping this lion in its tracks.

IMPROVE YOUR LOW LIGHT SKILLS 
AT NIKON SCHOOL! 

Nikon School is a venue for photography training that aims to 

educate and inspire photographers. Workshops cater for every 

level of ability, whether you’re new to taking photographs, a keen 

amateur or a professional. We offer a wide range of workshops 

suited to individuals wanting to learn more about photography or 

expand their creative horizons. You’ll improve your skills, develop 

your eye and learn to take control of your camera. All camera 

brand users are welcome.

Nikon School workshops are a mix of easy to understand 

theory and hands-on practical assignments. We have small 

groups of up to 12 delegates to ensure everyone can benefit from 

our expert tutors’ knowledge. From understanding your DSLR 

and lenses to image editing, our workshops cover a variety of 

skills and subjects. Nikon School workshops take place either at 

the Nikon Centre of Excellence, London or on location – please 

check the specific workshop for ability levels and further details. 

Check out these creative photography courses…



Shop online at www.srb-photographic.co.uk

Call our experts (Mon-fri 9am-4.30pm) 01582 661878

visit srb-photographic.co.uk for more!

Infrared
Skylight
Black & White
Colour Grad
6WDU (�HFW

from £19.95
from £9.95
from £7.50
from £14.95
from £12.95

More Filters...UV Filters

from £12.50

ND Fader Filters

from £29.95

Push-on Holder
Professional Kit
Upgrade Kit
Adaptor Rings from

ND Filters from

£115.00
£115.00
£75.00
£20.00
£78.00

Tripods & Monopods

Accessories

LEE Filters 100mm System

&LUFXODU �OWHU VL]HV UDQJH IURP��PPWR ���PPGHSHQGLQJ RQ
WKH �OWHU� 9LVLW srb-photographic.co.uk for more!

Award-winning SRB Photographic brand

100mm
Starter Kit

from £139.95

*Exclusive*

Circular Polarisers

“Highly Rated”
- Practical Photography, June 2016

- NPhoto Magazine, August 2016 - Digital Photo, 2015

Neutral Density Filters

from £16.95 from £13.95

��� ���

��� ���

- Digital Camera, ND Group Test

5 stars in DC’s ND 
Group Test 

ND1000 Filters
from £24.95

Best Value in Photoplus
Big Stopper Group Test

Plastic Filter System

Adaptor Rings £4.95

P Size
£4.95

A Size
£8.95

� [ +ROGHU� � [ $GDSWRU ULQJ

Filter Kit
A Size £44.95
P Size £44.95

Starter Kit
A Size £29.95
P Size £24.95

� [ 3 RU $ 6L]H �OWHUV
6$9( XSWR e�� RQ �OWHU VHWV�

Full ND
Soft ND Grad
Hard ND Grad
Black & White
Landscape

£39.95
£39.95
£39.95
£39.95
£34.95

Square Filter Sets

Individual Square Filters

0.3 Full ND
0.6 Full ND
0.9 Full ND

£14.95
£14.95
£14.95

0.3 Soft ND
0.6 Soft ND
0.9 Soft ND

£14.95
£14.95
£14.95

0.3 Hard ND
0.6 Hard ND
0.9 Hard ND

£14.95
£14.95
£14.95

Sunset Grad
6WDU (�HFW

P Size 6-Stop Filter

P Size ND1000

Pro Glass ND Filters

£14.95
£14.95
£29.95

£29.95

£22.95

$ 6L]H	3 6L]H UHVLQ VTXDUH �OWHUV

- Digital Photo, 2014

new

1 9 6 7 - 2 0 1 7

SRBPHOTOGRAPHIC
Celebrating 50 years of SRB

“SRB are a company who are vital to the optical
LQGXVWU\ DW ODUJH��7KH\�DUH�WKH�JR�WR���UP�ȋ

3URIHVVLRQDO�ΖPDJHPDNHU�0DJD]LQH

FREE UK Delivery
*spend over £40

*HW�LW�QH[W�GD\�
*order before 3pm

Check out our huge
range of Lens Adaptors

Digiscoping Kits from e������
Step Rings, Macro accessories &
much more at our online store!

www.srb-photographic.co.uk
6LJQXS WR RXUPDLOLQJ OLVW IRU WKH ODWHVW QHZVDQGRHUV�

On-it Carbon Fibre
Monopod

�0D[� +� ����PP
�0LQ� +� ���PP
�:HLJKW� ���J
�0D[� /RDGLQJ����NJ
� &DUU\LQJ &DVH

Monopod
Feet/Stand

£29.95
£14.95Colours: Black, Red

28mm On-it Carbon
Fibre Tripod

Practical Photography, 2016

��0D[��+������PP
��0LQ��+�����PP
��:HLJKW�����NJ
��0D[��/RDGLQJ������NJ
��&DUU\LQJ�&DVH

only £149.95

25mm On-it Carbon
Fibre Tripod

��0D[��+������PP
��:HLJKW�����NJ
��0D[��/RDGLQJ����NJ
��&DUU\LQJ�&DVH

only £119.95

LEE Filters

£17.50
£52.00
£64.95
£65.00
£68.00
£64.95
£190.00
£109.00
£460.00
£69.50

Adaptor Rings
ND Grads
ND Filters
Big Stopper
Little Stopper
Super Stopper
Polariser
Starter Kit
Deluxe Kit
Seven5 Hood

£89.95
£64.95
£95.00
£132.00
£132.00
£129.95
£180.00
£249.00
£18.00
£47.95

Mark II Adaptors
Screw-in Adaptors
ND Filters from

Big Stopper
Little Stopper
Super Stopper
Polariser
ND Filter Sets
Lightshield
Filter Pouch

Dust Blowers from

Rainsleeves from

Cleaning Kits from

Camera Wraps from

Cleaning Cloths from

Lens Pouch from

White Balance Caps from

£3.50
£5.95
£5.95
£8.95
£1.50
£8.50
£9.95

Lens Pockets from

Square Filter Wallet
Circular Filter Pouch
6HO�H 6WLFN %XQGOH

Spirit Levels from

Bluetooth Remote
Lens Pen
Memory Card Case
Angled View Finder

£3.95
£9.95
£5.95
£9.95
£3.50
£3.95
£4.95
£9.95
£39.95

Lens Caps

Body Caps

Rear Lens Caps

Petal Hoods

Rubber Lens Hoods

£3.95

£3.50

£3.50

£10.95

£4.95
Auto Extension Tubes from

Manual Extension Tubes

£29.95

£17.50

OpTech Comfort

OpTech Wrist Strap

OpTech Tripod Strap

£9.99

£9.99

£19.99 P Size Hood £34.95

Close up Lens Sets from £19.95

3KRWR�3OXV������

6HW�RI���OHQVHV�ZLWK�XSWR�����GLRSWHU

Square Filters Circular Filters7KH�QHZ 3 6L]H Elite Filter System

new

SAVE

Ȋ:HOO�PDGH	GHVLJQHG�OWHU V\VWHP
that lifts the semi-pro P system to a 
KLJKHU OHYHOȋ  I� &DPHUFUDIW0DJD]LQH

Elite Filter Holder
Elite Adaptor Rings
Elite Polariser
Elite ND1000

£34.95
£5.95
£24.95
£29.95

TOP SELLER

SAVE

Seven5 Holder
£59.50

LEE Filters
Seven5 System

LEE Filters
SW150 System

SW150 Mark II 
Holder
£150.00

“You could easily 
expect to pay that 
for the lightweight 
DOOR\�KHDG�DORQHȋ 
I��&DPHUFUDIW�0DJD]LQH

Big Stopper
Little Stopper
Landscape Polariser
Filter Sets from

Digital Starter Kit

£99.95
£95.99
£173.99
£100.00
£219.95

Foundation Kit
£59.95

Super Stopper
£99.95

TOP SELLER
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7D Mark II Body £1299

D5600 � �����PP £729
D5600 � ������PP £949

PEN-F Body £949
OM-D E-M5 II Body£849
OM-D E-M5 II
������PP £849
OM-D E-M5 II
������PP 352 £1249

NEW OM-D E-M1 II
Body £1849
NEW OM-D E-M1 II
������PP £2399

��PP I��� £699
�����PP I��� 3UR £799
������PP�I��� 3UR £1125

A7R Mk II Body £2499
A7S II Body £2499
A7 II £1199
A7 £799
A7 � �����PP £999
A7S Body £1609
A7R Body £999

X-T2 Body £1399
X-Pro2 Body £1349
NEW X-T20 IURP £799

NEW 77D Body £799
NEW 77D � �����PP £919
NEW 77D � ������PP £1149

D5 Body £5209D810 Body £2399

() ��PP I���/ ,, 860 ....................£1499
()���PP�I����/�,,�860 ...................£1799
()����PP�I����/�,6�860�0DFUR.....£699
()����PP�I��/�860 .......................£859.97
()����PP�I����/�860�0DFUR .........£1229
()����PP�I����/�860�0.,, ............£699
()����PP�I����/�,6�,,�860 .............£5799
()����PP�I����/�860 ....................£1111.50
()�����PP�I��/�860�)LVKH\H ........£1199
()�6������PP�I���������,6�670 ......£199
()�6������PP��I��������860 ..........£499
()������PP�I��/�860.....................£2699
()������PP��I����/�0N,,�860 .........£1429
()������PP�I��/�,6�860 ................£819.15
()�6������PP�I�����,6�860 ............£718
()�6�������PP�I��������,6�860....£429
()������PP�I��/�,6�860 ................£725
()������PP�I���/�,,�860 ...............£1699
()�������PP�I��������/�,6�860 ....£2249
() ������PP I��� / ,6 ,, 860 ........£1699
() ������PP I� / 860 ..................£593.10
() ������PP I������� '2 ,6 860.£1379
() ������PP I����� / ,6 860 .......£1279
() �������PP I������� / ,6 ,, 860£1789

NEW GX800
� �����PP £379
GX8 � �����PP £799
GX80 � �����PP £530

��PP I��� * $)�6 '; 0LFUR .................... £259
��PP I��� * $)�6 .................................... £429
���PP I��� * $)�6 95 ,) (' 0LFUR........ £769
�����PP I������� * $)�6 ';................... £745
�����PP I� * $)�6 (' 95...................... £1029 
������PP I������� * $)�6 '; (' 95 ,, . £649
������PP I������� * (' 95 $)�6 '; ....£629
�����PP I��� * $)�6 ('......................... £1549    
������PP I������� * $)�6 (' 95 .......... £829
������PP I������� * $)�6 95 ,)�('...... £519
�������PP I��� ( (' 95 $)�6 .............£1179

A6500 Body £1282
A6500 � �����PP £2199
A6300 Body £829
A6300 � �����PP £1029

D7200

D7200 Body £859
D7200 � ������PP £1099

NEW 6D Mark II Body £1999
NEW 6D Mark II
� ������PP ,6 670 £2379
6D Body £1349
6D � ������PP ,6 670 £1699

5DS Body £2949
5DS R Body £3149

5D Mark IV Body £3349

D750 Body £1599
D750 � �����PP 95 £2099
D750 � ������PP 95 £2279

D610

D610 Body £1299
D610 � �����PP £1699

D500

D500 Body £1729

�����PP I��� £699
������PP I��� £799
������PP�I������� £349
��P����PP�I����� £179

EOS 77D

24.2 PS

6.0 ISV

1080p

77D       ��������)URP�£799

EOS 6D Mark II

26.2 PS

6.5 ISV

Full Frame

 6D Mark II )URP�£1999

EOS 7D Mark II

20.2 PS

10.0 ISV

1080p

7D Mark II          £1299

5D Mark IV         £3349

30.4 PS

7.0 ISV

Full Frame

 EOS 5D 
Mark IV

 EOS 5DS

50.6 PS

5.0 ISV

Full Frame

5DS Body            £2949

D5600

24.2 PS

5.0 ISV

1080p

D5600 )URP £729

24.2 PS

6.0 ISV

1080p

D7200 )URP £859

24.3 PS

6.0 ISV

1080p

D610 )URP £1299

20.9 PS

10.0 ISV

1080p

D500                 £1729

D810D750  D5

24.3 PS

6.5 ISV

Full Frame

36.3 PS

7.0 ISV

Full Frame

D750         )URP £1599 D810                  £2399

20.8 PS

12.0 ISV

Full Frame

D5                    £5209

PEN-F
OM-D E-M1 II

20.3 PS

10.0 ISV

1080p

PEN-F
Body  £949

20 PS

60 ISV

CMOS

OM-D E-M1 II
)URP £1849

Olympus Lenses

X-T2 Black

24.3 PS

8.0 ISV

1080p

X-T2
)URP £1399

A7R Mark II
Black

42.0 PS

5.0 ISV

4K YLGHR

A7R Mark II
)URP £2499

A6500
Black or Silver

24.0 PS

11.0 ISV

1080p

A6500
)URP £1282

 GX800

16 PS

30 ISV

4K YLGHR

DMC-GX800  

)URP� £379

Panasonic Lenses

Nikon Lenses

� 2YHU �������3URGXFWV�����)UHH�'HOLYHU\�RQ�����RU�RYHU�����:H�FDQ�GHOLYHU�RQ�6DWXUGD\�RU�6XQGD\¹����������

Canon Lenses

1D X Mk II Body £4799

 EOS 1D X 
Mark II

20.2 PS

16.0 ISV

Full Frame

1D X Mk II          £4799

New New

New New

3 year warranty on all new 
Canon L Series lenses

Terms & Conditions apply. 
Offer ends 31.01.18
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Call us Mon-Fri 8am-7pm, Sat 9am-6pm, Sun 10am-4pm

Unit B, Frenbury Estate

Off Drayton High Road,

Norwich. NR6 5DP.

2SHQ IURP ��DP GDLO\�

:H[�6KRZURRP

$LU &XVKLRQHG�
/LJKWLQJ 6WDQG�

£29.99

/XPLPXVH
/(' /LJKWV
)URP £44.95

(]\ER[ 6SHHG�
/LWH �

£49.95
L308s
£179

3OXV ,,, 6HW
£229

*HPLQL�3XOVDU
7[����5�.LW�

£949

���5[�7ZLQ�+HDG
8PEUHOOD�.LW £569

�'�/LWH�5;����
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£725

8UEDQ�
&ROODSVLEOH�
%DFNJURXQG�

£165

PowerShot G9 X Mark II
£399

X100F £1249

PowerShot G5 X
£599

Coolpix P900 £479

Coolpix B500 .............................£239
Coolpix A900 .............................£329

GR II Digital £529

Theta S Digital
Spherical
Camera
£299

Extreme Pro: 95MB/s
SDHC
��*% ................£24.99
��*% ................£29.99
��*% 6';& .....£44.99

SanDisk Extreme Pro:
160MB/s UDMA
CompactFlash
��*% ................£39.99

D™ Memory Card:
MB/s
% .....................£129
% .....................£149

fessional 1066x
mpact Flash: 160MB/s
% .....................£49.99
% .....................£64.99

��*% .....................£89.99
���*% ...................£149

Professional 633x UHS-1:
95MB/s
��*% .....................£14.99
��*% .....................£24.99
��*% .....................£44.99
���*% ...................£79.99

��*% ............... £64.99
��*% .............. £119
���*% ............. £199

SanDisk Class 10
Extreme Micro SD
Card plus adapters:
��*% ................£34.99
��*% ................£69.99

MT055XPRO3.......... £159
MK055XPRO3
� ;�3UR ��:D\ +HDG £259
MK055XPRO3
� ���5&� %DOO +HDG £169
MT055CXPRO3
&DUERQ )LEUH ............ £329
MT055CXPRO4
&DUERQ )LEUH ............ £348
MT190XPRO3.......... £149
MT190XPRO4.......... £159

GT5543LS
� ���FP
0D[ +HLJKW
� ��FP
0LQ +HLJKW
� &DUERQ )

Systematic Tripods:
*7����/6 ...................£845
*7����/6 ...................£759
*7����/6 ...................£719

Hadley FRORXUV�DYDLODEOH�
Canvas/Leather:
Khaki/Tan, Black/Tan, Black/Black. 
FibreNyte/Leather: Khaki/Tan, 
Sage/Tan, Black/Black.

'LJLWDO ..............................£119
6PDOO ...............................£149
/DUJH ...............................£154
3UR 2ULJLQDO .....................£189
+DGOH\ 2QH .....................£265

3L[PD
3UR ���6

Gorillapod:
&RPSDFW............£16.99
+\EULG
�,QWHJUDO +HDG� ..£29
6/5 =RRP .........£44.99
)RFXV *3�� .......£89

Cyber-Shot WX500 ......£289
Cyber-Shot RX100 III ...£569
Cyber-Shot RX100 IV ...£729
Cyber-Shot RX10 III......£1399
Cyber-Shot RX1R II ......£2999
Cyber-Shot RX100 II.....£419
Cyber-Shot RX100........£349

PIXMA Pro 100S ........................£369
PIXMA Pro 10S ..........................£504.99
imagePROGRAF PRO-1000 £999

IXUS 185 HS............................£99
IXUS 285 HS............................£159
PowerShot SX60 HS ..............£349
PowerShot SX730 HS ............£349
PowerShot G1 X MK II ...........£448

5HORDGHU �� £299

3URIHVVLRQDO �� ...............£109
3URIHVVLRQDO �� ...............£159
3URIHVVLRQDO �� ...............£154

MT190CXPRO
&DUERQ )LEUH ............ £299
MT190CXPRO4
&DUERQ )LEUH ............ £318
MT190XPRO3
� ���5&� %DOO +HDG £139
MT190XPRO4
� ���5&� %DOO +HDG £189

Manfrotto Heads:
494RC2 0LQL %DOO ..... £49
498RC2 0LQL %DOO ..... £74
324RC2 -R\VWLFN ...... £99
327RC2 -R\VWLFN ...... £169

PowerShot G7 X Mk II
£541

����(;�,,,�57
£239

SanDisk
USB 3.0
,PDJH0D
5HDGHU
£39.99

Coolpix W300 £389

Cyber-Shot HX90V £339

Coolpix B700 £399

Lumix FZ2000 £999

Lumix LX100 ........... £499
Lumix LX15 ............. £568
Lumix FZ1000 ......... £579
Lumix TZ70 ............. £279

Lumix FZ330 ........... £449
Lumix FZ82 ............. £329
Lumix TZ100 ........... £528
Lumix TZ80 ............. £329

Pro Runner:
%3 ��� $: ,, .............. £139
%3 ��� $: ,, .............. £169

Photo Sport BP:
��� $:.........................£109
��� $:.........................£129

Anvil:
$QYLO 6OLP...................£122
$QYLO�6XSHU................£134
$QYLO�3UR ....................£129

6%����
£499
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 Digital Compact Cameras Accessories including spare batteries are available to buy on our website

   20.2 PS

4.2[ ]RRP

1080p

   20.2 PS    20.1 PS

4.2[ ]RRP 3[ ]RRP

1080p 1080p

16.0 PS

5[ ]RRP

4K YLGHR

20.3 PS

60[ ]RRP

4K YLGHR

   16.0 PS

83[�]RRP

12 PS

4[ ]RRP

4K YLGHR

Stylus TG-5 £399 Ricoh WG-50 £249

16 PS

5[ ]RRP

Z�SURRI

24.3 PS

CMOS
1080p

20.9 PS
40[ ]RRP

4K YLGHR

18.2 PS

30[ ]RRP

1080p

 Memory Cards & Readers

 Photo Bags & Rucksacks

Photo Sport BP 
200AW�FDSDFLW\�
•� '6/5
• 2 lenses
•� ��/WU�UHVHUYRLU�
� �QRW�LQFOXGHG��
•� )ODVKJXQ�	
� DFFHVVRULHV

Anvil Slim 11 
FDSDFLW\�
•� &6&�6PDOO�
� '6/5
• 2 lenses
•� ��μ�/DSWRS
•� )ODVKJXQ�	
� DFFHVVRULHV

Manfrotto Reloader 
55 Roller Bag
3UR�/LJKW�5LS�6WRS�
Q\ORQ�IDEULF�ZLWK�
ZDWHU�UHSHOOHQW�
FRDWLQJ�WR�SURYLGH�
VROLG�SURWHFWLRQ��
7KLV�FRPIRUWDEOH��
VW\OLVK�EDJ�LV�LGHDO�WR�
WUDYHO�ZLWK�

Manfrotto 
Professional 
Backpack 20

:DWHU�UHVLVWDQW�
ZLWK�H[WHUQDO�
VWUDSV�WR�DWWDFK�D
WULSRG��&DSDEOH�R
À�WWLQJ�D�3UR�'6/
DGGLWLRQDO�FDPHU
ERG\����OHQVHV�
DQG�PRUH�

Tripods & Heads
MT190XPRO3
• 0D[�+HLJKW�����F
• 0LQ�+HLJKW���FP

 Lighting & Accessories

DG

 Terms and Conditions $OO�SULFHV�LQFO��9$7�DW�
����3ULFHV�FRUUHFW�DW�WLPH�RI�JRLQJ�WR�SUHVV��
)UHH�'HOLYHU\�DYDLODEOH�RQ�RUGHUV�RYHU�����

�EDVHG�RQ�D���GD\�GHOLYHU\�VHUYLFH���)RU�RUGHUV�
XQGHU�����WKH�FKDUJH�LV��������EDVHG�RQ�D�

��GD\�GHOLYHU\�VHUYLFH���)RU�1H[W�:RUNLQJ�'D\�
'HOLYHU\�RXU�FKDUJHV�DUH��������¹6DWXUGD\�
GHOLYHULHV�DUH�FKDUJHG�DW�D�UDWH�RI��������
¹6XQGD\�GHOLYHULHV�DUH�FKDUJHG�DW�D�UDWH�

�������'HOLYHULHV�RI�YHU\�KHDY\�LWHPV��1�,���
UHPRWH�DUHDV�RI�6FRWODQG�	�&K��,VOHV�PD\�EH�

VXEMHFW�WR�H[WUD�FKDUJHV���(��	�2�(��3ULFHV�
VXEMHFW�WR�FKDQJH��*RRGV�VXEMHFW�WR�DYDLODELOLW\��

/LYH�&KDW�RSHUDWHV�EHWZHHQ�����DP��SP�
0RQ�)UL�DQG�PD\�QRW�EH�DYDLODEOH�GXULQJ�SHDN�
SHULRGV��†6XEMHFW�WR�JRRGV�EHLQJ�UHWXUQHG�DV�

QHZ�DQG�LQ�WKH�RULJLQDO�SDFNDJLQJ��:KHUH�
UHWXUQV�DUH�DFFHSWHG�LQ�RWKHU�LQVWDQFHV��WKH\�

PD\�EH�VXEMHFW�WR�D�UHVWRFNLQJ�FKDUJH��††$SSOLHV�
WR�SURGXFWV�VROG�LQ�IXOO�ZRUNLQJ�FRQGLWLRQ��1RW�
DSSOLFDEOH�WR�LWHPV�VSHFLÀ�FDOO\�GHVFULEHG�DV�
´,1μ�RU�LQFRPSOHWH��LH��EHLQJ�VROG�IRU�VSDUHV�

RQO\���:H[�3KRWRJUDSKLF�LV�D�WUDGLQJ�QDPH�RI�
:DUHKRXVH�([SUHVV�/WG��UHJLVWHUHG�DV�FRPSDQ\�

QR������������9$7�QXPEHU���������������
�:DUHKRXVH�([SUHVV�/WG�������

 &$6+%$&.6�$UH�UHGHHPHG�YLD�SURGXFW�
UHJLVWUDWLRQ�ZLWK�WKH�PDQXIDFWXUHU��3OHDVH�UHIHU�

WR�RXU�ZHEVLWH�IRU�GHWDLOV�
Showroom:�RII�'UD\WRQ�+LJK�5RDG���RSSRVLWH�

$6'$��1RUZLFK��15���'3�
0RQ�	�:HG�6DW���DP��SP��

7XHV���DP��SP��6XQ���DP��SP

&RPSHWLWLYH�
SULFHV

)UHH�FROOHFWLRQ��
RI�\RXU�JHDU

)DVW�WXUQDURXQG
RI�\RXU�TXRWH�DQG�
FUHGLW

������ XVHG SURGXFWV LQ VWRFN
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More Camera
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up
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16.2 PS

3.1[ ]RRP

1080p

Pro Runner BP 350 
AW II�FDSDFLW\�
•� 3UR�'6/5�ZLWK�OHQV
•������DGGLWLRQDO�OHQVHV
•��)ODVKJXQ��WULSRG�
� ODSWRS�	�DFFHVVRULHV
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130 Nikon vs Sigma
We take a look at five new

lenses, including the 14mm f/1.8

Sigma Art and Nikon 10-20mm.

134 DJI Spark
DJI’s smallest and most

advanced drone yet lets you

control it with just your hands, but

should it be taken seriously?

138 Creative lenses
Unleash your inner artist

with 10 weird and wonderful
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A trio
Nikon
glass
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LENSES

I
F YOU’RE ONE OF THE MANY
people who uses their APS-C Nikon
for landscapes, it’s time to rejoice –
this may be the perfect lens for you,

offering a comprehensive zoom range of
10-20mm (15-30mm 35mm equivalent),
ultra-wide to wide-angle in a relatively
tiny body. Its maximum aperture of f/3.5
is enough to allow shooting in dimmer
conditions, while its f/29 minimum
aperture will let you take your Big 
Stopper ND filter and shoot long 
exposures on even the brightest days.
Featuring a tough plastic body and
rubber grip zoom and focus rings, it
houses 14 elements in 11 groups, including
3 aspherical elements to keep distortions
to a minimum. It also packs a whopping
109º diagonal field-of-view at 10mm,
which gives you a phenomenal scope
when you’re shooting epic scenery. It also
includes Nikon’s VR (Vibration 
Reduction), which is effective up to 3.5
stops, allowing you to go hand-held, even
in low-light scenarios – this is a welcome
inclusion. With a minimum focusing
distance of 22cm, you can also get close to
your subjects to create a unique look, 
perfect for unleashing your creativity.
Image quality is superb, with central 
sharpness being impressive at the 
maximum apertures, though excelling at

f
li ess at wider apertures, but
quickly catching up by f/5.6, offering you
a great level of optical quality throughout.
Once you pass f/16, diffraction does start
to lower the overall sharpness, as is the
case in most lenses, and the wider 10mm
has a slight advantage over 20mm, 
though it’s still extremely usable. A 
certain amount of barrel-distortion is
also visible at 10mm, though this is to be
expected and it’s still very respectable,
and simple to fix in post-processing. At
20mm the distortion is virtually gone, we
wouldn’t let this put us off purchasing this
lens. At £329 and 230g, it’s a great choice
for anybody looking for a wide-angle lens.
Sharpness is impressive, especially 
considering its compact form factor, and
the chromatic aberration is virtually
non-existent. This kind of lens will fly off
the shelves. nikon.co.uk

NIKON AF-P DX
10-20MM F/4.5-5.6

GetIntoGear

Above 10-20mm offers a 35mm equivalent 
of 15-30mm on an APS-C body.

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

PROS Extremely lightweight
and compact Impressive sharpness

Great value for money
Image stabilisation

CONS Variable aperture
Slight barrel-distortion at 10mm 

THE VERDICT

HIGHLY 
RATED



NIKON 28MM F/1.4 IS £2079

NIKON AF-S FISHEYE 8-15MM
F/3.5-4.5 ED £1299

N
IKON’S 28MM F/1.4 IS AN
ultra-fast wide-angle lens
designed to bolster its
full-frame line-up. While the

slightly unusual focal length is a tad too
long for serious landscape work, it offers a
wealth of possibilities, from street to
portrait or wedding and event
photography, allowing you to get close to
your subjects, or frame more than a
traditional 35mm. The wide f/1.4
maximum aperture means you can easily
shoot hand-held in darker conditions,
though given its wide focal length, you

won’t get a shallow depth-of-field or
much in the way of bokeh. However
this is a very sharp lens, with ex
central image quality, even wide
open, and corners which catch up
quickly, becoming sharp at f/5.6.
Because it’s a prime lens, it handles
distortions well, lacking any obvious
barrel-distortion or chromatic
aberration, as well as dealing with
ghosting and flare well. However, at 645g,
it’s not the lightest or easiest handling
travel lens. We have to question whether
the great image quality, fast aperture and
unique focal length justify the £2079
expenditure when there are excellent
alternatives around the more versatile
20-35mm focal lengths. nikon.co.uk

T
HE 8-15MM F/3.5-4.5 IS AN
all-in-one fisheye lens and the
first of its kind in Nikon’s
line-up. Using it at the 8mm

length will give you the traditional
circular fisheye look (a circular image in
the middle of the frame, though on APS-C
you won’t get this full effect), while at
15mm it will give you a full image, corner
to corner, though both will exhibit the
bulging look, which is synonymous with
fisheye photography. While this type of
lens isn’t to everyone’s tastes, its results

are iconic, often sacrificing overall
quality for a specific look. Happily,
lens retains image quality through
with the centre of the frame being
impressively sharp, although the co
are soft, which is part of the appea
build quality is as high as you’d exp
from Nikon, packing in 15 elements
groups, including its ED Extra Low
Dispersion coating, to reduce flare
ghosting. It also covers 180º maxim
field-of-view on full-frame (this is
reduced substantially on APS-C). I
reality, this lens is great, if you hav
for it, though the price might put a
people off. nikon.co.uk
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LENS  TEST

Above The 28mm allows you to easily 

switch between focus modes.

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

PROS Iconic look Acts as both

circular and diagonal fisheye on

full-frame Impressive sharpness

CONS Very limited real world uses 

Twice as expensive as both of 

Nikon’s current prime fisheye lenses

THE VERDICT

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

PROS Excellent sharpness at an

unusual focal length Very good

all rounder Versatile lens

CONS Extremely expensive

Unusual focal length Heavy and 

quite bulky for a prime in its focal length

THE VERDICT

Above The bulging front elements allows 

up to a massive 180º field-of-view.



Another
fine wor
of Art
Sigma has released a 
brace of new lenses into its 
acclaimed Art range, and 
Kirk Schwarz is putting 
them through their paces.
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SIGMA 14MM F/1.8
DG HSM | ART £1679

S
IGMA’S ART LINE-UP HAS
fast become one of the most
highly regarded lens ranges on
the planet. That’s why we’re

excited to see the world’s first 14mm
f/1.8 prime, with an ultra wide-angle
and fast aperture which could make
it every astrophotographer’s dream.

The build quality of this glass is
superb, with its tough dust and moisture
resistant plastic and aluminium design
housing 16 elements in 11 groups, as
well as 9 rounded diaphragm blades.
It features 3 premium FLD and 4 SLD
Low Dispersion elements to control
chromatic aberration and flare (both
of which are near perfectly handled),
as well as a newly designed HSM
(Hypersonic Motor), which makes for
a great autofocusing experience.

While this construction does come
at a cost, both financial and heft – the
14mm f/1.8 weighs 1.1kg – its potential
for anybody looking to shoot ultra-wide
during low-light is undeniable, with the
fast f/1.8 aperture, huge front element
and 14mm focal length all screaming
astrophotography. Despite such a wide
aperture, the nature of ultra wide-angles
mean you’ll still have a mammoth depth-
of-field, allowing for crisp foregrounds, as
well as sharp sky details. Of course, this

lens is just as at home with landscape,
travel and architecture, which all benefit
from such a unique perspective, as well
as a large in focus area. One drawback
of this lens is the lack of filter ring due
to the bulging front element found
in many lenses of this focal length.
While companies like Lee Filters will
inevitably make adaptors to allow you
to use filters, these will cost hundreds.

Though it may be costly and not as
versatile as Sigma’s other newest release,
this lens performs spectacularly. The
distortion at the edges of the frame is
leagues above other lenses in this focal
length, with very little distortion being
evident and lines at the extremes of the
frame remaining relatively straight.
Sharpness is astounding, with the centre
at f/1.8 blowing us away and the corners
being equally impressive. We wouldn’t
hesitate to recommend this lens.
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Above Despite its ultra wide-angle, barely
any distortions are visible in the image.

Above The 14mm offers a minimum
focusing distance of 27cm.

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

PROS Wide maximum aperture
Ultra-wide focal length
Superb sharpness
Image quality

CONS Heavy and bulky
Expensive Rather limited uses

THE VERDICT

HIGHLY 
RATED



F
OR
the
fo
most major manufacturers

offering lenses at this range due to its 
extreme versatility. While own-brand 
lenses have often been the go-to for 
anybody looking for premium quality, 
Sigma has just released its own 24-70mm 
f/2.8 in the widely acclaimed Art range. 

Featuring the excellent build quality 
found throughout the Art collection, 
this new lens comes with Sigma’s 
traditional quality, housing 19 elements
in 14 groups, including 3 SLD (Special 
Low Dispersion) and 4 aspherical 
elements for optimum results, as well 
as 9 rounded diaphragm blades that 
result in beautifully rounded bokeh in 
the out of focus areas. This also impacts 
the chromatic aberration, which is 
virtually non-existent in even the highest 
contrast scenes, as well as vignetting, 
which is faint but disappears by f/5.6.

The body itself, weighing in at a rather 
chunky 1kg (heavier than Canon and 
Nikon’s alternatives) offers Sigma’s OS 
image stabilisation (which puts it a step 
beyond its own-brand contemporaries), 
which can be selected on the side of the 
barrel. This adds an extra level of value 
to the Sigma, which is already retailing 

which works amazingly well, offering
fast and accurate autofocus. Even in low 
light the hunting was kept to a minimum. 

At the wider focal lengths, the centre 
of the image is sharp at f/2.8, with the 
corners being slightly softer (though 
still impressive) until f/5.6. This level 
of sharpness does start to decline 
when you get towards the minimum 
aperture, with defraction setting in 
quite noticeably at f/22. However, when 
you’re using this at 70mm, the corners 
are noticeably softer than the centre 
throughout the range, though still 
perfectly usable. We also found that 
24mm was susceptible to noticeable 
barrel-distortion when used close to your
subject. The same is true at 70mm, with 
some light pin-cushioning being visible. 

stabilisation giving it a clear advantage
in low-light performance over its rivals.
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LENS TEST

Above OS and focus modes can be 
activated quickly with the switches.

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

PROS Versatile focal length Wide
maximum aperture Build quality

Image stabilisation

CONS Heavier than its main
competition Suffers from slight barrel 
and pin-cushion distortion

THE VERDICT

DG O £1399



2
Equipped with the same 1/2.3in

sensor as you’d find in a Mavic Pro, 

the Spark is capable of brilliant stills 

and smooth 1080p footage, thanks 

to the 2-axis stabilised gimbal.

3
A new sensing system on the 

front allows the Spark to recognise 

your face, as well as accept hand 

gestures to control its movements. 

You are actually able to pilot this 

drone without the need for any 

additional controller at all.
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D

DJI SPA R K

4
The intelligent battery allows 

up to an impressive 16 minutes of 

flight time, as well as offering an LED 

display so you can check your power 

level with the press of a button.

1
We’ve seen drones which

are small before, but none that 

pack in such an insane level of 

technology and functionality. The 

Spark weighs a mind-blowing 300g, 

as well as being small enough 

to fit into a pocket... almost.

KIT PRICE 
£519

IMAGE RESOLUTION 
12MP
VIDEO 

1080p

1

2

3
4

The Spark houses extremely advanced  
tech, a 1/2.3in 12MP sensor and hand-
gesture control. Kirk Schwarz unleashes 
his inner Jedi to test it out.

GetIntoGear

HIGHLY 
RATED



level of precision when
hovering, offering a minimum
+/- 0.1m vertical and +/-
0.3m horizontal accuracy 
range (giving it exceptional 
steadiness in-air). DJI’s 
excellent vision system is 
also included, allowing for 
obstacle avoidance at up to 
22mph (though there are no 
side-mounted sensors, so be 
wary in confined spaces). A 
new addition is the 3D sensing 
system, which is effective 
at up to 0.2m–5m, allowing 
hand-gesture control – the 
piece de resistance of the 
Spark. Hand gestures allow 
you to control the Spark 
with nothing but hand 
movements, making it follow
you, track you and even take
photos from the air. It’s very
impressive and may be as 
close to becoming a Jedi as
you’ll ever get, so long as you
stay within the 5m operating
zone. It offers the ability to
connect to a smart device 
via Wi-Fi for more precise 
control, which increases the
operating distance to 100m
and 50m height. This allows
you to take advantage of the
new QuickShot mode, where

you can command the Spark
to complete some advanced
cinematic manoeuvres for
pro-looking footage. It also 
packs a 2-axis mechanical 
gimbal to control pitch and 
roll shake, which isn’t quite as 
good as the more expensive 
Mavic Pro’s 3-axis gimbal, 
but it still works well. It 
also offers vibrant Full HD 
1080p 30fps video, though 
you’ll need a Mavic Pro of 
Phantom 4 Pro for 4K.

Handling & build
The DJI Spark may be one of 
the smallest enthusiast drones
on the market, weighing in at 

a svelte 300g and measuring
143x143x55mm, but its
construction is every bit as
sturdy as its more advanced
relatives. The fixed propeller
supports are robust enough
to face the occasional scrape,
and the plastics used feel
tough and long wearing, with
a couple of hairy moments
in a corn field leaving no
lasting damage. The props 
themselves stay attached 
to the drone, meaning you 
needn’t fiddle with them 
every time you scramble 
for take off. Perhaps one 
of the biggest USPs for the 
Spark is the fact that you 
can put it in its tiny case, 
leave it in the bottom of 
a backpack and whip it
out at a second’s notice.

Performance
Traditionally, when a 
company releases a smaller, 

cheaper product, certain
omissions must be made,
and while that’s true in part, 
there are also features which 
you won’t find in DJI’s more 
expensive offerings. The 
full array of hand gestures 
are responsive (though may 
take a little getting used to) 
and offer you an undeniable 
level of pick-up-and-play fun, 
which actually disguises some 
very advanced tech. Making 
the Spark track your hand as 
you move from side to side, 
or having it take off and land 
on your palm works nearly 
flawlessly, within the 5m 
range. You have the option of 
using a smartphone or tablet 
to act as your controller, 
which allows you to see 
through the camera and 
unlocks many features, such 
as the new ShallowFocus 
mode, which fakes a shallow 
depth-of-field in your 
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The Spark comes with a fixed

aperture of f/2.6 and 25mm 

(35mm equivalent) lens. 

owever, you can adjust the 

utter speed and ISO 

anually, as well as use 

xposure compensation for 

auto shots. We’re very 

impressed by the detail we 

can get from the 12MP 

camera – much like the 

Mavic Pro, the dynamic 

range is superb for a sensor 

of this size. The gimbal does 

great job of stabilising the 

mera, and even video 

otage looks very impressive. 

Small size,
big results

IMAGE 
QUALITY

DRONE TEST

“QUICKSHOT ALLOWS YOU
TO PERFORM COMPLEX 
AERIAL MOVES WITH THE 
PRESS OF A BUTTON”

It’s important to remember that the use of drones 

is covered by relevant laws set out by the Civil 

Aviation Authority (CAA). As a recreational user, 

you must keep your drone in your line of sight, 

stay at least 150m away from any congested area 

or organised open air crowd of more than 1000 

people, or 50m away from people, property or 

objects that are not under your control. You are 

also required to stay below 120m in height, which 

is automatically built-in. In addition, new 

regulations are set to require you to register any 

drone which is over 250g with the CAA.

  Know The Law Drone Do’s & Don’ts 



All prices include VAT @ 20%. All products are UK stock. E&OE. * = Please mention “Practical Photography” for this special price.
For our opening times and directions to our BURGESS HILL and LONDON stores, please visit www.parkcameras.com/prp.

Prices correct at time of going to press; Prices subject to change; check website for latest prices.

Exclusive offers,
competitions & more at

Experts in photography   Unbeatable stock availability Competitive low pricing UK stock

Visit our website - updated daily

www.parkcameras.com/prp

or phone us Monday - Saturday

01444 23 70 54

Canon EOS M5

24.2
MEGA

PIXELS 7 FPS

Body only

£864.00*

+ 15-45mm

£914.00*

*Prices after £85 cashback
from Canon. 01.09.17 - 17.10.17

AF G 10.5mm f/2.8G ED DX £585.00

AF D 14mm f/2.8D £1,369.00

AF D 16mm f/2.8D Fisheye £566.00

AF S 20mm f/1.8G ED £649.00

AF D 20mm f/2.8 £477.00

AF D 24mm f/2.8D £379.00

AF S Nikkor 24mm f/1.4G £1,530.00

AF D 28mm f/2.8 £289.00

35mm f/2 AF Nikkor D £279.00

AF S 35mm f/1.8G ED £439.00

AF S 35mm f1.8G DX £179.00

AF S 40mm f/2.8G ED £229.00

AF 50mm f/1.4D £259.00

AF S 50mm f/1.4G £379.00

AF D 50mm f/1.8 £119.00

AF S 50mm f/1.8G £189.00

AF D 60mm f/2.8 Micro £409.00

AF S 60mm f/2.8G Micro ED £479.00

AF S 85mm f/3.5G DX £449.00

AF S 85mm f/1.8G £429.00

AF S 105mm f/2.8G VR £729.00

AF D 180mm f/2.8 IF ED £684.00

AF D 200mm f/4D IF ED £1,269.00

AF S 200mm f/2G ED VR II £4,473.00

AF S 300mm f/2.8G ED VR II £4,699.00

AF S 300mm f/4 D IF ED £1,099.00

AF S 300mm f/4E PF VR £1,449.00

AF S 400mm f/2.8 FL ED VR £9,999.00

AF S 500mm f/4E FL VR £8,449.00

AF S 600mm f/4E FL VR £9,999.00

AF S 800mm f/5.6E FL VR£14,999.00

AF S 10 24mm f/3.5 4.5G £729.00

AF S 14 24mm f/2.8G ED £1,649.00

AF S 16 80mm f/2.8 4E VR £859.00

AF S 16 85mm f/3.5 5.6G £424.00

AF S 17 35mm f/2.8 IF ED £1,549.00

AF S 17 55mm f/2.8G DX £1,315.00

AF S 18 35mm f/3.5 4.5G £619.00

AF S 18 105mm VR £219.00

AF S 18 140mm ED VR DX £429.00

AF S 18 200mm ED VR II £534.00

AF S 18 300mm f/3.5 6.3 VR £629.00

AF S 24 85mm VR £439.00

AF S 28 300mm ED VR £799.00

AF S 55 200mm f/4 5.6 VR II£239.00

AF S 70 200mm f/2.8 VR II£1,998.00

AF S 70 300mm IF ED VR £499.00 

AF S 200 400mm VR II £5,899.00

NIKON LENSES Prices updated DAILY! Visit us in store, online at
parkcameras.com or call us on 01444 23 70 54

In stock at £1,999.00

Canon EOS 77D

24.2
MEGA

PIXELS 6 FPS

Body only

£714.00*

+ 18-55 IS STM

£834.00*

*Prices after £85 cashback
from Canon. 01.09.17 - 17.10.17

Canon EOS 7D Mark II

20.2
MEGA

PIXELS 10 FPS

Body only

£1,169.00*

+ 100-400mm

See web
*Price after £130 cashback

from Canon. 01.09.17 - 17.10.17

Canon EOS 5D Mark III

PIXELS

MEGA

£1,999.00*

See website for
low prices on

lenses

*Price available whilst stock
last! See web to learn more

14mm f/2.8L II USM £1,999.00

20mm f/2.8 USM £449.00

24mm f/1.4L Mk II USM £1,499.00

24mm f/2.8 IS USM £409.00

24mm f/2.8 STM £139.00

28mm f/1.8 USM £399.00

28mm f/2.8 IS USM £389.00

35mm f/1.4L II USM £1,799.00

35mm f/2.0 IS USM £465.00

35mm f/2.8 Macro IS STM £399.00

40mm f/2.8 STM £189.00

50mm f/1.2 L USM £1,272.00

50mm f/1.4 USM £339.00

50mm f/1.8 STM £106.00

60mm f/2.8 Macro £350.00

85mm f/1.2L II USM £1,767.00

85mm f/1.8 USM £327.00

100mm f/2 USM £405.00

100mm f/2.8 USM Macro See web

100mm f/2.8L Macro IS £699.00

135mm f/2.0L USM See web

180mm f/3.5L USM £1,229.00

200mm f/2.0L IS USM £5,399.00

200mm f/2.8L USM/2 £699.00

300mm f/2.8L USM IS II £5,799.00

300mm f/4.0L USM IS £1,199.00

400mm f/2.8L USM IS II £9,899.00

400mm f/4.0 DO IS II £6,999.00

400mm f/5.6L USM £1,170.00

500mm f/4.0L IS MK II £8,299.00

600mm f/4.0L IS MK II £10,995.00

800mm f/5.6L IS USM £11,899.00

TSE 17mm f/4.0L £1,999.00

TSE 24mm f/3.5L II £1,689.00

TSE 90mm f/2.8 £1,239.00

8 15mm f/4L USM £1,119.00

10 18mm IS STM £199.00

10 22mm f/3.5 4.5 £499.00

11 24mm f/4L USM £2,699.00

15 85mm f/3.5 5.6 IS See web

16 35mm f/2.8L II USM £1,429.00

16 35mm f/2.8L III USM £1,899.00

16 35mm f/4.0L IS USM £849.00

17 40mm f/4.0L USM £619.00

17 55mm f/2.8 IS USM £718.00

18 135mm IS STM £379.00

18 135mm f/3.5 5.6 IS USM £429.00

18 200mm f/3.5 5.6 £439.00

24 70mm f/2.8L II USM £1,699.00

24 70mm f/4.0L IS USM £699.00

24 105mm f/4L IS II USM£1,065.00

24 105mm f/3.5 5.6 IS STM £366.00

28 300mm f/3.5 5.6L IS £2,249.00

55 250mm f/4 5.6 IS STM £269.00

70 200mm f/2.8L IS II USM£1,699.00

70 200mm f/2.8L USM £1,329.00

70 200mm f/4.0L IS USM£1,049.00

70 200mm f/4.0L USM See web

70 300mm f/4.0 5.6 IS £449.00

70 300mm f/4.0-5.6L IS USM£1,279.00

70 300mm f/4.0-5.6 IS II USM £449.00

100 400mm L IS USM II £1,789.00

200 400mm f/4.0L USM£10,999.00

1.4x III Extender £398.00

2.0x III Extender £389.00

CANON LENSES Prices updated DAILY! Visit us in store, online at
parkcameras.com or call us on 01444 23 70 54

3 year warranty available on Canon L-series lenses!
www.parkcameras.com/canon-l-series-lenses

The search for the perfect image can take
you anywhere. Go there with the powerful,
nimble, and fully connected D7500. Catch the
beauty you find with flagship DX image quality
inherited from Nikon’s D500.

20.9
MEGA

PIXELS
4K3.2”

8 fps

Nikon D500

20.9
MEGA

PIXELS 10 FPS

Body only

£1,729.00

+ 16-80 VR

£2,479.00

Add a Nikon EN-EL15 spare
battery for only £64!

This mechanism-free camera can deliver a-class-
above performance conventional mechanical SLRs
have only sought. A high-speed, vibration-free,
silent Anti-Distortion shutter vastly extends the
range of shooting situations.

24.2
MEGA

PIXELS
IS 4K3.0”

20 fps

Sony RX100 V

20.1
MEGA

PIXELS

In stock

£899.00

Spread the cost with

our finance options!

Add a Sony NP-BX1 battery
for only £38.00

4K

Sony a7S II

12.2
MEGA

PIXELS

£2,499.00

See website for
low prices on

lenses

See in store or online for a 
free 2 year warranty!

Sony a6500

24.2
MEGA

PIXELS 11 FPS

Body only

£1,282.00

+16-70mm

£1.909.00

Add a Sony NP-FW50 battery 
for only £50.99 

Joining the Contemporary family of Sigm
this compact lens utilises optical image
to assist in long-range photography - wit
applications of sports or wildlife photography b
perfect beneficiaries of this technology. In stock at £799.00

Sigma 100-400mm
f/5-6.3 DG OS HSM | C

Lume Cube
LED Lighting

Available from

£87.95

See the Lume Cube range of
LED lights on our website!

Manfrotto 1to 190 GO!
Carbon Fibre
Tripod

Available from

£249.00

See the range of tripods in
store or on our website!

Vanguard AltaVangu
Shoulder bags / Backpacks

Available from

£99.95

See the Vanguard range
in store or online!

LEE Big Stopper
100x100m

In stock at only

£99.00

For even more LEE filters, see
in store or on our website.

Tamrac Anvil Slim 11
Backpack

In stock at only

£122.00

For even more bags, visit us
in store or see our website

Gitzo GK15
82TQD Trip
+ Head

In stock at only

£789.00

For even more tripods, visit
us in store or see our website

22.3

6 FPS LOW

PRICE!

UP TO £215 
CASHBACK

Visit us in store online or call 
01444 23 70 54 to benefi t from 

cashback on a range of Canon lenses!

Achieve new creative goals, with advanced
performance and innovative features
that will support your next steps in
photography – wherever they might lead.

26.2
MEGA

PIXELS 6.5 fps
1080p3.0”

NEW!

£85

cash
back

£85

cash
back

Canon EOS 80D

24.2
MEGA

PIXELS 7 FPS

Body only

£914.00

+ 18-55 IS STM

£944.00

*Prices after £85 cashback 
from Canon. 01.09.17 - 17.10.17

£85

cash
back

£130

cash
back

Canon EOS 5D Mark IV

30.4
MEGA

PIXELS

4K

Body only

£3,349.00

24 months 0%
finance available.

See website

Add a Canon LP-E6N spare 
battery for only £68.00 

In stock from £1,299.00

Com
ing

soon...

Nikon have announced the next frontier in full-frame, 
high-resolution, high-speed digital SLR cameras with 
the upcoming release of the highly anticipated D850.

Learn more at www.parkcameras.com/nikon-d850

In stock from £1,299.00

Tamron have introduced the world’s
ultra-telephoto all-in-one zoom lens
achieve 400mm telephoto.

In stock at £649.00

Tamron 18-400mm
f/3.5-6.3 Di II VC HLD

Learn more at www.parkcameras.com
*Among interchangeable lenses for DSLR cameras

NEW!

Visit our London store on 9th September, and get help & advice from an expert from Nikon!
Learn more and see what other events are coming soon at www.parkcameras.com/events

Visit www.parkcameras.com/calendar-competition-2017
and enter our FREE photo competition to win some 
fantastic prizes! 



images. It also offers a world
of cinematic possibilities
with the QuickShot feature, 
letting you select options 
such as Helix, Rocket, Dronie 
or Circle, each performing 
an advanced manoeuvre. 
QuickShot is an extremely 
impressive feature and we 
managed results which we 
would struggle to achieve 
by relying on our own skill. 

Familiar DJI options 
return, such as ActiveTrack, 
where you select a subject 
and the Spark will diligently 
follow. Return to Home 
lets you recall your drone 
with the press of a button. 
This feature also kicks in if 
the battery is running low. 
Another fan-favourite, TapFly,
is here, where the Spark will 
gauge the depth and distance 
required to get to the spot 
you selected and go to it. The 
1080p video looks fantastic, 
and although it’s not 4K, it 
serves a purpose for anybody 
looking to start their drone 
journey well and footage still 
looked very smooth, even in 
high winds. Our favourite 
video feature is being able to
control the pitch of the camera
by simply tilting your iPhone
(sadly this feature is not yet
present on Android devices),
as well as using the more 
traditional controls. Using 
a smartphone without the 

optional remote control will
limit your drone’s capability,
allowing you an operating 
distance and height of only 
100m and 50m respectively, 
as well as limiting the top 
speed to 6.5mph instead of the 
possible 31mph. If you’re after 
the full experience, you’ll 
need to purchase the remote 
control (which comes as part 
of the Fly More pack, with an 
additional battery and prop 
guards for an extra £180). 
Although this is an additional 
expense, the difference it 
makes is phenomenal, giving 
the Spark near-Mavic levels 
of responsiveness. We would 
like to see the propeller 
guards included as standard, 
considering they’re an 
important safety feature. 

The fact you can only shoot 
in JPEG, unlike the Mavic 
Pro, which allows you to shoot 
in DNG (RAW) is a bit of a 
drawback, but the images look 
great, and you can still shoot 
in manual exposure mode to 
fine-tune your settings, as 

well as use the ShallowFocus
and Pano features to get
some excellent results.

Verdict
The DJI Spark is a curio –
half selfie drone and half
tech marvel. It’s extremely
capable and handles like a
dream, even more so if you
invest in the remote control.
The footage you can achieve is
extremely impressive. So too
are the 12MP stills. The hand
gestures, though maybe a
gimmick, work exceptionally
well and the QuickShot
feature lets you film like a pro
with absolutely no experience.
Of course, the additional cost
of the remote control and
propeller guards, as well as
limited battery life (though
still stronger than most
competition) do count against
it. Overall, this is a great and
reasonably-priced option
for anybody contemplating
taking a tentative first step
into drone use, and one we
would highly recommend.

TECH SPEC
Drone: DJI Spark

Lens: 25mm (35mm

equivalent) f/2.6 with

an 82º field of vision

Price: £519 (£699 for the

Fly More pack)

Effective resolution: 12MP

Sensor: 1/2.3in CMOS

Controller: Hand gestures or

smartphone, remote controller

is additional

Shutter: 2-1/8000sec

ISO: 100-1600 (stills)

& 100-3200 (video)

Shooting speed: 3fps

Video: 1080p Full HD 30fps

Positioning: GPS & GLONASS

Other features: ActiveTrack,

TapFly, ShallowFocus, Pano,

QuickShot

Battery life: Max 16 minutes

flight time, 15 minutes

hovering time in still conditions

Card type: SDHC, SDXC

Size (WxHxD):

143x143x55mm

Weight: 300g

Web: dji.com

FEATURES

HANDLING

OVERALL SCORE

IMAGE QUALITY

VALUE FOR MONEY

PROS Lightweight and compact Easy to use
Obstacle avoidance Relatively cheap
Hand gestures QuickShot feature

CONS No 4K video Short battery life
Controller and prop guards cost extra

THE VERDICT 
DJI SPARK

5

6
7
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10
OF THE
BEST

from just £10
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Lenses are such an integral part of
photography, but we always judge 
them by the same standard. Is the 
image sharp? Are the corners free from 
vignetting? Is the chromatic aberration 
evident? Sometimes we forget that 
they are simply tools – a means to an 
end. But what do you do when you 
want to take a break from the norm 
and capture an image with a bit more 
of an artistic feel to it? Luckily there 
are options designed just for you. With 
creativity in mind, this month we are 
checking out lenses that each give a 
different and unique effect to inspire 
your creativity. Some of these are as 
cheap as £10, while others are a bit 
more expensive. Kirk Schwarz looks 
at 10 of the best creative lenses...

Holga 60mm lens............................................ £10........P136
Thingyfy Pinhole............................................. $79 .......P136
Lensbaby Spark.............................................. £79........P137
Lensbaby Twist 60.......................................... £199......P137
Lomography Daguerreotype Achromat .... £399 .....P138
Lomography Petzval 85mm.......................... £459 .....P138
Laowa 15mm f/4 1:1 Macro .......................... £499 .....P139
Fujifilm XF56mm f/1.2 R APD ....................... £1159 ....P139
Canon 8-15mm f/4L Fisheye USM ............... £1199....P140
Nikon 24mm f/3.5 ED PC-E........................... £1429....P140

IN THE TEST

IN THE FIELD 
Due to each lens offering a 

distinctive look, which may 

not mean perfect optical 

quality on our usual graph 

tests, this month we are 

taking them into the field

and shooting with them

to inspect the final image

and the look of the effect.

OVERALL EFFECT
I’ll also be taking the impact of the overall effect into 

consideration, as well as the price and the usefulness

of the lens. Points will be awarded for value for money,

build quality and ease of use.

HOW WE TESTED 
THE LENSES

CREATIVE LENSES
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For anybody who’s used the Holga

120N medium-format Russian toy

camera, you’ll know how distinctive

the look is, with saturated colours,

a heavy vignette and soft focus

all contributing. You can now buy

a Holga lens for DSLRs, which is

about a 40mm focal length on

full-frame. The lens is as you’d

expect for the price, being very

cheap in feel, with moulded plastic

forming every aspect of the

construction – as well as featuring a

plastic element – necessary for the

retro look. The aperture is a fixed f/8

and focusing is denoted by icons on

the lens – a mountain for infinity, a

single person for close-up – though

you’ll struggle to find any sharpness

here. We found the aperture to be

narrower than f/8, and had to bump

the ISO and lower shutter speeds

drastically. While this adds to the

effect, it’s not ideal. This lens is a

fun experiment, but we doubt you’ll

get more than a couple of shots

before you get bored. ebay.co.uk

The principle of the camera obscura

has been around since 500BC, so

it’s refreshing to see this recent

innovation in pinhole technology.

Canadian company Thingyfy

has created the world’s first

multi-aperture pinhole lens thanks

to a very successful Kickstarter

campaign. Weighing in at 120g, this

miniscule lens allows you to switch

aperture as you shoot (a first for

pinhole photographers), choosing

from a 0.1-0.8mm range. We have

to compliment the build quality,

which is very sturdy for such a lens,

with a single twist ring to change

apertures. Although this lens may

have a perfect everyday focal

length of 55mm, it does require long

exposures to gather enough light

into the sensor. At $79, this won’t

break the bank but will give you

a very distinctive look, extremely

well suited to documentary work

or anybody looking to add some

autheniticity to their vintage shots.

indigogo.com (search Pinhole Pro)

PROS
Retro look

Cheap

Fun to

experiment with

CONS
Very narrow

effective aperture

Hard to focus

PROS
Creative look

Vintage lo-fi

feel

Multi-aperture

CONS
Requires long

exposure times

Never sharp

RATING RATING

SPEC
Aperture: f/8

Weight: 38g

Focal length: 60mm

SPEC
Aperture: 0.1-0.8mm

Weight: 120g

Focal length: 55mm

HOLGA THINGYFY

60MM LENS FROM £10 PINHOLE PRO $79

Below The soft focus 

and heavy vignette 

are all signs of the 

traditional Holga.

Below Pinhole 

lenses give a very 

distinctive look when 

used on a DSLR.

GetIntoGear

Q MICRO 4/3Q PENTAX K Q FUJI X 
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When you think of creative lenses,

it’s hard not to think of Lensbaby,

with its optics offering a unique

blend between tilt and shift and the

freelensing technique. The Spark 

has a fixed f/5.6 aperture with a 

50mm focal length and it includes

a plastic lens element attached to

a set of bellows. This allows you to

move the lens around to change the

‘sweet spot’, as well as the blurred

area which surrounds it (it does this

by changing the direction of the 

light entering the lens, so it doesn’t

always converge on the centre of 

the sensor like a traditional lens). 

Focusing itself can be achieved 

by pulling the element towards the

sensor and is very intuitive. The look

is very hard to achieve in any other

way, and the raw colours produced

are unique and honest as well as 

being tonally varied. Although this is

a quirky lens at heart, it’s beautifully

atmospheric and unique, working

very well in portraiture to give an

ethereal look. lensbaby.com

The second Lensbaby in our line-up

adheres to a more traditional

form. It’s a 60mm lens with an

aperture range of f/2.5-f/22 and a

minimum focusing distance of 18in.

Lensbaby describes this as having

a ‘twisty, swirly blur’, and as the

name suggests, it creates a twist at

the edge of the frame, akin to the

Petzval lens from Lomography. It

also creates a very heavy vignette,

which makes subjects in the

centre of your frame really stand

out. The lens has two parts to

it – a focusing ring, which acts in

the same manner as any modern

lens, and the brass barrel, which

extends when focusing. You twist

the latter to change the aperture,

though we find the effect works

best at wider apertures. Overall,

this gives a very pleasing effect,

but you’ll need to make sure you

have a busy enough background

to take advantage of it, as shooting

against anything plain will diminish

the overall effect. lensbaby.com

PROS
Unique look
Easy to control
Instant

creativity

CONS
Hard to achieve

perfect focus
Fixed aperture

PROS
Simple to focus
Build quality
Great colour 

rendition

CONS
Lesser effect  

on APS-C
Fiddly aperture

RATING RATING

SPEC
Aperture: f/5.6
Weight: 96g
Focal length: 50mm

SPEC
Aperture: f/2.5-22
Weight: 221g
Focal length: 60mm

LENSBA BY LENSBA BY

SPARK £79 TWIST 60 £199

Below The bellows 
allow you to create 
a sweet spot almost 
anywhere in frame.

Below The edge blur 
shows the ‘twisty’ 
effect, courtesy of the 
Petzval-type design.

CREATIVE LENSES

HIGHLY 
RATED
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Possibly the prettiest lens on test,

with its brass construction evoking

a 19th century feel, the Achromat

has been designed by Lomography

and is based on the world’s first 

Daguerreotype optic by Charles 

Chevalier. It’s a manual focus lens

which provides a dreamy soft focus

at wider apertures, or a sharper 

image beyond f/5.6. It allows you to

insert manual aperture slides into 

the body (known as a Waterhouse

system, which come included), 

which will give your bokeh (the orbs

in the out-of-focus areas) different

shapes. It has a focal length of 64mm,

and a very distinct effect, making it

ideal for portraits. However, it won’t

be to everybody’s taste, and we 

found it to be quite distracting at 

times. Though changing the shapes

of your aperture inserts does result

in some amazingly different bokeh,

the image as a whole can become

almost fabric-like in texture. More of

an acquired taste than a must-have.

lomography.com

This fully brass lens is similar in

execution to the cheaper Lensbaby

Twist 60, though packed into a more

visually-appealing body, and using a

Waterhouse Aperture System (using

insertable aperture plates to switch

between the ranges). Focusing is

controlled by the dial on the side of

the body, with a distance scale on

the top. This is a throwback to the

techniques used in the 19th century,

though we prefer the current system,

finding this a bit fiddly in practice,

although the quality of the glass

is very impressive, with very

respectable central sharpness (the

corners, of course, are meant to be

soft and swirly). The bokeh rendition

is clean and plentiful when using

the wider aperture plates, and the

twisting effect lends itself to

isolating your subjects extremely

well. This is an interesting lens, and

a good way to appreciate the history

of photography, though it may be a

bit too expensive if you aren’t sure

of its usefulness. lomography.com

PROS
Ability to shape

your bokeh
Iconic history
Unique effect

CONS
Heavy
Very love it/

hate it effect

PROS
Great aesthetic
Build quality
Interesting 

effect

CONS
Reduced effect 

on APS-C
Fiddly focusing

RATING RATING

SPEC
Aperture: f/2.9-16
Weight: 689g
Focal length: 64mm

SPEC
Aperture: f/2.2-16
Weight: 680g
Focal length: 85mm

LOMOGRAPHY LOMOGRAPHY

DAGUERREOTYPE 
ACHROMAT F/2.9 £399

PETZVAL 85 
ART LENS £459

Below The aperture 
system lets you 
change the shape 
of the bokeh.

Below The Petzval 
creates a similar 
swirl to the 
Lensbaby Twist.

Q PENTAX KQ PENTAX K Q NIKONQ NIKON Q CANONQ CANON
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As its focal length suggests, this

is one of the most innovative macro

lenses out there, and was handed a

five-star review in our recent macro

lens test (Spring 2017). Allowing you

to focus within millimetres of the 

front element gives you some truly

unique perspectives, which would

be impossible with other lenses. 

We  previously noted that the lens

had soft edges and heavy vignetting

throughout its aperture range (up to

f/32), though both ‘faults’ give this

a very unique feel. This is especially

evident when turning your hands 

to landscape photography, where

you will get a very fine art feel, 

with the optics producing a very 

simple and honest colour pallette.

The lens also has a basic +/- 4mm

shift mechanism, for correcting 

perspective when shooting 

architecture. This Laowa is already

a must for macro enthusiasts, but

it’s also recommended for anybody

who wants to take wild, epic fine

art landscapes. laowalens.co.uk

Fujifilm has two 56mm lenses for

their X Series cameras, and although

the APD is near identical in spec,

it’s hiding a secret its rivals can’t

compete with. APD stands for

apodization filter, an inclusion that

makes the bokeh smoother than a

regular lens. By counteracting the

lens’ natural diffraction, it’s able to

remove the hard edge of bokeh and

represent it as a smooth, gradual

decline. This is a feature which gives

the APD its allure, making it one of

the few lenses available with an

apodization filter. The only downside

is that apertures are slightly

narrower than you realise until you

reach f/5.6, so Fujifilm has included

a scale to let you know the effective

aperture (e.g. f/1.2 is actually f/1.7).

It also has the bonus of feeling like

a modern lens, with autofocus and

full compatibility with X Series

cameras. The effect, while subtle,

is a lens which creates a stunning

array of bokeh, while avoiding any

nasty distortions. fujifilm.eu

PROS
Extremely close

focusing distance

True 1:1 macro

Shift

mechanism

CONS
Manual focus

Heavy vignette

PROS
Amazing

image quality

Gorgeous and 

plentiful bokeh

Autofocus

CONS
Subtle effect

Expensive

RATING RATING

SPEC
Aperture: f/4-32

Weight: 410g

Focal length: 15mm

SPEC
Aperture: f/1.2-16

Weight: 410g

Focal length: 15mm

L AOWA FUJIFILM

15MM F/4 1:1
WIDE MACRO £499

XF56MM  
F/1.2 R APD £1159

Below The short 

focusing distance 

allows for some 

truly creative shots.

Below The bokeh 

looks gorgeous and 

soft, thanks to the 

apodization filter.

CREATIVE LENSES

HIGHLY 
RATED

Q FUJI X Q PENTAX KQ NIKONQ CANON



144 PRACTICAL PHOTOGRAPHY

More than a traditional fisheye, this

ultra wide-angle zoom offers two

different perspectives on a full-frame

camera. At the widest length, 8mm,

you will see a circular image in the

frame, with anything outside of that

image being black. If you zoom out

to 15mm, the image becomes more

akin to a diagonal fisheye, meaning

it fills the entire image frame, corner

to corner. While fisheye lenses 

aren’t as popular as they once were,

the ability to get creative is almost

unparallelled. When shooting close

up, the lens revels in its distinct 

barrel distortion, making anything

in the centre of the image appear 

bulbous. The minimum focusing 

distance of 15cm lets you get up 

close for some spectacular shots.

It’s also one of only two lenses in 

test to support autofocus, with 

Canon’s USM (Ultra Sonic Motor)

allowing for quick and accurate

selection, though being ultra-wide,

even at f/4 you’ll find a surprisingly

large depth-of-field. canon.co.uk

Most of us are familiar with the tilt

& shift look, with many Photoshop

tutorials and smartphone camera

filters dedicated to replicating the

effect. However, you’ll never be able

to truly recreate the effect better

than with a dedicated lens. Nikon’s

24mm moves across both vertical

and horizontal axes, allowing you to

correct for perspective distortions.

Although designed with architecture

in mind, you can also create what’s

commonly know as the ‘toy town’

effect, creating a single line of focus

while blurring the rest of the scene.

This results in your scene looking 

like a miniature model, faking an 

impossibly small depth-of-field. 

While Nikon’s 24mm certainly isn’t

a cheap lens (Samyang offers an 

alternative for around £680), being

aimed at architectural specialists, it

does offer something unique on this

list, with a superior set of optics for

superb image quality and extremely

precise manual focusing.

nikon.co.uk

PROS
Insanely wide

field-of-view

Versatility on

full-frame

Image quality

CONS
Heavy

Expensive

PROS
Excellent for

architecture

Unique ‘toy

town’ effect

Easy to use

CONS
Expensive

Heavy

RATING RATING

SPEC
Aperture: f/4-22

Weight: 540g

Focal length: 8-15mm

SPEC
Aperture: f/3.5-32

Weight: 730g

Focal length: 24mm

CANON NIKON

EF 8-15MM F/4L 
FISHEYE USM £1199

24MM F/3.5D
ED PC-E £1429

Below This lens 

allows you to 

capture up to 180º 

corner to corner.

Below The tilt & shift 

effect is a classic, 

which has been 

often immitated.

HIGHLY 
RATED

GetIntoGear

Q NIKONQ CANON
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We thought it would be unfair to compare
such wildly different lenses against
each other in terms of image quality, so
we’ve decided to name the three lenses
that we felt had the greatest impact and
most unique effect. A couple of lenses
were more novel than useful, with the
Holga not standing out as something
we’d use for more than a couple of hours.
Similarly, the Fujifilm 56mm APD is one
of the best lenses I’ve ever used, but its
price and subtle effect (while stunning)
doesn’t give it the same level of creativity
as others in test. The effects were wide
ranging and, in some cases, very unique
to each lens – though we also had to
take value for money and quality into
consideration and at the end, there were
three lenses that stood out above the rest.

And our favourites are...
The Lensbaby Twist 60 arguably offers
some of the best results in test, with the

placement of the edges allowin
create a swirling effect which l
the viewer into the centre of yo
It also offers beautiful colour re
in a small and lightweight pack
means you can experiment wit
really creative compositions, as
the lens to isolate your subject
sense of movement and drama
the Laowa offers something un
ability to get a 1:1 macro shot fr
milimetres away – this will un
introduce the most creative fre
your macro shots. We were als
impressed by the Nikon 24mm
lens, though it’s very expensive
results can be created in Photo
a lens which has very good opt
creates an effect that will chan
you see scenes entirely. Getting
up and shooting large crowd sh
give you a reason to keep this le
kit bag every time you go walk

Overall verdict

“THE LENSBABY TWIST 60 OFFERS
A UNIQUE EFFECT, WITH SWIRLING
EDGES, FOR A GREAT PRICE”

Three of the best Low budget, low tech lens hacks 

Flowers From £1
By introducing a flower to the egde of

your lens, you can create a foreground

blur that’s almost akin to a light leak.

With the many different varieties and

colours available, there’s a lot of scope

for experimentation. This technique

helps to inject some depth into 

the scene, as well as 

an ethereal sense of 

fantasy and 

illusion. Just 

remember to hold

the flowers as close to the

lens as possible so they

completely blur out.

Psychedelic prism £3
Using a prism 

isn’t a new hack, 

but if you were to 

buy three small

mirrors (roughly

6x4in) and tape

them together to

form a triangle,

the result of shooting through them

is beautifully psychedelic. This is a 

technique used well by Lindsay Adler

in her fashion photography and gives

a truly unique effect with every shot,

and one that will definitely add a fresh

appeal to your portrait portfolio.

Custom bokeh £2
Bokeh, or the 

light blobs in the 

out-of-focus 

areas of an

image, are

rounded 

because that’s

the shape of the

aperture blades. We can create a fake 

‘second’ aperture by cutting any shape 

(such as a heart or star) into a piece of 

black card and holding it flush against 

our lens. Just make sure your shape is 

smaller than your aperture (focal length 

divided by f/number).

CREATIVE LENSES

HIGHLY 
RATED

HIGHLY 
RATED

HIGHLY 
RATED

Above

a unique perspective and the Nikon

tilt & shift makes you see differently.
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Cewe provides some excellent p

solutions, including photo book

has also recently revamped its design

software to be more intuitive and offer

a higher level of customisation. We

opted for a large landscape soft cover

book, with 26 pages, and classic paper

(though these can all be upgraded to

suit your needs), which represents great

value for money. You can choose to use

the online builder or smartphone app,

though we downloaded the creation

software. It offers a great amount of

customisation, as well as seemingly

hundreds of templates. The whole

process is very intuitive, though we’d

have liked the option to drag the images

anywhere on the page. The book itself

is great quality, especially for the price,

and we loved the ability to have our

images dominate the front and rear

covers, as well as adding text with

highlights. cewe-photoworld.com

SPEC Pages: 26 Front and rear cover
photo: Both Software download: Optional

Cewe Large Lan
Photo Book £20

pric

it doesn’t allow you to create your photo

book directly in-browser, as others

do, it offers a free software download

that’s packed with a truly massive

range of customisation options which

really impressed us – though we do feel

in-browser creation would have been a

nice inclusion. We chose the standard

A4 landscape hardcover (available in

black or white) with 20 pages. This

option doesn’t allow for an image to be

printed on the front cover, although it

does provide a window to the first page,

which frames your chosen image nicely.

The quality of the printing is exceptional,

with the colours and contrast appearing

as they would on-screen and the paper

feeling solid, all giving it a premium

feel and excellent value for money.

dscolourlabs.co.uk

SPEC Pages: 20 Front and rear cover
photo: No Software download: Mandatory

DS Colour Labs Standard
A4 Photo Book £27

HIGHLY 
RATED
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FIV E OF THE BEST

m canvas a

ugs. Using the online crea

allows you to craft your book in the

comfort of your own browser window 

– although the choice of a slightly more 

comprehensive software download 

would have been a nice touch. You 

can customise the layout with a wide 

range of templates and text, giving 

you a lot of freedom to arrange your 

photos – as well as a lot of pre-designed 

templates to give you a helping hand. 

We ordered an 11x8in book with a hard 

cover and 20 pages in matte. Although 

not the most comprehensive on the 

list, we found the process of creating 

our book to be simple and hassle-free, 

and the actual quality was great. The 

images looked every inch as good as 

when they were edited and the paper 

did a great job of making them stand 

out as we intended. snapfish.co.uk

SPEC Pages: 20 Front and rear cover 
photo: Both Software download: No

     

 

Whitewall is renowned for high quality

printing options, so we were excited

to see its photo books. We opted for a

standard landscape book with a hard

cover, 24 pages, standard glossy paper

and white book ends. The creation

process is very simple, allowing you

to either use the in-browser creator

tool, or upload a PDF, though much

like Snapfish, there is not dedicated

software. You can choose from manual

or automatic layout, for precision

placement. The automatic option will

create an entire book – all you have to

do is select a theme, though you can

switch to the more comprehensive editor

at any time. Here you can fine-tune your

images, drag them to any location and

resize them, as well as adding borders

and frames. Not the most comprehensive

creator, but the quality is very high, with

the glossy paper making our images

look outstanding. uk.whitewall.com

SPEC Pages: 24 Front and rear cover
photo: Both Software download: No

Whitewall standard

landscape A4 £34

BEST  
IN  
TEST

big way

book, which includes a g

matte spreads and 26 pages, all of whic

can be upgraded for an extra price. 

When it comes to creating, much like 

DS Colour Labs, you have to download 

the software, meaning you are unable to 

create a book directly in the browser. The 

software is exceptionally comprehensive, 

allowing you to create your book with as 

much or little precision as you require. 

We really appreciated the inclusion of 

guidelines, which you can move about 

the page to ensure all your edges are 

perfectly aligned. The book itself is very 

high quality, from the image on the front 

cover, to the richness of the tones and 

colours on the pages themselves, which 

is why this is definitely our top pick.

saal-digital.co.uk

SPEC Pages: 26 Front and rear cover  
photo: Both Software download: Mandatory 

 Saal-Digital - A4

 Landscape £30 



SOFTWA R E

Minitests

O

landscapepro.pics

Small accessories that could make a huge difference

Above

from £30

Above 

OFFER! 
SAVE 15% ON

LANDSCAPEPRO2
For a limited time, visit

landscapepro.pics  
and get 15% off the full 

price using code

PP10T



OWith many cameras becom

lightweight travel tripods off

alternative to expensive, bul

Benro Slim series offers grea

package, weighing only a sm

well as being light, it’s a bud

amazing for a tripod with a 1

included ball head and 4kg w

Without the central column,

operated with an intuitive tw

design, the tripod reaches 12

whole kit folds down to 51cm

travel a piece of cake. It also

a ball head and an Arca-styl

well as hard-wearing alumin

lock mechanisms, allowing y

legs in an instant. We’re extremely impressed

with this tripod, especially at the price, and

even more so with the aluminium version,

which retails at only £80. benro.com

Benro Slim
fiber tripod

TR IPOD

R ING LIGHT

O As anybody who shoots extreme macro

shots will tell you, getting the right level

of available light for a close-up shot can

be hard, and that’s where ringlights come

into the equation. The R60 by Kaiser is

a portable battery, or mains powered

(DC adapter sold separately) unit, which

attaches to the front of your lens via a filter

thread (it comes with 49, 52, 55, 58, 62

and 67mm adaptors). Once secured, it can

provide soft, even light over your subject

thanks to a circular array of 60 LED lights,

which are capable of putting out 2300

LUX (at 30cm). Each LED carries a colour

temperature of approximately 5600K,

which means they give roughly the same 

colour temperature as daylight (so your 

images don’t come with an unnatural blue 

or orange colour cast). This light can be 

dimmed, thanks to the inclusion of a control 

wheel on the side, to adjust the amount of 

light output. It also comes with a minimum 

working distance of 3cm, which allows 

you to get really close to your subject. 

The unit itself is pleasingly rugged, while

maintaining a lightweight feel thanks to 

its plastic construction. This means your 

lens won’t be over-burdened or top-heavy 

while you’re shooting. The light lasts for up

to 120 minutes at full power or 30 hours

when dimmed to the lowest setting, which

is very respectable, though you’ll want to

invest in a set of rechargeable batteries if

you’re a heavy user. One annoyance we

found was that the compartments which

house the four AA batteries were screwed

shut by two small Phillips Head screws.

This would normally be fine, but since each

battery has its own compartment, this 

means changing them becomes a bit of

a pain, and we’d have preferred a simple 

snap-shut design. kaiser-fototechnik.de
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Kaiser R60 
LED light £73

Pixi
Pano360
£125
Pixi Pano360 is

Manfrotto’s fully

remote controlled

rotating panoramic

head. Designed for

phones, it comes with

a universal smartphone

mount and a remote

control, allowing you

to move the head

left or right, as

well as set it to

a sweeping

video

motion or

minute increments. You can

also control this with the Pixi

Pano360 smartphone app, which

works as well as the head itself,

although sadly the price will put

off those who would prefer the

same kit but for a traditional 

camera. manfrotto.com

Above Thanks to 60 LED lights putting out

2300 LUX at a daylight colour temperature 

of 5600k, it provides very even illumination.

Right
inclusion o
head is ext

welc

Left 

HIGHLY
RATED

iStorage
Personal 2 
32GB £49
This 32GB USB thumb-drive

from secure memory

manufacturer iStorage offers

full XTS-AES 256-bit encryption

in a small package. Great for

anybody needing to transfer

sensitive data on the go. The

drive lets you set a password

on the keypad to ensure you’re

the only person able to view the

contents – perfect for keeping

hose special files safe. It also

offers USB 3.0 connectivity

or high speed transfer, and

s available in 8, 16 and 64GB

versions. istorage-uk.com



OMore intuitive interface
makes viewing even easier

O Extra images and videos
o inspire your photography

O Retina-optimised display  
or incredible detail & clarity

New iPad
edition!
The best digital 
photo magazine 
just got better...      

Enjoy over 60 minutes of
expert advice every issue

and get more free gifts

See the world s most amazing
photographs as they were

meant to be displayed

Navigate around the
magazine quickly and easily

with its slick new design

Bring pictures to life  
 with pan & zoom detail

 Take a fresh look at  
 your favourite features

 Watch the best camera  
 and editing videos 

Packed 
with over 
60 minutes  
of video 
lessons! 

Subscribe or buy a single issue now
www.greatmagazines.co.uk/pp



KOOD SUPPLIES EVERY PART OF THE PHOTO TRADE - HOME AND EXPORT.
EMAIL: info@koodinternational.com FOR DETAILS OF STOCKIST IN YOUR AREA OR, IF YOU ARE A CAMERA EQUIPMENT TRADER, 

SEND YOUR DETAILS FOR ACCOUNT APPLICATION AND TRADE SUPPLY PRICES

KOOD high Definition Slot ND Gradients and ND filters

1) KOOD uses small untoughend, thick Pilkington Optical Glass Mould’s
to produce the highest possible optically flat resin Filters, without
curvature, this maintains high definition throughout the focus range
including infinity

2) Casting system eliminates all bleach so no loss of density or colour
over time

3) Batch tested every 12 filters to maintain good neutrality

4) All filters packed in between card, in wallets which allows no
movement or dust

5) KOOD Manufactures its own resin filters from casting to packing

N

D
1
6

=
4

S
T

O
P
S

Canon EOS 5D MkII, Canon EF 16-35mm 
f2.8 II USM, KOOD ND 16 SB270 82mm

Andy Wilson setting up the shot, andy210966@hotmail.co.uk

Llanwryst Falls - ISO 100 f2.8 35mm 0,8sec

• ND400 9 stops
• ND16 4 Stops
• ND8 3 Stops
• ND4 2 Stops

KOOD JAPANESE MANUFACTURED 
PRO QUALITY ND FILTERS

KOOD BRAND PRODUCTS ARE EXPORTED WORLDWIDE

CAN BE ORDERED FROM ANY INDEPENDENT RETAILER

K O O D
KOOD International Limited, Unit 6, Wellington Road, London Colney AL2 1EY  

Tel: 01727 823812   Fax: 01727 823336   

E-mail: info@koodinternational.com / koodinternational@gmail.com

www.koodinternational.com

KOOD Japanese ND filters are accurate, neutral, and 
are made with optically ground glass so as to maintain 
the definition capability of today’s high pixel count  DSLR
sensors. These pure ND filters are not the cheapest – but 
they are the best

• ND 400 9 stops is available in 52, 58, 62, 67, 72, 
77 and Cokin/ KOOD P Size

• ND 16 4 Stops is available in 46, 52, 55, 58, 62, 
67, 72, 77 and Cokin/ KOOD  P Size

• ND 8 3 Stop is available in all sizes 37mm  - 86mm

• ND 4 2 Stop is available in all sizes between 27mm - 72mm

Variable ND filters use two polarizing elements, that effect 
the result and confuse camera metering systems. Far better to
use straight ND filters for the best result and correct exposure

The pictures in this ad were shot by Andy Wilson using the ND 16 4 stop filter



  Upgrading - we want your old cameras and photographic equipment! 

  • EXPERIENCED KNOWLEDGEABLE STAFF  

 • TOP PRICES PAID  • FILM OR DIGITAL EQUIPMENT CONSIDERED 

• QUALITY EQUIPMENT BOUGHT OUTRIGHT!
Ask us today and see how much your old equipment is worth - it may be worth more than you think!

PART EXCHANGE WELCOME

VISIT YOUR LOCAL LCE FOR       

londoncameraexchange

FUJIFILM X-PRO2
BODY ONLY

Delivering a new level of 
X Series photo quality by 
combining the brand new 
X-Trans CMOS III sensor and 
X-Processor Pro engine.

£1349.99

FUJIFILM X-T2
& XF 18-55MM LENS

In its compact, lightweight 
and robust body, the 
FUJIFILM X-T2 delivers 
everything you need.

£1649.99

PANASONIC G80
& 12-60MM LENS

Packs state-of-the-art
4K Photo capabilities and
the latest Dual Image
Stabilisation technology in
a weather-sealed kit.

£799.99

PANASOINC GH5
ODY ONLY

K/60P video recording 
upport a professional 

workflow. 6K PHOTO lets you 
onfidently capture moments 
therwise left to chance.

£1699.00 

£100
TRADE-IN

BONUS

£100
TRADE-IN

BONUS

FUJIFILM X-T20
& XF 18-55MM LENS

Turn the dials. Look through 
he viewfinder. Shoot in 
tunning colors. Capture the 

moment...

£1099.00 

FUJIFILM X-A10
& XC 16-50MM OIS II LENS

Combines a 16 megapixel 
sensor with the X Series’ 
signature skintone 
reproduction technology. 

£399.99 

OLYMPUS OMD EM1 II
BODY ONLY

An advanced system of 
innovative technology 
and features designed to 
forever change the power of 
photography.  

£1849.99 

LYMPUS OMD EM10 II
 4-150MM MKII LENS

 camera that fits your 
cerning style and is the 
rfect companion to take 
erywhere you go.

£699.99  



UK MAIL ORDER Next day delivery available from all LCE branches. Postage & Insurance £4.99 for most items.

E. & O. E. Prices quoted include VAT @ 20%. Prices subject to change. Goods subject to availability.BRANCHES NATIONWIDE

BATH

01225 462234

BRISTOL (BALDWIN ST)

0117 929 1935

BRISTOL (BROADMEAD) 

0117 927 6185

CHELTENHAM 

01242 519 851

CHICHESTER  

01243 531536

CHESTER

01244 326531

COLCHESTER 

01206 573444

DERBY

01332 348644

EXETER

01392 279024

GLOUCESTER

01452 304513

GUILDFORD

01483 504040

HEREFORD   

01432 272655

LEAMINGTON

01926 886166

LINCOLN (HIGH ST) 

01522 528577

LINCOLN (SILVER ST) 

01522 514131

LONDON (STRAND)

0207 3790200

MANCHESTER 

0161 834 7500

NEWCASTLE  

0191 213 0060

NORWICH  

01603 612537

NOTTINGHAM

0115 941 7486

PLYMOUTH

01752 664894

PORTSMOUTH

023 9283 9933

READING

0118 9592149

SALISBURY

01722 335436

SOUTHAMPTON (CIVIC CTR)  

023 8033 1720

SOUTHAMPTON (HIGH ST)

023 8022 1597

TAUNTON  

01823 259955

WINCHESTER 

01962 866203

WORCESTER 

01905 22314

OPENING TIMES:

Monday—Saturday  

9am —5:30pm

SEARCH OUR USED EQUIPMENT AT:

 THE LATEST CAMERA OFFERS

www.LCEgroup.co.uk

SONY A6300
ODY ONLY

An APS-C mirrorless camera 
that takes autofocusing 
and imaging speed and 
performance to astonishing 
new heights.

£829.99  

SONY A6000
E16-50MM PZ OSS &

Add an OLED Tru-Finder™, 
manual controls and a range 
of lenses, for a superior 
alternative to bulky DSLRs.

£549.99  

SONY A9
BODY ONLY

True potential can only soar 
when free
A dream meets technology, 
and a new camera is born
Now the future is yours

£4499.99  

SONY A7S MKII
BODY ONLY

Meet the A7S II  with ultra-
high sensitivity, wide dynamic 
range, internal 4K movie 
recording and superior 
shooting stability.

£2499.99
£250

TRADE-IN

BONUS

NEW 
MODEL

NIKON D7200
BODY ONLY

Step up to excellence.
This nimble DX-format 
D-SLR delivers sumptuous 
stills, excels at video, and is 
fully connected.

£844.99

NIKON D7500
BODY ONLY

Powerful, nimble, and fully
connected D7500. Catch the
beauty you find with flagship
DX image quality inherited
from Nikon’s D500.

£1299.99

IKON D500
ODY ONLY

s the smaller sibling to 
e D5, Nikon’s FX-format 

agship, the D500 offers 
henomenal power and 
recision.

£1729.99
NEW 
MODEL

NIKON D5300
& 18-55MM F/3.5-5.6 VR AF-P

This impressive 
24.2-megapixel DX-format 
camera lets you capture and 
share the magic of your world 
in incredible detail.

£529.99
£65

TRADE-IN

BONUS



Tel: 01803 852400
Email - info@mifsuds.com
www.mifsuds.com

Mifsuds Photographic Limited
27-29, Bolton Street, Brixham. Devon. TQ5 9BZ.

PHONE LINES OPEN  

MON -FRI 8am - 5pm, 
SAT 9am - 3pm, 

SUN CLOSED.
SHOP OPEN

MON -FRI 10am - 5pm, 
SAT 9am - 3pm. SUN CLOSED.

U.K. Stock
No Grey Imports

MORE ON WEBSITE - UPDATED DAILY. FREE U.K. MAINLAND DELIVERY FOR ITEMS OVER £100 VALUE. ALL U.K. STOCK, NO GREY IMPORTS.

Family Run Pro Dealership With Friendly, Knowledgeable Staff. Prices Inc VAT - Correct 26/05/2017. E&OE.

PART-EXCHANGE WELCOME
WE PART EXCHANGE, BUY FOR CASH OR COMMISSION SALE
FAIR PRICES OFFERED ~ QUOTED QUICKLY ~ COLLECTION CAN BE ARRANGED

For speediest response please email your equipment details to... info@mifsuds.com

For cameras, lenses and accessories from a range of brands please see our website...

www.mifsuds.com
For all the latest prices on new and used 

items, plus current cashbacks and 

promotions, visit our website NOW!

EOS 5D
MKIV Body

REAL
DEAL
PRICE £3197

200-400mm

f4 L IS USM

REAL
DEAL
PRICE £9777

300mm f2.8

LII IS USM

REAL
DEAL
PRICE £5597

400mm f2.8 LII IS USM

REAL
DEAL
PRICE £9888

500mm f4 LII IS USM

REAL
DEAL
PRICE £7999

600mm f4 LII IS USM

REAL
DEAL
PRICE £11348

REAL Deals From A REAL Camera Shop



FUJI DIGITAL USED
X Pro2 body box..................£1099
X T1 body black...................... £499
X T1 body black...................... £449
X T10 body box ...................... £299
X E1 body black box............. £199
10 24 F4 OIS box.................... £649
16 F1.4 XF box ........................ £599
16 55 F2.8 WR M box.......... £729
18 F2 WR................................... £299
18 55 F2.8/4 XF ...................... £399
35 F1.4 R box........................... £399
55 200 F3.5/4.8 R box .......... £499
56 F1.2 R .................................. £599
60 F2.4 macro box................. £429
1.4x WR converter M box.. £239
X T1 battery grip.......................£89
EF42 flash box......................... £129
MINOLTA/SONY DIGITAL USED

Sony H400 .................................. £169
Sony RX100 MKIII box............ £449
Sony A7R II body box...........£1999
Sony A7 II body ........................ £999
Sony VG B30AM..........................£69
Sony VG C70AM....................... £139

Sony VG CE2.............................. £179
Sony VG C77M.......................... £149
Sony HV56AM........................... £169
Sony LA EA4 mount adap ... £189
SONY NEX USED
A6000 body................................... £329
NEX 5 body.................................... £129
FE 16 35 F4 ZA OSS E................ £999
FE 16 50 F3.5/5.6 EZ.................. £149
FE 24 70 F4 ZA OSS box.......... £699
FE 28 70 F3.5/5.6 OSS............... £299
FE 70 200 F4 G OSS box.......... £999
FE 90 F2.8 macro......................... £799
Samyang 100 F2.8 macro....... £229
MINOLTA/SONY AF USED
7xi body .......................................£49
7000i body..................................£39
600Si body ..................................£69
300Si body ..................................£19
24 50 F4 .......................................£99
24 85 F3.5/4.5 ......................... £149
28 F2.8 ..........................................£99
28 80 F4/5.6................................£39
28 85 F3.5/4.5 ............................£99
35 70 F4 .......................................£39

35 70 F3.5/4.5..................................£25
35 80 f4/5.6.......................................£25
35 105 F3.5/4.5 ...............................£99
50 F1.7 AF..........................................£89
70 210 F3.5/4.5 ...............................£99
75 300 F4.5/5.6 ...............................£99
85 F1.4 G box................................ £649
100 300 F4.5/5.6 APO............... £179
100 300 F4.5/5.6.......................... £149
VC700 grip.........................................£39
RC1000S cord...................................£29
SONY LENSES USED
16 80 F3.5/4.5 ZA DT................. £499
18 55 F3.5/5.6 SAM.......................£59
18 200 F3.5/6.3 DT ..................... £199
55 200 F4/5.6 DT SSM .................£69
75 300 F4/5.6................................ £129
SIGMA MIN/SONY AF USED
10 20 F3.5 EX............................. £259
18 35 F1.8 Art............................ £549
28 135 F3.8/5.6............................£79
28 300 F3.5/6.3 macro........... £149
50 F1.4.......................................... £149
50 F2.8 EX DG macro ............. £149
55 200 F4/5.6 ...............................£69

70 300 F4/5.6 DG OS............ £169
70 300 F4/5.6 APO DG............£99
135 400 F4.5/5.6 .................... £299
1.4x EX conv ...............................£99
TAM 10 24 F3.5/4.5 DiII ....... £239
TAM 90 F2.8 .................... £179/249
Teleplus 1.4x conv....................£69
Teleplus 2x conv .......................£79
Kenko 1.4x Pro 300DG......... £149
MINOLTA FLASH USED
Minolta 5200i.............................£29
Minolta 5400HS.........................£39
Minolta 5600HSD M ...............£99
OLYMPUS 4/3 USED
E3 body ..................................... £299
E510 body ................................ £149
7 14 F4 ED................................ £499
9 F8 Fisheye................................£79
11 22 F2.8/3.5 ......................... £349
14 42 F3.5/5.6 ............................£49
14 45 F3.5/5.6 ............................£79
14 50 F3.8/5.6 ......................... £199
35 F3.5 ..........................................£99
50 F2 mac................................. £349
90 250 F2.9 ............................£1799

EC 14 converter ........................£19
EC 20 converter ..................... £199
25mm ext tube..........................£99
HLD 4 grip...................................£99
VA 1 angle finder......................£99
SIGMA 4/3 USED
50 500 F4/6.3 EX DG HSM.. £399
OLYMPUS MICRO 4/3 USED
Stylus 1F.................................... £299
OMD EM1 body M box ...... £599
OMD E M5 MKII b/o box..... £499
OMD E M5 body box............ £249
OMD EM10 body blk............ £249
OMD EM10 body silv ........... £249
E10 body................................... £279
E P5 body silver......................£ASK
12 F2........................................... £479
12 40 F2.8 Pro......................... £649
12 50 F3.5/6.3 ......................... £149
14 42 F3.5/5.6 ......................... £169
17 F2.8........£159 25 F1.8..... £269
45 F1.8 box .............................. £199
40 150 F2.8 Pro ...................... £949
HLD 8 grip................................ £149
HLD 7 grip box....................... £119

HLD 6 grip...................................£99
PANASONIC DIGITAL USED
GH2 body ................................. £299
G6 body black......................... £299
G3 body box............................ £199
GX80 body ............................... £369
GX7 body.................................. £399
GF7 body silver box.............. £199
GF3 body black .........................£99
GF1 body .....................................£79
GM1 body silver..................... £299
12 35 F2.8................................. £549
14 F2.5 ....................................... £199
14 42 F3.5/5.6 ......................... £199
14 42 F3.5/5.6 ............................£79
14 45 F3.5/5.6 ......................... £149
20 F1.7 ....................................... £199
35 100 F4/5.6 .......................... £199
45 200 F4/4.5 box ................. £199
100 300 F4/5.6........................ £349
FL360L flash............................. £139
FZ200 Bridge camera box .. £249
FZ72 Bridge camera box..... £199

DIGITAL USED Why not register to receive our email newsletters? Simply send your email address to info@mifsuds.com to enrol

£1099

Used Fuji
X-Pro2
body
box

£249

Used Olympus
OM-D E-M10
body blk or
silv each

£1999

Used Sony
A7R II
body box

Although we are the best stocked dealer in the West Country,  
we cannot always have every item listed in stock at all times, so 
we are happy to reserve new & used items for customers 
planning to visit. Prices correct 26/05/2017 but subject to 
change without notice. See website for up to date prices. E&OE.

ITEM YOU REQUIRE NOT LISTED? PLEASE GIVE US DETAILS OF WHAT YOU ARE LOOKING FOR AND WE WILL CONTACT YOU WHEN THAT ITEM BECOMES AVAILABLE.
Mail order used items sold on 10 day approval. Return in ‘as received’ condition for refund if not satisfied (postage not included - mail order only). E&OE.

QUALITY USED EQUIPMENT. See website for full list. Call us to check condition. 6 Month warranty on most secondhand.

Website altered daily inc. manufacturers cashback & promotions 

www.mifsuds.com
Subscribe to our newsletter -  send your email address to info@mifsuds.com.

CANON DIGITAL AF USED
1DX body box........... £1999/2799
1D MKIV body......................... £999
1D MKIII body ......................... £499
7D MKII body box.................. £899
7D body box............................ £499
6D body ..................................£1099
5DsR body box .....................£2299
5Ds body box ........................£2199
5D MKII body ..............................£799
5D MKI body box ......................£399
70D body box .............................£499
60D body box .............................£399
50D body box .............................£299
20D body box ................................£99
1000D body .................................£139
BG E2...........£39  BG E2N ............£49
BG E4 box ........................................£69  
BG E5..........£49 BG E7...............£79
BG E8.................................................£69

BG E11 box ..................................£169
BG E16 box ..................................£169
Powershot G5X ..........................£449
Powershot G3X ..........................£529
EOS M3 + 18-55.........................£329
EOS M body....................................£99
EVF-DC1 viewfinder.................£149
CANON AF FILM BODIES USED

EOS 3 body M- box ............... £299
EOS 1n HS body ..................... £199
EOS 30/5 body each ................£69
EOS 650 body ............................£39
EOS 600 body ............................£39
EOS 50E body.............................£29
EOS 500N/1000 body each ...£29
PB E2 drive M  box................ £199
PB E2 drive fits EOS1/3 ........ £149 
CANON AF LENSES USED
10 22 F3.5/4.5 USM............... £329
14 F2.8 USM LII box ............£1499

16 35 F2.8 USM LII................. £899
16 35 F4 L IS U M box......... £749
17-40 F4 L................................. £499
17-85 F4/5.6............................. £199
18-55 F3.5/5.6 IS .............................£99
18-135 F3.5/5.6 IS USM............ £349
20 F2.8 USM................................... £349
24 F3.5 TSE MKI box ................... £699
24-70 F2.8 L USM box ............... £799
24-85 F3.5/4.5 USM .................... £149
24-105 F4 L ..................................... £599
28-80 F3.5/5.6 ............................£79
28-90 F3.5/5.6 ............................£79
28 135 F3.5/5.6 IS USM ....... £199
40 F2.8 STM ............................. £139
50 F1.2 L .................................... £899
50 F1.4 USM ............................. £249
50 F1.8 MKII ................................£69
55 250 F4/5.6 EFS.................. £149
60 F2.8 USM EFS mac........... £249

65 F2.8 MP E............................ £849
70 200 F2.8 IS USM LII .......£1499
70-200 F2.8 IS USM LI........... £999
70-200 F2.8 USM L ................ £799
70-300 F4.5/5.6 DO IS U...... £399
70-300 F4.5/5.6 IS USM ....... £249
75-300 F4/5.6 MKII ...................£99
85 F1.2 L USM ......................... £899
85 F1.8 M- ................................. £269
100 F2.8 USM box.................. £339
100-400 F4.5/5.6 L IS U ........ £899
135 F2 L USM box.................... £779
300 F2.8 LII IS U ......................£4999
300 F2.8 LI IS U........................£2999
300 F4 L IS USM box ............... £799
1.4x extender MKII box........ £249
2x extender MKII box ............. £239
Teleplus 1.5x conv ....................£79
Teleplus 2x DG conv................£89
Kenko ext tube set DG................£79

SIGMA CAF USED
10 20 F4/5.6 HSM box.............. £219
17-50 F2.8 OS DC box............... £249
17-70 F2.8/4 DC OS.................... £249
18-125 F3.8/5.6 OS DC ............. £149
18-200 F3.5/6.3 DC..................... £149
24-70 F2.8 HSM............................ £469
28-105 F2.8/4 ...................................£69
28-135 F3.8/5.6 ...............................£99
28-200 F3.5/5.6 Asph ..............£99
50 F1.4 DG Art ........................ £499
50 F2.8 EX macro ................... £149
50-500 F4/6.3 EX DG OS...... £699
50 500 F4/6.3 EX DG ............ £399
70 300 F4/5.6 APO DG ............£99
120 300 F2.8 EX DG .............. £799
120 400 F4/5.6 DG ................ £399
150 F2.8 EX DG OS mac ........... £549
150 500 F5/6.3 DG OS.............. £449
180 F3.5 EX DG HSM mac....... £399

1.4x EX DG converter................ £149
Kenko Pro 300 DG 1.4x conv....£99
Kenko Pro 300 1.4x conv............£99
Kenko ext tubes..............................£79
OTHER CAF USED
TAM 16-300 F3.5/6.3 DiII VC £329
TAM 18-200 F3.5/6.3 VC ...... £149
TAM 18-250 F3.5/6.3 DiII ..... £149
TAM 18-270 F3.5/6.3 VCII .... £169
TAM 28-75 F2.8 XR Di ........... £199
TAM 70-300 F4/5.6 ........................£99
TAM 200-500 F5/6.3 ................... £449
TOK 100 F2.8 ATX ........................ £299
Zeiss 50 F1.4 ZE box .................. £599
CANON FLASH USED
ST E2 transmitter ......................£79
MR 14EX ringflash ................. £299
430EXII......£169   550EX ....... £149  
580EX box ................................ £179 
580EX MKII ............................... £299

CANON USED Buy with confidence - all of our used equipment is thoroughly tested and cleaned before being offered for sale

Used Canon
EOS 7D
MKII

body
 box

£899

£1999/2799

Used Canon
 EOS 1DX
 MKI body 
 box

NIKON DIGITAL AF USED
D4s body box........................£3499
D4 body box..........................£2199
D3X body box.......................£1649
D3s body box........................£1699
D3 body box.................£999/1199
D2xs body box........................ £399
D810 body box .....................£1799
D800 body box .....................£1399
D700 body box .............. £499/599
D610 body box ....................... £899
D300s body ............................. £349
D300 body box ....................... £299
D200 body box ....................... £149
D7000 body ............................. £399
D5200 body ............................. £299
D5000 body box .................... £199
D3100 body ............................. £169
D100 body ..................................£99
D90 body .................................. £199
D60 body .................................. £149
D50 body .....................................£79  

D40X b/o .....................................£99
MBD 15 grip ............................ £149
MBD-14 grip ............................ £149
MBD-12 grip ............................ £279
MBD-10 grip M- box............. £129
MBD-10 grip ...............................£79
MBD-80 grip ...............................£49
MBD-200 grip .............................£49
NIKON AF FILM BODIES USED

F5 body ..................................... £399
F4E body inc MB-23 .............. £399
F60 body ......................................£49
F801 body ............................ £29/59
F601 body ...................................£29
NIKON AF LENSES USED
10.5 F2.8 DX ..................................£429
10-24 F3.5/4.5 DX .......................£599
14-24 F2.8 AFS M- box..........£1099
14-24 F2.8 AFS box ....................£999
16-35 F4 VR box ..........................£749
16-85 F3.5/5.6 AFS VR ...............£399
17-55 F2.8 AFS .............................£499

18 35 F3.5/4.5 AFD ....................£299
18 55 F3.5/5.6 AFS VR................£99
18-70 F3.5/4.5 AFS .....................£129
18-105 F3.5/5.6 AFS VR............£179
18-200 F3.5/5.6 AFS VRI...........£299
18-300 F3.5/5.6 VR .....................£649
28 F1.8 AFS G................................£399
24-70 F2.8 AFS box ....................£999
24-85 F3.5/4.5 VR ........................ £329
24-120 F3.5/5.6 G VR ................. £299
28 F1.8 AFS G ................................ £449
28-100 F3.5/5.6 AF G ....................£69
28-300 F3.5/5.6 VR ...................... £599
35 F1.8 DX ....................................... £149
35 F2 AFD ....................................... £199
40 f2.8 AFS Micro ................... £169
45 F2.8 DN PC-E ...................£1099
50 F1.8 AFS box ...................... £149
50 F1.8 AFD.................................£99
55-200 F4/5.6 VR AFS........... £149
60 F2.8 AFS .............................. £399
60 F2.8 AF ................................. £199

70 200 F2.8 AFS VRII...........£1349
70 200 F4 AFS VR................... £899
70-300 F4/5.6 VR.................... £369
70-300 F4/5.6 AFD ................ £129
70-300 F4/5.6 G non VR..........£99
80-400 F3.5/5.6 AFS VR......£1399
85 F1.4 AFS M- box ............... £999
85 F1.8 AFD.............................. £249
85 F2.8 DN PC-E ...................£1099
105 F2.8 AFS VR ...................... £579
180 F2.8 AFD M- box ............ £449
200-400 F4 AFS VRII ............£3699
300 F2.8 AFS VRII box.........£4199
300 F2.8 AFS VRI ..................£2999
300 F4 AFS E PF ....................£1299
300 F4 AFS box ....................... £549
400 F2.8 AFS E FL VR 
M- box .....................................£8299
400 F2.8 AFS non VR...........£3999
600 F4 AFS VR .......................£5499
600 F4 AFS II non VR 
serviced ...................................£3999

TC17EII....................................... £249
TC20EIII M box ...................... £329
TC20EII....................................... £199
SIGMA NAF USED
24-35 F2 DG Art box .................£599
24-70 F2.8 EX DG........................£299
24-105 F4 DG OS HSM.............£499
28-200 F3.5/5.6 early...................£69
35 F1.4 DG Art ..............................£499
50-500 F4/6.3 DG .......... £399/499
70-200 F2.8 EX DG................. £399
70-300 F4/5.6 APO DG ............£99
105 F2.8 EX DG ............................. £199
150-500 F5/6.3 DG OS .............. £499
150-600 F5/6.3 DG OS cont ... £749
150-600 F5/6.3 DG OS 
Sport box ......................................£1079
170-500 F5/6.3 D ......................... £299
TC-1401 1.4x converter............ £179
1.4x converter EX DG ................ £149
2x EX DG converter .................... £149
2x EX converter ...............................£99

TAMRON NAF USED
10 24 F3.5/4.5 DiII....................... £239
11-18 F4.5/5.6............................... £219
18-250 F3.5/6.3 ............................ £149
19-35 F3.5/4.5..................................£99
28-300 F3.5/6.3 XR Di................ £149
70-300 F4/5.6 ...................................£79
OTHER NAF USED
TOK 10-17 F3.5/4.5 ATX ....... £249
TOK 12-24 F4 ATX Pro .......... £329
FLASH / ACCESSORIES USED
SB-24...........£49   SB-25 ...................£49  
SB-28...........£69   SB-80DX ...........£79
SB-600............................................... £169   
SB-800............................................... £149
SB-900............................................... £249
SB-R1 kit M- box .......................... £399
SD-8A batt pack..............................£89
DR-3 angle finder ...........................£59
MB-10 (fits F90) ...............................£29
MB-23 (fits F4) ..................................£69
MC-30 remote .................................£39

NIKON USED We carry out sensor cleaning on the premises, firmware updating and equipment hire - please enquire for details

£3499

Used Nikon
 D4s  body 
 box

£999/1199

Used Nikon
 D3  body 
 box

£1399

Used Nikon
 D800  body 
 box

BRONICA ETRS 645 USED
75 F2.8 PE ................................. £149
105 F3.5........................................£99
135 f4 PE................................... £249
150 F3.5 E ....................................£99
150 F3.5 PE M- Box................ £149
200 F4.5 PE............................... £199
E14 Ext tube ...............................£49
E42 Ext tube ...............................£49
120 RFH ........................................£69
Polaroid Back .............................£39 
Plain prism ..................................£59
Rotary prism ...............................£99
Winder early ...............................£79  
Speed Grip E ...............................£39
Tripod adapter E .......................£39
Winder early ...............................£49
Metz SCA 386 .............................£49
BRONICA SQ 6x6 USED
SQA + 80 F2.8 S + WLF 
+ 120 RFH box ........................ £399
40 F4 S ....................................... £299  
50 F3.5 PS ................................. £299
50 F3.5 S.................................... £149

110 F4.5 PS macro................. £399
135 F4 PS M ............................ £229
150 F4 PS ......................... £149/199
180 F4.5 PS............................... £399
200 F4.5 PS M- box ............... £199
2x PS converter M-................ £179
135N 35mm film back ......... £119
SQAi 120 RFH .............................£79
SQAi prism late ....................... £299
45° Prism box .......................... £129
Plain Prism S Boxed .................£69       
AE Prism Early ............................£79 
ME Prism Finder ........................£69 
Metz SCA 386 .............................£49
Pro shade S .................................£59
Lens Hood 65-80.......................£20 
SQAi Motorwinder ................ £149
Speed grip S ...............................£79
SQAI winder ............................. £149
HASSELBLAD 6x6 USED
501CM chrome 
+ 80 F2.8 CB + A12 ..............£1699
501C + 80 CB + A12............£1399
45 degree prism late ............ £299

45 degree prism early.............£99
Sports viewfinder .....................£69
Chimney.......................................£89
A16 (6x4.5 120 back) chr .... £199
A12 chrome latest................. £299
A12 late blk/chr...................... £129
Polaroid back 100.....................£79
50 F4 CF FLE ............................ £849
150 F4 chrome serviced ...... £199
Ext tube 21, 55 each ................£39
Vivitar 2x conv ...........................£49
Lens hoods various ........... £20/50
MAMIYA 645 MF USED
Plain prism (645 Super) ..........£39
Polariod Back HP401 ...............£29
Polaroid back .............................£29
120 Insert.....................................£20 
HA401 120 RFH Box .................£49
120 Back .......................................£39  
Winder ..........................................£79
45 F2.8 N ................................... £199
150 F2.8 A ................................. £199
150 F3.5 N ...................................£79
150 F3.8 NL leaf...................... £299

210 F4 N M ................................£79
Ext Tube 1....................................£29
ext tube 2 ....................................£29
Ext tube 3S..................................£29
Teleplus 2x converter..............£49
Vivitar 2x converter..................£39
MAMIYA TLR 6x6 USED
C330F body + WLF ................ £199
65 F3.5 box late ...................... £199
65 F3.5 serviced...................... £149
80 F2.8 late serviced ............. £139
180 F4.5 ..................................... £149
250 f4.5 late serviced............ £249
250 f4.5 early serviced ......... £179
Porrofinder ..................................£59
MAMIYA 6 & 7 RF 6x7 USED
50 F4.5 L + VF .......................... £699
80 F4.5 L M  box..................... £699
150 F4.5 M  .............................. £399
MAMIYA RB 6x7 USED
Pro SD  + 90 KL
+ WLF + back .......................... £549 
Pro S + 90 + WLF + back..... £399
Pro S body................................ £149

Pro S body scruffy ....................£99
Plain prism late....................... £199
WLF. ...............................................£79
120 645V back ...........................£99
90 F3.5 KL ................................. £299
127 F3.5 KL............................... £299
180 F4.5............................................ £149
Pro SD ext tube 2 82mm ............£99
Pro SD ext tube 1 45mm ............£99
Ext tube 2 ...........................................£49
MAMIYA RZ 6x7 USED
RZ Pro body ............................. £149
120 RFH Pro ................................£99
Polaroid back .............................£79
FE701 prism ............................. £299
WLF ................................................£79  
Winder II .......................................£69
65 F4 box M  ........................... £399
90 F3.5 W M  box ................... £299
180 F4.5 W ................................ £199
Pro shade .....................................£49
PENTAX 645MF USED
645 + 75 F2.8........................... £249
645 body + insert .................. £199

200 F4 ........................................ £149  
300 F4 ........................................ £249
1.4x converter......................... £199
PENTAX 645AF USED
AF500FTZ flash..........................£79
PENTAX 67 USED
6x7 body + prism ................... £599
45 F4 latest M- ........................ £499
45 F4 ........................................... £399
135 F4 macro late .................. £249
165 F2.8 latest M- .................. £499
200 F4 latest ............................ £169
200 F4 early ...................................£99
300 F4 early scruffy ................... £99
Pentax rear conv 1.4x ........... £249
2x rear converter .................... £179
Auto ext tubes ...........................£49
Vivitar 2x conv ...........................£49
Wooden grip ........................... £169
ROLLEI 6x6 TLR USED
3.5F White Face serviced ...£1699
3.5F Planar ..............................£1399
2.8E ............................................. £797
Automat K4B ........................... £599

MEDIUM FORMAT  6x45, 6x6, 6x7 & 6x9 USED

£1699

Used Hasselblad
 501CM chr

 + 80 F2.8
 CB + A12

For more used equipment listings please see website www.mifsuds.com

£549

Used Mamiya
 RB67 Pro SD +
 90 KL + WLF
 + Back

£1699

Used Rollei

 3.5F 6x6
 White Face 
 serviced

CANON FD USED
A1 body serviced................... £199
AE1 Program body...................£99
24 F2........................................... £299
28 F2.8 ..........................................£49
35-70 F3.5/4.5 ............................£59
35-70 F4 .......................................£69
35-105 F3.5 .............................. £149
50 F1.4 ..........................................£99   
50 F1.8 ..........................................£49   
50 F2 ..............................................£49
50 F3.5 macro ............................£99
70-150 F4.5 .................................£29
75-200 F4.5 .................................£49
85 F1.8 ....................................... £199
100 F2.8 ..................................... £149
100-300 F5.6 ...............................£79
135 F3.5 ........................................£49
135 F3.5 (Breechlock)..............£39
200 F4 ...........................................£69
2x Extender B .............................£49

25mm or 50mm ext tube ea £29
177A flash....................................£20
199A flash....................................£39
244T flash......£20 277T flash £25
300TL flash..................................£49
Winder A.......£20 Winder B..£30
Angle finder B............................£59
CONTAX 35mm RF USED
90 F2.8 G ................................... £299 
CONTAX 35mm USED
28-70 F3.5/4.5 MM ................ £169 
HASSELBLAD XPAN USED

Centre filter 49mm ........................£129
LEICA M USED
IIIf Red Dial ST serviced 
chrome body........................... £479
LEICA SLR USED
R8 body black box................. £499
LEICA OPTICS USED
Televid APO 77 body only ...... £549
Televid 77 + 20x60 ................ £649

Trinovid 10x42........................ £599
Ultravid 8x32 HD ................... £849
LIGHTMETERS USED
Sekonic L308 BII ........................£99
Sekonic L408........................... £149
MINOLTA MD USED
XD7 body black...................... £199
X300 chrome body ..................£49
X300s black body .....................£49
X700 black body .......................£69
XGM chrome body ...................£49
28 F3.5 MD ..................................£39
50 F1.7 MD ..................................£49  
50 F2 MD .....................................£49
70-210 F4 MD.............................£99
2x Converter ...............................£79
Ext tube for 50 F3.5..................£29
Ext tube set .................................£49
Auto bellows 1...........................£99
NIKON MF USED
FE2 body chrome .................. £349

F3 body ..................................... £199
F2 Photomic body box........ £399
FM2 body chrome box ........ £399
FM2n body chr box............... £299
FM2n body chr ....................... £249
FE body chrome........................£99
20 F3.5 AI.................................. £199
24 F2.8 AIS M- box ................ £249
24 F2.8 AI. ................................. £199
28 F2.8 E box ..............................£69
28-85 F3.5/4.5 AIS.................. £199
35 F2 AI box ............................. £249
35 F2.8 AIS................................ £149
35 F2.8 PC ................................. £349
35-70 F3.3/4.5 AIS.................. £129
35-70 F3.5 AIS ............................£99
35-105 F3.5/4.5 AIS ..................£79
50 F1.4 AI .................................. £199  
50 F1.8 E .......................................£59
55 F2.8 AIS................................ £199
180 F2.8 AIS ED scruffy ........ £179

500 F4 AIS...............................£1399
600 F5.6...................................£1499
TC200............................................£49
SC-17 TTL lead...........................£25
DW-3 WLF find fit F3 ...............£99
DW-21 fits F4........................... £149
OLYMPUS OM USED
OM-4T body ............................ £249
OM-1n body chrome............ £249
OM-2SP body .............................£99
OM-2n body blk or chr ........ £149
24 F2.8 ....................................... £199   
28 F3.5 ..........................................£49
35-70 F4 .......................................£79
35-105 F3.5/4.5 ..........................£79
300 F4.5 ..................................... £199
7, 14, 25 man ext tube ea ......£20
14 or 25 auto ext tube ea ......£29
PENTAX 35mm AF USED
16-45 F4 .................................... £199
17-70 F4 SDM M- box .......... £299

18 55 F3.5/5.6 ............................£69
28 80 F3.5/5.6 ............................£49
50 F1.4 AF................................. £149
50-135 F2.8 SDM.................... £379
55-300 F4/5.8 ED WR............ £229
55-300 F4/5.8 ED box ........... £199
70 F2.8 Limited ....................... £349
SIGMA PKAF USED
18-250 F3.5/6.3 ....................... £199
PENTAX MF USED
LX + prism serviced .............. £299
50 F1.4 PK ....................................£99
50 F4 macro PK..........................£99
50 F2 ..............................................£49
STUDIO LIGHTING USED
Bowens Esprit 1000 twin 
head kit ..................................... £449
TAMRON ADII USED
28 F2.5 ..........................................£49   
35-135 F3.5/4.2 ..........................£99
90 F2.5 SP ................................. £149

35MM & MISCELLANEOUS  USED Please contact us to determine availability before making a lengthy journey

£499

Used Lighting
 Bowens Esprit
 1000 twin
 head kit

£1399

Used Nikon
 500mm F4 AIS

MORE ON WEBSITE
WWW.MIFSUDS.COM



Finance example: 12mths, 0% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £110.62, Total Amount Payable £1475. • 24mths, 9.9% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £60.93, Total Amount Payable £1608.82
36mths, 19.5% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £47.95, Total Amount Payable £1873.70 See website for details: www.uttings.co.uk/Information/Finance. Finance is subject to status, terms & conditions apply.*

*Consumer credit service provided by DEKO in association with Close Brothers Retail Finance. DEKO is licensed by the Financial Conduct Authority (Consumer Credit Licence: 0616240) Finance provided by Close Brothers Retail Finance is a trading name of Close Brothers Limited10 Crown Place, London EC2A 4FT.
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See website for Remotes, Batteries &   Chargers

See website for more lenses

See our website for full details & specifications



NEW
FB Mono Gloss 
Baryta 320

Bring the beauty of the
darkroom into the digital world
with FB Mono Gloss Baryta 320, 
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£14.95

www.permajet.com
01789 739200
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www.cameraclean.co.uk � Telephone 01793 855663

Just Ltd. The Old Shop, Hook, Swindon SN4 8EA ( www.cameraclean.co.uk ( sales@cameraclean.co.uk ( Tel 01793 855663 E&OE

easyCover Glass Screen ProtectorseasyCover Lens Bags
Made from water-resistant nylon with extra
padding inside to safeguard your lens from
dust and moisture.

easyCover Lens Rim
Designed to protect your lens while using it.
Functional in all situations, your lens will be
protected against bumps and scratches.
The Lens Bumper is manufactured per diameter
size: 52,58, 62, 67, 72 and 77mm.  
Available in black / red / yellow / camouflage

Easy on... Easy off
easyCover camera protection
when you need it.

2 ���� �%+�'  ( &'�� ( %$ #%*"���
in silicone and includes a
separate LCD protector.

2 �%+�'( �'� �+� "��"�
in black, camouflage,
red (Canon) and
yellow (Nikon).

easyCover glass LCD protectors,
protect against scratches, dust 
and dirt.

They are touchscreen
compatible and easy to fit.

HUNDREDS OF PLACES WHERE YOU
CAN SELL YOUR PHOTOS FOR CASH!

OUT NOW! The latest edition of 
The Freelance Photographer’s
Market Handbook

Described as the photographer’s bible, this
208-page BFP Handbook has hundreds of
markets where you can sell your pictures for
£££s. It includes magazines, greetings card
and calendar publishers, picture libraries,
newspapers, book publishers etc.

The Freelance Photographer’s Market
Handbook gives full details of the type of
photos – subject matter etc – being sought,
fees paid, and exactly where to send your
pictures.

Price: £15.95 + £2.00 P&P

SPECIAL OFFER: Join the Bureau of
Freelance Photographers (BFP) and
get 14 months membership for the
price of 12!

For almost 50 years, the BFP has been helping
photographers like you to sell their photos.

As well as getting the 208-page Freelance
Photographer’s Market Handbook with
hundreds of markets for photos, you’ll also
receive our monthly Market Newsletter keeping
you up to date with current picture needs.

You may also take advantage of our Advisory
Service offering personal help on any aspect of
selling photos.

All for just £54 per annum. Join now and get
14 months membership for the price of 12!

NEW! The BFP Freelance
Photography Course

While the BFP Handbook (above) will show
you WHERE to sell your photos, this lavishly
illustrated manual will show you HOW to
sell them.
It’s a practical course with 16 lessons
covering everything you need to know to
sell your pictures to magazines, greetings
cards, calendars, newspapers, books etc.
When ordered from the BFP, it comes with
a set of tutorials to guide you through

the lessons.

Price: £25.00 + £2.00 P&P

To join the BFP � To order BFP books
Go to www.thebfp.com

Phone 01707 651450
Or send a cheque to:

Bureau of Freelance Photographers
Freepost 

Vision House PO Box 474
Hatfield AL10 1FY



This beach once appeared  
in a Thai holiday brochure. 
But it’s about 5000 miles 

nearer than that. 

D over more of our paradise island

Free delivery: magsdirect.co.uk/country-walking  

  with the UK’s best-selling outdoors magazine  

Did you know?

Photography
Wildlife

25 years experience in 

creating exceptional 

wildlife holidays

Small group photography 
tours 
 
Worldwide destinations 
 
UK macro workshops 
 
Incredible wildlife 
encounters 
 
Expert guidance from  
professional photographers

Holidays

wildlifeworldwide.com

01962 302 088 sales@wildlifeworldwide.com

Request our NEW brochure

Bird Watching magazine is full of 
information and practical advice on 
how to see, photograph and enjoy 
the birds around you.

You’ll learn about the huge variety 
of species you can see in your 
garden and further afield

On sale every month in all good newsagents

Subscribe today at 
www.greatmagazines.co.uk/bw



HOLIDAYS AND COURSES

STUDIO HIRE

ACCESSORIES
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WILDLIFE PHOTO HIDES
WORKSHOPS AND HIRE

with Sussex Wildlife Trust
Photographer

David Plummer

9[[]kk�lg�caf_Ú�k`]j$�god$�jYhlgj$�ogg\dYf\�Zaj\$�
\]]j�`a\]k

www.davidplummerimages.co.uk

Photographic Backgrounds
Hard wearingO low creaseOWashable

01457 764140
for a FREE colour brochure or visit...
www.colourscape.co.uk

SPECIAL OFFER: 8 x 12 CLOUDEDS
2 FOR £80 OR 3 FOR £115

PLAIN
8’ x 8’ .....£15 plus P&P

8’ x 12’ ...£24 plus P&P

8’ x 16’ ...£29 plus P&P

CLOUDED
8’ x 8’ ......  £27 plus P&P

8’ x 12’ .... £44 plus P&P

10 COLOURS INC 
BLACK, WHITE 
& CHROMA 
COLOURS

20 COLOURS

“I thoroughly enjoyed the course the other evening,
The model was charming and I got out of the course
everything I had hoped. From a pleasant and enjoyable
experience point of view I cannot make any suggestions
to improve it. You hit the nail on the head with my
expectations, but with others you may like to ask them
to give you their expectations on a mail before they
anrive and then you can modify to suit.”
Gary

“The course easily catered for me as a studio beginner.
Nothing was taken for granted, without teaching me
how to suck eggs! The model Paul had chosen, was
the most patient person on earth and kept smiling
throughout the shoot. At the end of my time I left with a
lot of excellent photos and a confi dence to carry on with
this type of photography.”
Sam

WWW.PAULS-STUDIO.CO.UK
STUDIO@PAULS-STUDIO.CO.UK
07930 462906

STUDIO ONE TO ONE
COURSES AVAILABLE:
• BASIC STUDIO STARTER
• PORTRAIT & STUDIO LIGHTING
• BASIC STUDIO STARTER COURSE
• GLAMOUR & NUDE
•  BOUDOIR PHOTOGRAPHER PRIMER

COURSE
• ART NUDE CREATIVE COURSE
• NUDE, EROTIC & ADULT COURSES
• CUSTOM COURSES
•  ALL COURSES AVAILABLE WEEKDAYS

EVENINGS & WEEKENDS
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www.pauls
s

· STUDIO HIRE · MODEL PHOTO SHOOTS · STUDIO EVENTS · GLAMOUR & NUDE LOCATION GROUP SHOOTS



162 PRACTICAL PHOTOGRAPHY

Capturing 
consumerism

Iris Xing graduated with an (MFA) Photography
from New York’s School of Visual Arts in 2016.
irisxing.com 

OWHEN I WAS IN HIGH SCHOOL MY DAD GAVE ME 
a camera, which I very quickly became obsessed with. I 
much preferred going out and shooting rather than being 
stuck in school learning subjects I didn’t care about. When 
I went to college I chose a major in advertising, which 
gave me better access to photography. When I was in my 
second year of college I met a professor whose attitude 
towards art deeply influenced my journey as an artist. 
He said that he wanted to record the beauty of the world 
in order to leave precious and beautiful images for the 
people that come after us. I was so moved by his view on 
this artform that I realised that I also wanted to create 
something meaningful. Although I’ve now been studying 
photography for more than five years, the purpose of my 
work never changes. I don’t want to create art just for art’s 
sake. I want to inspire people and make them think. 

In 2013 I moved to New York to study photography for my
master’s degree at the School of Visual Arts. It’s the top course
in the world for my discipline and it taught me so much about
how to use images to express myself. In the second year of 
my master’s degree, I gradually started to find myself using 
food as a focal point in my work. My family has always been 
very concerned about the environment and I’ve always had 
an obsession with rainbow colours, so I think food turned 
out to be a perfect fit. I always try to make my work super 
colourful and playful so that it can look real yet fake, and 
cute yet scary all at the same time. I want it to mirror the 
food industry’s nature – confusing and surreal. My ‘Burger 
It’ project dealt with consumption culture. Hamburgers are 
the pinnacle of instantly accessible and consumable food. If 
I’m able to draw people’s attention to the food they eat and
help them choose a healthier lifestyle then I’d be happy. 

I believe that art should always be accessible so that 
everyone can interact with it. Art and photography 
shouldn’t be an expensive print hanging on a wall – it 
should be something that inspires and excites people.
This is what I always try to do with my work, and it’s 
something I’ll continue to strive towards in the future. 

Iris Xing trains her camera’s
eagle eye on the confusing 
nature of the food industry 
in her fine art images. 

STUDENT SHOWCASE





WhiteWall.co.uk

Selected by the Editors of 28 International Photography Magazines

‘Best Photo Lab Worldwide’
Winner of the TIPA Award

Your most beautiful photos in large-format prints, mounted under acrylic, 

and framed. Made in Germany by the lab with 90 awards & recommendations. 

Upload and set a custom format – we can even do sizes up to 120 cm x 90 cm. 

Hang your smartphone photos on the wall!

FROM YOUR SMART-

PHONE ONTO THE WALL

Our Solid Wood ArtBox starts at

£24.90


